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Preface 

Vocational Education is a dynamic and evolving field, and ensuring that every 

student has access to quality learning materials is of paramount importance.  The 

journey of the PSS Central Institute of Vocational Education (PSSCIVE) toward 

producing comprehensive and inclusive study material is rigorous and time-

consuming, requiring thorough research, expert consultation, and publication by 

the National Council of Educational Research and Training (NCERT). However, the 

absence of finalized study material should not impede the educational progress of 

our students. In response to this necessity, we present the draft study material, a 

provisional yet comprehensive guide, designed to bridge the gap between teaching 

and learning, until the official version of the study material is made available by 

the NCERT. The draft study material provides a structured and accessible set of 

materials for teachers and students to utilize in the interim period. The content is 

aligned with the prescribed curriculum to ensure that students remain on track 

with their learning objectives. 

The contents of the modules are curated to provide continuity in education and 

maintain the momentum of teaching-learning in vocational education. It 

encompasses essential concepts and skills aligned with the curriculum and 

educational standards. We extend our gratitude to the academicians, vocational 

educators, subject matter experts, industry experts, academic consultants, and all 

other people who contributed their expertise and insights to the creation of the 

draft study material. 

Teachers are encouraged to use the draft modules of the study material as a guide 

and supplement their teaching with additional resources and activities that cater 

to their students' unique learning styles and needs. Collaboration and feedback are 

vital; therefore, we welcome suggestions for improvement, especially by the 

teachers, in improving upon the content of the study material. 

This material is copyrighted and should not be printed without the permission of 

the NCERT-PSSCIVE.   

 

Deepak Paliwal 

(Joint Director) 

PSSCIVE, Bhopal 

Date: 17 September, 2024 
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Module 1 Drawing and Animating 

Roto Shapes 

 

Module Overview  

 

Shapes are integral part of rotoscoping created over the focus object and animated 

according to object motion. It is important to understand the roto objective before 

creating shapes. The shot duration for rotoscoping, footage stabilization, identifying 

focus object, matte uses, edge feather need to be observed before creating shapes. 

There is various software to perform rotoscoping. In out book we will be using 

SilhouetteFX software. In this unit you will learn the basics of SilhouetteFX. You will be 

able to work with its interface, sessions, trees, nodes, shapes, layers, object and object 

list. Further you will be able to draw shapes over the focus object by using roto shapes 

like Bezier, B-spline and X-spline. The use of open shapes, blend mode and reshape 

tools is demonstrated. Then you will know about the technique of animation shapes. 

You will be able to use transform tools is used, which is divided into shape and point 

mode. It is further demonstrated to animate the roto shapes by using various key-

framing techniques. 

 

Learning Outcomes 

 

After completing this module, you will be able to: 

• Understand the foundational skills and knowledge required for effective 

rotoscoping. 

• Describe the learn techniques for working with silhouette images in rotoscoping 

and animation. 

• Explore the skills required to draw and manipulate shapes for animation and 

visual effects. 

• Demonstrate the apply techniques for animating shapes to create dynamic and 

engaging visual content. 

 

Module Structure  

Session 1: Rotoscoping Pre-Requisite 

Session 2: Working with Silhouette   

Session 3: Drawing Shapes 

Session 4: Animating Shapes 
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Session 1: Rotoscoping Pre-Requisite 

A teacher asked to students about their planning to spend the vacation after 

examination. Rohan expressed his feeling that he loves the mountain and want to spend 

the vacation in hill station. But he was not aware about the climate, mountain road and 

safety measures for mountain traveling. The teacher told him to take the basic 

information about the hill station which he wants to visit. Because it is essential to 

know all about the culture, clothing, the way to reach, food habits and accommodation 

etc. for visiting any hill station.  (Figure 1.1) Thus, you should have a proper travel plan 

to visit any place, which includes, travel guides, maps, clothes according to climate and 

safety equipment. 

 

Fig. 1.1 Rohan is thinking about a trip to the mountains Courtesy- Freepik.com 

In the same way if you wish to learn rotoscoping, you should be well prepared with 

rotoscoping basics. Planning and preparation is important in rotoscoping. In this 

chapter, you will understand the rotoscoping basics to start with rotoscoping. It is 

essential to understand rotoscoping basics before rotoscoping a shot. 

1.1. Important terms in Rotoscoping 

You need to understand the following terms to do the rotoscoping in a specific shot. 

1. The shot length – Duration of video footage for rotoscoping. 

2. Stabilization of the Footage – Stabilize shaky and jerky video footage before roto. 

3. Identification of the objects for rotoscoping – Object which is going to isolate from 

the video footage. 

4. Matte usage – Identify the final use and motion path of the matte. 

5. Edge and Shape – Technique of breakdown an object in shapes, considering the 

edge. 

6. Edge Feather – To create softness at the outer edge of an object. 

7. Multiple Shape – Breakdown an object in two or more basic shapes. 

8. Positive Space – A space within footage to place a different object. 

9. Motion Path – A route shapes takes, while moving with object. 

Let us now discuss these terms in detail. 

1. The Shot Length 

It is essential to determine the duration of the shot before conducting rotoscoping. 

Consider a shot of 150 frames for rotoscoping. If matte is needed only for the focus 
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object between 75 to 150 frames, then it is worth to concentrate on these frames for 

rotoscoping without wasting the time on other part of the footage. 

To complete the rotoscoping within the stipulated time period consider only those 

frames which needs roto. So, focus on the rotoscoping details which are provided by the 

client. 

Know More… 

Focus object is the object, which is going to isolate or separate from frame. In Figure 

1.2, boat is a focus object. 

 

Fig. 1.2: Focus Object (Courtesy Author) 

Matte is a black and white frame or a set of frames that tells the software what is 

visible and what is not. In Figure 1.3 white is visible while black is invisible. You can 

observe the final output in Figure 1.4. 

 

Fig. 1.3 Matte (Courtesy Author) 

 

Fig. 1.4 Colour Comp of matte (Courtesy Author) 

2. Stabilization of the Footage 

Once the shot length is fixed, play the video footage and watch its motion. If it is shaky 

and jerky, then to stabilize video footage before start rotoscoping. This will save the time 

while rotoscoping. Practical Activity 1.1 illustrates the method to stabilize video footage 

in Adobe Premiere Pro software. 

Practical Activity 1.1 – Stabilize shaky video footage in Adobe Premiere Pro 

Step 1. Import the footage into the ‘Project window’ of Adobe premiere editing software 

and insert it on timeline, as shown in Figure 1.5 
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Fig. 1.5 Import the footage in editing software (Courtesy Author) 

Step 2. Now to stabilize the footage apply Warp Stabilizer video effect over the footage 

as shown in Figure 1.6 

 

Fig. 1.6: Select Warp Stabilizer (Courtesy-Author) 

Step 3. Drag and drop this effect over the footage on timeline. This effect will analyze 

the motion shake of the video footage initially and then stabilizes it as shown in Figure 

1.7 & 1.8. 

 

Fig. 1.7: Drag and Drop the effect over the video footage (Courtesy Author) 
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Fig. 1.8: Video effect is being applied on the footage (Courtesy-Author) 

Step 4. After applying this effect on the video footage, export the video in desired format 

for rotoscoping. To export the video, select File> Export> Media. Choose the desired 

format, browse the destination location and click on Export, as shown in Figure 1.9. 

 

Fig. 1.9: Export the video in desired format (Courtesy-Author) 

Assignment 1.1 

Shoot a video footage from Mobile/DSLR and stabilize it. 

3. Identification of the Focus object for rotoscoping 

After stabilizing the footage, you need to recognize the object to be isolated from the 

frame. In Figure 1.10, Lamp-post is a focus object which will be isolated from the frame. 

 

Fig. 1.10 Focus Object in the frame Courtesy-Author 

4. Matte Usage 

After identifying the focus object, you need to understand the final use of matte. This 

will help you to identify the area of more focus. It is better to get style frame from the 

compositor before starting rotoscoping. Style frame is a frame, which reveals, what 
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exactly is going to happen in final frame. With the help of style frame, you can easily 

distinguish the focus object. 

There are three paths 1, 2 and 3, as shown in Figure 1.11. Suppose in final shot, a leaf 

is falling from the tree behind the squirrel and follow the path 1 or 3 then you need roto 

the wood not the squirrel. You need to roto the squirrel, if only the path 2 is followed. It 

also depends upon the movement of the focus object in this case squirrel is focus object. 

So, style frame is very necessary to define the roto object. 

 

Fig. 1.11 Matte Uses (Courtesy-Pixabay.com) 

Assignment 1.2 

In a given video frame, mention the possible path to perform Roto of a character moving 

towards sea. As shown in Figure 1.12. 

 

Fig. 1.12 Identify the possible path of a man to reach sea (Courtesy-Pixabay.com) 

Know More… 

Style Frame – A style frame is a snapshot of a finished frame as it would look within a 

longer animation. In Figure 1.13 It aims to capture a still image of overall look and feel 

of an animated or live action video. 
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Fig. 1.13: Style frame from ‘twinings tea’ advertisement (Courtesy-TwiningsUK) 

5. Edge and Shape 

Once the range of shot imports on timeline, watch the footage and playback it in a loop 

to find out important frame. Here, Shape and Edge are basics of Rotoscoping. A Roto-

artist watches the frame in the form of shape and edge. Every visual element can be 

separated and defined into smaller, easily animated shapes, which follows a distinctive 

motion path. It is similar to basic drawing techniques for making image with basic 

shapes. Use these simple drawing techniques to breakdown the focus object in various 

shapes as shown in Figure 1.14. 

 

Fig. 1.14: Bird’s drawing using basic shapes (Courtesy-Author) 

 

Fig. 1.15: Different roto shapes in green outline (Courtesy-Author) 

Edges are another consideration of a roto artist’s focus. It is the most important element, 

what we get as a final matte while doing roto. Figure 1.15 shows how the edge of the 

picture is separated. Edges is another consideration of roto artist’s focus. 
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Fig. 1.15 (a) Shape in blue overlay          Fig. 1.15 (b) Edge in red outline 

Shapes are used to identify and isolate form and motion, whereas edge shows the 

perfection in roto object. To extract the focus object from the video footage, view the 

focus object such that it should fully appear on the screen, so that even if it disappears 

behind another element in the footage, you can still manipulate the shape. 

6. Edge Feather 

Edge feather refers to the softness of the shape edge. Roto Artist should confirm the 

requirement of the edge feather from compositor before starting rotoscoping. Because 

once it is applied on the roto object, it cannot to revert easily. In Figure 1.16 Edge feather 

should be applied carefully well after knowing the requirement. 

 

Fig. 1.16 Edge feather Courtesy-Author 

7. Multiple Shapes 

In graphics, a single outline is created for entire focus object, but in case of Roto, it is 

difficult to rotoscoping a single shape, particularly if focus object has multiple moving 

shapes. Breaking down the focus object into multiple shapes makes rotoscoping more 

manageable than working on the single shapes. 

Using just one spline for a focus object with multiple moving parts would be a nightmare 

in almost any mildly complex roto shot. In Figure 1.17 (a), the boat on the lake is being 

isolated with single spline, which looks fine for just the one frame. But when you move 

to the next key frame, everything about the figure has changed. To create the second 

key frame, you’d have to move every single point on this spline to a new position. In 

Figure 1.17 (b), the boat is breakdown in multiple shapes. So as the focus object moves, 

you can easily modify the shapes accordingly. 
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Fig. 1.17 (a) Breakdown of Focus Object in Multiple Shapes Courtesy-Author 

 

Fig. 1.17 (b) Breakdown of Focus Object in Multiple Shapes Courtesy-Author 

8. Positive Space 

A Positive space can be created by Roto Artist within the footage to place an object which 

is not picturized. Suppose a character is picturised with a clear sky, and you want to 

insert clouds behind him or the area outside the car window needs to be colour 

corrected. In both situations, you may require to perform roto between and behind 

shapes for which mattes in not required. In this situation you will find focus object, 

passing in front of the isolating object. In Figure 1.18 (a), you need to isolate the window 

but person is sitting in front of it. So you have to create two mattes as shown in Figure 

1.18 (b) and (c). 

 

Fig. 1.18(a) Original Footage 
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Fig. 1.18 (b) Windows matte including person           Fig. 1.18 (c) Person Matte 

To signal out the area of focus object, remove the man matte from window matte as 

shown in Figure 1.19. 

 

Windows Matte   -    Man Matte                 =    Final Matte 

Fig. 1.19: Final matte after removing man matte from windows matte 

9. Motion Path 

Motion path refers to a shape taken while moving with focus object. After breaking down 

the focus object into shapes, you need to find motion paths of these shapes. Motion is 

defined by using key frames. Key frames are set on the stopping point of the object or 

in changing direction. Motion and animation for the key-frames is calculated by using 

this technique. 

 

Fig. 1.20 Motion path showing in red line 

Defining a movement means establishing the focus object from starting point to end 

point. Setting up the key frames suggest that the object is in these two positions at these 

two points in the timeline. The computer assumes the position data between these two 

points and moves the spline/shapes appropriately. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. Which of the following is not decided before rotoscoping (a) Motion Path (b) 

Positive space (c) Shot Length (d) Negative space 

2. Which of the following object is going to isolate from a frame is (a) Main (b) Sub 

(c) Focus (d) Image 

3. Matte refers to (a) Layer of an image (b) Colour image that tells software about 

colour channel (c) Black and white frame that tells software what is visible (d) 

Image format 
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4. Shaky video footage cannot stabilized in (a) Adobe Premiere pro Software (b) 

Adobe after Effects Software (c) Final cut pro (d) Adobe Audition 

5. Style frame is a snapshot of (a) Finished frame (b) Final edited frame (c) Original 

video frame (d) Raw footage 

6. A Roto-artist watches the frame in the form of (a) Shape (b) Edge (c) Layer (d) 

Shape and Edge 

7. Which of the following shows the perfection in roto object (a) Shape (b) Focus 

object (c) Edge (d) Motion Path 

8. Rotoscoping should be started from (a) First Frame (b) The frame which has 

details of object (c) The frame which has detail and complete shape of object (d) 

End frame 

9. For effective rotoscoping effortlessly, focus object should be break down in (a) 

Single shape (b) Two shapes (c) Multiple shapes (d) Open shape 

10. Motion path refers to (a) Movement of all objects within frame (b) Routes of an 

object (c) Routes a shape takes while moving within a shot (d) Routes of 

background object 

B. Fill in the blanks 

1. Rotoscoping requires________ and _________. 

2. In a matte, White is ________ while black is_________. 

3. In Adobe Premiere software, _____ is used to stabilize the footage. 

4. The next step after identifying the focus object is __________. 

5. Shape helps roto-artist to easily distinguish and isolate_________. 

6. Edge shows the ___________ in roto object. 

7. Creating _____ is inefficient way of roto. 

8. It is easy to manage rotoscoping by breaking down the focus object into 
__________ (multiple shapes) 

9. Motion path refers to a ________ taken while moving with focus object. (shape) 

10. Defining a movement means establishing the focus object from ________ point to 
point (starting, end). 

C. True or False 

1. The shot length is important aspect in rotoscoping. 

2. It is essential to understand matte use in rotoscoping. 

3. Edge is technically the most important element in rotoscoping. 

4. Edge feather should be used on every shape. 

5. Key frames are generally set on the stopping points or direction changes. 

D. Short answer questions 

1. Why the shot length is important factor in rotoscoping? 

2. What is Focus object and matte? 

3. What is style frame? 

4. Differentiate between Edge and Shape. 

5. How the style frame helps to understand matte usages? 

6. Write the importance of edge and shape in rotoscoping. 

7. What are the benefits of breaking down an object in multiple shapes? 

8. What is positive space? 

9. What is motion path? 
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Session 2: Working with Silhouette Software 
 

Rotoscoping can be performed traditionally as well as digitally on computer. Digital 

Rotoscoping is much faster than the traditional. Digital roto artist can do the work eight 

times faster than the traditional rotoscoping within one fourth of time. In traditional 

rotoscoping each frame has to be drawn individually, while in digital rotoscoping, roto 

artist can use the previous frame as a basis which minimises the work of roto artist. 

Digital rotoscoping is now empowered by various rotoscoping software like Adobe After 

Effects©, Nuke© and SilhouetteFX©. 

In this chapter, you will be able to perform hands on of SilhouetteFX© software developed 

by Boris FX. (Figure 2.1) It is specially designed software for Rotoscoping and Paint. The 

top most artists and most famous Visual Effects studios such as Weta Digital, Frame-

store, Technicolour, Deluxe, and many more use Silhouette software for creating epic 

visual effects on the biggest blockbuster film including Avatar, The Hobbit, Wonder 

Woman, Avengers: End Game, and Fast & Furious Presents: Hobbs & Shaw. 

 

Fig. 2.1 Visual Effect scene from movie ‘The Hobbit’ Courtesy-Weta Digital 

It is exciting to know that SilhouetteFX© is developed by Hollywood post production 

houses. The team behind Digital Film Tools discovered that the looks and effects they 

wanted as artists just did not exist. So, they decided to write new custom tools for 

themselves and the rest is history. Featuring over 100 filters and thousands of pre-set 

including color grading pre-sets inspired by Academy Award-winning films like 2001: A 

Space Odyssey, Apocalypse Now, Blade Runner, back to the Future, and Gone with the 

Wind. 

2.1 SilhouetteFX© Overview 

SilhouetteFX© is hard core, streamlined rotoscoping software, which can be leaned 

easily by the roto artist. It was designed purely for Roto and Paint. Its interface and 

workflow provide optimal situation in which element can be isolated quickly. 

In this software, you get an excellent non-uniform scale. It allows adjusting a section of 

a shape without altering other accurate edge sections. Silhouette also has useful 

keyboard shortcuts that make it very easy to view your shapes, a shaded area of your 

shapes over the footage i.e. coloured overlay, and the alpha channel of shapes. 
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The software also empowered with useful tracker such as point tracker and planar 

tracker. It requires little input from the user and rest it tracks automatically. You can 

pre-process the tracker by using pre-processing options like blur, sharpness, contrast 

and noise. SilhouetteFX© also comes with some light compositing tools. Its main 

function is Roto and paint. Its features are simple, straightforward and easy to use for 

Roto. 

2.2 User interface 

SilhouetteFX© interface is made up of traditional pull-down menus, toolbars and pop-

up menus. Here, you will get quick shortcut keys for all the function and most of the 

time; it is shown next to the menus or toolbar. When you drag cursor over any function 

or tools, then the function of the keys or menus are described. Mostly popup and floating 

windows are used as per requirement. (Figure 2.2) 

The SilhouetteFX© interface is comprised of Sources, Trees, Viewer, Toolbar, Time bar, 

Timeline/Curve Editor, Node and Object Parameters, Presets, Object Lists and Nodes 

windows. 

 

Fig. 2.2 User interface of SilhouetteFX© Software Courtesy-Author 

2.2.1 Sources Window 

The video clips are placed in Sources window, which is saved in the form of image 

sequence. (Figure 2.3) The location, frame rate, raster type, image size, and other 

information about the sources are stored for reference. 

 

Fig. 2.3 Sources window Courtesy-Author 

Practical Activity 2.1 – Create a Project in SilhouetteFX©v7.5 and import footage 

on sources Window. 

Silhouette supports only the image sequence. So first convert your video in to the image 

sequence. 
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(a) Convert Video in to the Image sequence. 

Step 1. You need video conversion or video editing software for converting video footage 

in image sequence. This time, we will use Adobe Premiere Pro© video editing software. 

Open Adobe Premiere Pro© software by clicking on desktop icon or from start menu. 

(Figure 2.4) 

 

Fig. 2.4 Welcome Screen of Adobe Premiere Pro© Courtesy-Adobe 

Step 2. As the software initial screen opens, click on New project tab to create a new 

project as shown in Figure 2.5. 

 

Fig. 2.5 Adobe Premiere pro Home Screen Courtesy-Author 

Step 3. In New Project pop-up window, fill the required detail such as project name, 

location and general setting. Now click on OK button as shown in Figure 2.6. 

 

Fig. 2.6 New Project window Courtesy-Author 

Step 4. Now Adobe Premiere Pro© software interface open as shown in Figure 2.7. 
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Fig. 2.7 Adobe Premiere Pro© interface Courtesy-Author 

Step 5. Now you need to bring the video footage into the software for creating image 

sequence. So Select File > Import; and Import video footage in project panel as shown 

in Figure 2.8. 

 

Fig. 2.8 Project Panel Courtesy-Author 

Step 4. To convert this video, it needs to be put on the timeline. For this, go to the File > 

New > Sequence and Create a new sequence in timeline as shown in Figure 2.9. 

 

Fig. 2.9 New Sequence in timeline Courtesy-Author 

Step 5. Drag and drop your footage into the timeline and mark ‘IN’ and ‘OUT’ to the 

footage as shown in Figure 2.10. 

 

Fig. 2.10 Footage is inserted on timeline Courtesy-Author 

Step 5. For creating Image sequence; Select File> Export> Media. Now the dialogue 

box opens. You can choose your export setting here. For creating image sequence from 

the video, select image format like jpeg and its image present. After that choose the 
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output name of the file and click on file name to browse the desired location. Once all 

is done click the Export button at the bottom of the window as shown in Figure 2.11. 

 

Fig. 2.11 File export setting Courtesy-Author 

Step 6. The selected video has been converted in to the Image sequence and saved in 

to desired location as shown in Figure 2.12. 

 

Fig. 2.12 Image Sequence Courtesy-Author 

Now you need to import this Image Sequence in SilhouetteFX© Software. 

(b) Create a project in Silhouette©v7.5 and Import the footage. 

Step 1. To open the software under Windows 10 environment, Type Silhouette on search 

box and click on software link as shown in Figure 2.13. 

 

Fig. 2.13 Search the software Courtesy-SilhouetteFX 
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Step 2. Silhouette©v7.5 Welcome Screen appears. Here click on New Project as shown 

in Figure 2.14. 

 

Fig. 2.14 SilhouetteFX©v7.5 Welcome Screen Courtesy-SilhouetteFX 

Step 3. The New Project dialogue box opens. Enter the name of the Project and browse 

the destination folder to save the project. After this, click on Create Project as shown 

in Figure 2.15 

 

Fig. 2.15 New Project Dialog box Courtesy-Author 

Step 4. After creating project, Silhouette© v7.5 interface opens as shown in Figure 2.16. 

 

Fig. 2.16 SilhouetteFX© Interface Courtesy-Author 

Step 5. To import, converted image sequences on Project, select File >Import > Media 

or click on import icon on Sources window as shown Figure 2.17 and Figure 2.18. 
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Fig. 2.17 Import footage Courtesy-Author 

 

Fig. 2.18 Import icon on source window Courtesy-Author 

Step 6. As you click on ‘Import’, a dialogue box opens. Keep in mind that you need to 

select first frame and click on Open tab as shown in Figure 2.19. 

 

Fig. 2.19 Import Dialog box Courtesy-Author 

Step 7. Now Video footage is imported in the form of Image sequence, which is placed 

in Sources window as shown in Figure 2.20. 

 

Fig. 2.20 Footage is imported on source window Courtesy-Author 

Step 8. Thus, Footage is imported in Silhouette© v7.5, double click the Footage on 

Sources windows to playback it on Viewer Panel. In this way, you can import a video 

footage in Silhouette© software as shown in Figure 2.21. 
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Fig. 2.21 Playback footage on viewer panel Courtesy-Author 

Know More… 

SilhouetteFX© Software does not support the video files. So you have to convert video 

files into the Image sequence by using software like Adobe Premiere or Adobe After 

Effects. 

The Silhouette’s supported image format includes – Cineon, DPX, IFF, JPEG, Open 

EXR, PNG, TGA, TIFF, SGI 

2.2.2 Sessions 

Once you import footage in silhouette, a session needs to be created for each video 

footage you will be working on. You could create as many sessions as you want, but can 

work only one session at once. Session is a place where you can roto, paint or composite 

as shown in Figure 2.22. 

 

Fig. 2.22 New Session Courtesy-Author 

It describes the Format, resolution, pixel aspect, duration in frames, frame rate and bit-

depth. Let us create a session into the Silhouette© v7.5.5. 

Practical Activity 2.2 – Create a session in Silhouette© v7.5.5 software. 

Once you Import the footage on Sources window, you need to create session. Session 

can be created by two methods. 

Method 1 

Step 1. Select the video frames on sources window and go to Session > new session; a 

dialogue box opens. It automatically fill-up the setting details based on selected video 

property. If you want any change on session setting then change it manually. Write the 

session name and click on OK button as shown in Figure 2.23.   
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Fig. 2.23 New Session Dialog Box Courtesy-Author 

Step 2. Now a new session is created on Trees window at the top right side of the 

software interface. In Trees window, initially you will get two nodes interconnected 

which are source and output node as shown in Figure 2.24. 

 

Fig. 2.24 Trees Window Courtesy-Author 

Method 2 

Step 1. In this method, drag and drop the image sequence (Video footage) from sources 

window to trees window by holding the left mouse button as shown in Figure 2.25. 

 

Fig. 2.25 Drag and drop image sequence from sources to trees window Courtesy-

Author 

Step 2. A new session dialogue box opens after releasing the mouse button. Here you 

can fill the detail as done in method 1 and click OK button as shown in Figure 2.26. 
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Fig. 2.26 Session Dialog Box Courtesy-Author 

2.2.3 Trees 

A Session is created in Trees Window. Trees are the combination of sources and nodes 

that are used to create the desired effect as shown in Figure 2.27. 

 

Fig. 2.27 Trees Courtesy-Author 

2.2.4 Nodes 

Node base software is handling complex compositing task by linking together several 

simple image processing operations. Each of these operations is referred to as a “node”. 

Individual nodes are connected together to form a tree. Nodes are grouped into the 

categories, such as, Color, Composite, Diffusion, Filter, Film Lab, Image, Key, Light, 

Silhouette, Special Effects, Time, Tints, Transform and Warp. There are more than 150 

nodes in Silhouette©v7.5 software as shown in Figure 2.28. 

 

Fig. 2.28 Nodes Courtesy-Author 

In Figure 2.29, you can easily observe the different colour bars on the border of the 

nodes. Let us find out what they are? 

 

Fig. 2.29 Different colour bar on Roto node Courtesy-Author 

Inputs 
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Green Colour bar on the top is the inputs. Depending on the node, the type of input 

required may change. Green bars are foreground and background inputs. Tool tips pop 

up when you hover over a node’s input or output to easily identify it. 

 

Fig. 2.30 Foreground and background connected with Roto nodes Courtesy-

Author 

You can check foreground and background in roto nodes. For this switch between 

foreground and background in viewer panel as shown in Figure 2.32 (a) and (b). 

 
Fig. 2.31 (a) Foreground view 

 
Fig. 2.32 (b) Background view 

Output 

The colour bars on the bottom of a node is outputs. The grey colour bar is the main 

output, purple bars are colour composite, composite and channel outputs respectively. 

Yellow bars are object outputs-like layers. You can use the output of a node to feed into 

the input of other nodes. It is shown in Figure 2.33 (a) – (d). 

So we will connect different output node in succession and observe the result. 

 

Fig. 2.33 (a) Main output node Courtesy-Author 
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Fig. 2.33 (b) Colour composite output Courtesy-Author 

 

Fig. 2.33 (c) Composite output Courtesy-Author 

 

Fig. 2.33 (d) Channel output Courtesy-Author 

Obey Matte 

Obey Matte input as shown by blue colour bar at the far right. Obey matte works as a 

mask. Whatever is plugged in to Obey Matte input will constrain or limit the effect of 

the node. So, let’s understand the impact of obey matte with the following example. 

Step 1. Insert a double fog node between source and output in tree window as shown 

in Figure 2.34. 

 

Fig. 2.34 Node Insertion Courtesy-Author 

Step 2. Now connect the colour composite output from roto node with Obey Matte as 

shown in the Figure 2.35. The already done roto of boat shape will be explained in 

forthcoming chapter. You will observe no change yet in viewer’s panel. 
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Fig. 2.35 Connect roto node with obey matte Courtesy-Author 

Step 3. Now centre click on double fog node. Now Node parameter opens at bottom 

right corner as shown in Figure 2.36 (a) & (b). Here Right check in obey matte under 

node parameter. Watch the result on viewer’s panel. 

 

Fig. 2.36 (a) Obey matte option in node Parameter Courtesy-Author 

 

Fig. 2.37 (b) Final result in Viewer’s panel Courtesy-Author 

View Node 

When enabled the View Node icon on the left side of the node. It displays the result of 

that node in the Viewer. 

Edit Node 

When enabled, the Edit Node icon on the right side of the node. It displays parameters 

in the Node parameter window. It is shown in Figure 2.38. 

 

Fig. 2.38 Viewer and Edit Node Courtesy-Author 

Table 2.1, shows the various Node category, their types, colour and specific work. 

Table 2.1 Details of Roto Nodes 

Node Category Types Colour Work 

Input Foreground Green Connects the source video with 

foreground. 

Background Green Connects the background which place 
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behind the extracted foreground object. 

Output Main Output Grey It is main output. 

Colour Composite Purple It shows the extract object in colour. 

Composite Purple It shows the combine output with 

foreground and background. 

Channel Purple If shows colour channel’s output. 

Object output Yellow Nodes that contain trackers, like Depth, 

Morph and Roto have an Objects output 

that can be plugged into another node’s 

Transform input. 

Obey Matte  Blue Constraints or limit the effect of nodes. 

 

Know More… 

When you insert a still frame in background node, always click on extend duration in 

node parameter otherwise it will show only the first frame and remain will be blanked. 

(Figure 2.39) 

 

Fig. 2.39 Check on Extended Duration Courtesy-Author 

Practical Activity 2.3 – Connect Roto Node between Source and output in tree 

window. 

To insert Roto node between source and output, perform the following steps. 

Step 1. Search Roto node in Nodes window as shown in Figure 2.40. 

 

Fig. 2.40 Search Roto Node Courtesy-Author 

Step 2. Click and Drag Roto nodes to Trees window and drop it on to the existing node 

wire between source and output as shown in Figure 2.41. 
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Fig. 2.41 Nodes connected in tree window Courtesy-Author 

Now you can observe that Roto node is automatically connected. Here Source (Boat 

tracking) is connected with input and output is connected with output connection. 

2.2.5 Object and Object List 

After connecting the Roto node with source and output, you need shapes, layers and 

trackers to roto the object. Clicking on Roto node, the panels open as shown in Figure 

2.42 will open. 

 

Fig. 2.42 Object and Object list Courtesy-Author 

Tools Panel – It helps in creating different shapes and tracker. 

Object list – It shows the list of shapes, layers and trackers. With the help of object list 

you can select, lock, combine, rename and delete the shape, layer and tracker. 

Object – It shows the parameters/properties of the object. 

By observing the object list carefully, you will find that some of the icons are on the right 

side, as shown in Figure 2.43. 

 

Fig. 2.43 Object list Courtesy-Author 

Object list icon is divided in two segments. 

Layer Icon – It is used to modify layers as shown in Figure 2.44 (a). 
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Fig. 2.44 (a) Layer Icon Courtesy-SilhouetteFX 

Shape icon – It is used to modify shape as shown in Figure 2.44 (b). 

 

Fig. 2.44 (b) Shape’s Icon Courtesy-SilhouetteFX 

Observe the layer and shape icons, most of them are similar. Table 2.2 shows list of 

icons. 

Table 2.2 Layer/Shape icon with its function 

Layer/Shape icon Function 

View It only shows up when using stereo source. It displays L for left view 

and R for right view. 

Active layer The active layer box displays a check mark when the layer is 

selected. 

Roll It only appears when using the morph node. 

Opacity It indicates the opacity level of the shape. It displays white when the 

opacity is 100%, black for 0% and shade of ray when opacity is in 

between. 

Blend Mode It shows how the shapes are blended with other shapes. 

Invert It inverts the shape. 

Motion blur It turns motion blur on or off for selected shape. 

Colour Change the outline colour of selected shape. 

Lock Lock/unlock the selected layer. 

Visibility Hide or show selected layer by click on visibility icon. 

Notes You can type a note for selected object. 

Table 2.3 Object list shortcuts 

Shortcut action 

Click on an object Selects the object 

Shift-click an object Adds an object to the current selection 

Ctrl(Win)/Cmd(Mac)- Toggles the object selection 
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click on an object 

Shift-click color pot Selects shapes of same color 

Alt-click the 

Visibility icon 

Solos an object 

Alt-Ctrl-click the 

Visibility icon 

Forces the visibility of all objects to the on position 

Shift-click the +/- 

icon 

Expands or collapses all nested layers inside that layer 

Double-click an 

object 

Selects the object so it can be renamed 

 

Fig. 2.45 Object window Courtesy-Author 

To change shape/object parameter then you should watch the object window, as shown 

in Figure 2.45. Here most of the option is similar to the object list icon. You can change 

this parameter either from object list icon or from object window. Table 2.4 mentions 

some parameters which are not included in the object list. 

Table 2.4 Shape/object parameter 

Shape/object 

parameter 

Function 

Blur Apply blur over the shape. 

Blur type Set the blur type- centre, inner or outer. 

Shrink/Grow Shrink or grow the matte. Negative value shrinks while positive value 

grows the matte. 

Stroke width It is used to set the thickness of the open shape. 

Cap style It is used in open shape. You can keep your shape’s corner flat or 

rounded. 

Channel You can assign channel like red, green, blue and alpha to the shape. 
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Know More… 

In Silhouette©v7.5, Every node has different tool panel which enables as you click on 

that node Such as we click on Roto node, its tool panel enables. (Figure 2.46) 

                  

             Roto Node                   Tool Panel    

Fig. 2.46 Roto node and it’s tools Courtesy-Author 

2.2.6 Viewer and Time bar 

In Viewer, you can watch the frame and manipulate it using various tools. Here by using 

time bar, you can reach at any frame or playback frame as shown in Figure 2.47. 

 

Fig. 2.47 Viewer and Time bar Courtesy-Author 

Important controls in viewer’s panel 

Output View – In output view, you are able to see various outputs like – foreground, 

background, colour comp, components and channels, as shown in Figure 2.48. 

Update – It shows the update in viewer’s panel when you perform any change in node 

parameter. It has four options – Drag, adaptive, release and manual. 

Selecting Drag update automatically displays the change in viewer panel. Set the update 

to manual mode and hit the enter key, if you want to see the changes when you want. 

 

Fig. 2.48 Update option Courtesy-Author 

Proxy Size – You can use a lower quality proxy image by using proxy pull down menu 

above the viewer. It helps you to speed up the processing of the system as shown in 

Figure 2.49 and Figure 2.50. 
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Fig. 2.49 Proxy Size 1:1 (Original Quality) Courtesy-Author 

 

Fig. 2.50 Proxy Size 4:1 (Lowest Quality) Courtesy-Author 

ROI (Region of Interest) 

It crops the image in the viewer to a user defined size and can be animated. This is 

useful when you only need to animate within a smaller region of a larger image as it will 

use less memory and process faster. If expanded, the ROI will display over scan pixels 

which can then be manipulated. 

End Frame – It shows the last frame number. 

Current Frame – It displays the current frame number. 

Frame Step – It skips the number of frames in playback, which you selected here. 

Suppose you have selected 30 frames then it shows frame like 0, 30, 60 etc. It’s an 

important tool which helps you to move with specific frame interval. 

Know More… 

Frame Step is used for animating roto shape. You can set number of frames which 

you want to skip. The keyboard shortcut for frame step is page-up and page-down. 

Table 2.5 Viewer keyboard Shortcut 

Keyboard 

Shortcut 

Actions 
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F1 Only the Viewer is shown in the interface. 

F2 Only the Viewer and Timeline are shown in the interface 

0 Toggles the display of overlays which are lines, shapes or objects 

1-7 (Number Keys) Switches the Viewer > View menu 

~ Cycles through the update modes 

A Cycles the display between the full color image, the alpha 

channel 

Shift +A superimposed over the image, and the alpha channel by itself 

Alt-R/G/B/A Toggles the red, green, blue and alpha channels ON & OFF 

Alt-0 Toggles the display to/from the Output node’s alpha channel 

from any other node. Pressing Alt-O again views the previous 

node. 

Shift-Ctrl-R Toggles the Viewer rotation mode ON/OFF 

Shift-R Toggles the Viewer rotation editing mode ON/OFF 

Summary 

SilhouetteFX© is node base software. 

SilhouetteFX© interface and workflow creates ideal situation in which an element can 
be quickly isolated from videos. 

The SilhouetteFX© interface is comprised of Sources, Trees, Viewers, Toolbar, Time 
bar, Timeline/Curve Editor, Node and Object Parameters, Presets, Object Lists and 
Nodes windows. 

In SilhouetteFX© software, you can work on a single session at a time. 

All the nodes are connected into trees window. 

Each node includes simple image processing operations. 

Roto node is specifically made for rotoscoping work. 

You can create multiple shapes in roto nodes. 

Object shows the parameters/properties of the object/shape. 

Object list shows the list of shapes, layers and trackers. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. SilhouetteFX was designed purely for_______(a) Roto (b) Paint (c) Roto and Paint 
(d) Compositing 

2. Which are located in Source window (a) Effects (b) Nodes (c) Still image sequence 
(d) Video file 

3. SilhouetteFX does not support ______ image format (a) Cineon (b) DPX (c) JPEG 
(d) BMP 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

32 

4. You can work in_______ session at once. (a) One (b) Two (c) Three (d) Four 

5. You cannot select ______ in session setting. (a) Format (b) Resolution (c) Depth 
(d) Aspect Ratio 

6. Trees are the combination of__________. (a) Sources and Output (b) Sources and 
Roto (c) Sources and Nodes (d) Nodes and output 

7. Nodes are grouped in ____ category. (a) 14 (b) 15 (c) 16 (d) 17 

8. Green colour bar on the top of any node are________(a) View Node (b) Input (c) 
Output (d) Obey matte 

9. The gray colour bar on the bottom of the node is ______ (a) Main Output (b) Aux 
Output (c) Objects output (d) Channel output 

10. Which is not included in object list (a) Shapes (b) Layers (c) Trackers (d) Nodes 

B. Fill in the blanks 

1. SilhouetteFX uses a combination of traditional pull-down menus, _______and 
_______. 

2. SilhouetteFX supports only the__________. 
3. After importing the footage on source window, you need to create______. 
4. Roto node included in _________ category. 
5. Obey matte works as a ________. 
6. Edit node displays parameters in the _______________ window. 
7. You can select, lock, ________, rename and _______ the shape, layer and tracker 

in object list. 
8. If update mode is set in 'manual' then you need to hit_______ key to see changes 

in viewer's panel. 
9. ROI ________ the image in the viewer. 
10. Frame Steps skips the no. of frame in __________. 

C. True or False 

1. You can import video file in silhouette software. 
2. You need to create a session for each video footage. 
3. Individual nodes that perform image processing functions are connected together 

to form an object. 
4. Foreground and background come under inputs. 
5. You can use the output of a node to feed it into the input of other nodes. 
6. The blue colour bar at the far right is the Obey matte input. 
7. View node displays the result of the node in node parameter. 
8. In roto node, tools panel helps in creating different shapes and trackers. 
9. Object shows the list of shapes. 
10. Stroke width is used to set the thickness of the open shape. 

D. Answer in short 

1. What is SilhouetteFX software? 
2. Create a diagram of SilhouetteFX user interface. 

3. How to create session? 
4. Writes the name of different nodes included in SilhouetteFX category. 
5. What are the different output nodes? 
6. What are view node and edit node? 
7. Explain object and object list? 
8. What is different layer and shape icons? 
9. Write the use of viewer and time bar? 
10. What is ROI? 
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Session 3: Drawing Shapes 
 

You can create anything by using a Magic pencil. It is a story of famous serial ‘Shaka 

laka boom boom’ as shown in Figure 3.1. The story revolves around the central 

character Sanju finding a magical pencil, which has the ability to bring things drawn 

with it to life. 

 

Fig. 3.1 Stills from serial ‘Shaka Laka Boom Boom’ Courtesy-UTV Software 

comm. 

It is a fiction story; we don’t have this kind of magic pen in reality. But you can find 

various pen or spline tool in SilhouetteFX© software that helps you to extract the focus 

object from the video footage. 

This spline or pen creates shapes same as magical pen. Before you begin to create 

shapes from splines, let us resolve some thoughts which may come in your mind later. 

Need of creating shapes for rotoscoping 

Shape creates alpha matte. It is a black-and-white frame or set of frames that tells the 

program what is visible and what is not. In matte, white color is visible and black is not 

visible. Gray areas are partially visible depending on their numerical position between 

1 and 0. Compositors use the Alpha matte to isolate areas within the comp. Observe 

three pictures shown in Figure 3.2 (a), (b), (c). 

 

Fig. 3.2 (a) Original Footage Courtesy-Pixabay.com 
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Fig. 3.2 (b) Create Alpha Matte in SilhouetteFX© Courtesy-Author 

 

Fig. 3.2 (c) Final Composite Courtesy-Author 

Observe that the black and white area in Figure 3.2 (b). The black colour represents 

transparent area and white colour represents solid area. So, in Figure 3.2 (c) 

transparent black area is replaced by background while the solid white area is not 

replaced. Compare Figure 3.2 (a) and Figure 3.2 (c), and identify the area which is 

replaced in final composite. You need pen tool or spline to create the picture shown in 

Figure 3.2 (b), which is Alpha mate. 

3.1 Tools 

Spline is probably most important tools for creating roto shape which you can get in 

tools panel. As you click on Roto nodes, Tools panel appears Left side of Silhouette©FX 

software interface. Tools are designed for rotoscoping and it helps to draw the shapes. 

 

Fig. 3.3 Rotoscoping Tools Courtesy-SilhouetteFX 

This tool panel is classified in three categories. 

Drawing Tools – B spline, X spline, Bezier, Square, Circle and Reshape. 

1. Animating Tools – Transform and IK (Inverse Kinematics), Reshape. 
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2. Tracker – It creates path for animating shapes. 

In SilhouetteFX© the drawing tools are commonly known as Shape type. 

3.1 Shape Types 

3.1.1 Bezier 

It is the oldest tool such as Pen tool in Adobe Photoshop©. Bezier splines are defined by 

control points and tangents. To control Bezier, you have to control two things. 

1. Control point for position 

2. Tangent or Handle for curvature 

Control Point  Tangent or Handle 

 

Fig. 3.4 Bezier tool Courtesy-SilhouetteFX 

Table 3.1 Adjusting Bezier Curve 

Mouse/ keyboard 

Control 

Action Curve 

Left click on screen Place First 

Control point 

 

Hold down left click Curvature 

appears 

 

Click and drag tangent 

handle 

Adjust the 

length of one 

tangent while 

retaining fix 

angle between 

tangents. 
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Ctrl+ drag a tangent Adjust both 

tangents 

simultaneously 

while retaining 

fix angle 

between 

tangents. 

 

Alt+ drag a tangent Only one 

tangent is 

move which is 

good for 

creating corner 

 

Adjust Bezier curve tension 

Right clicking the mouse button on any control point shows the four adjustments. 

• Linear – Linear adjusts both tangents one quarter the distance and in the direction 

of their adjoining control points. 

• Corner – It collapses both tangent points. 

• Cardinal – Creates smooth point whether the curve passes smoothly. 

 
Fig. 3.5 (a) Original Curve 

 
Fig. 3.5 (b) Linear 

 
Fig. 3.5 (c) Corner 

 
Fig. 3.5 (d) Cardinal 

Practical Activity 3.1 – Create a shape over the focus object using Bezier tool. 

Step 1. As you select roto node in Tree window, Bezier tool appears on toolbar. Select 

Bezier (Shift+B) . 

Step 2. Click on the image to place the first control point. The starting control point is 

created and sets the direction of the shape’s path as shown in Figure 3.6. 
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Fig. 3.6 Create First Control Point Courtesy-Pixabay.com 

Step 3. To extend the control point’s tangents, drag the cursor while keeping the mouse 

pressed as shown in Figure 3.7. 

 

Fig. 3.7 Drag the Cursor to create Curve Courtesy-Author 

Step 4. Click on the screen to add more control points as shown in Figure 3.8. 

 

Fig. 3.8 Add more Control Point Courtesy-Author 

Step 5. When finished adding points, click the first control point that you added to close 

the shape as shown in Figure 3.9 and Figure 3.10. 

 

Fig. 3.9 Click the first point to connect it with end point Courtesy-Author 
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Fig. 3.10 Shape is created Courtesy-Author 

Step 6. Use as many points as needed to create the shape, but avoid using more than 

necessary. With fewer points, it is easier to animate the shape. 

Step 7. Watch the alpha matte by pressing 2 times A on keyboard. Compare it with 

colour composite view of created shape. You can see colour composite view by selecting 

the Colour Comp view on viewer panel. In colour composite view grey represent the 

transparent area as shown in Figure 3.11 (a) & (b). 

 
Fig. 3.11 (a) Alpha Matte of focus object 

 
Fig. 3.11 (b) Colour Composite View 

3.1.2 B-Spline 

In contrast to Beziers, B-Splines don’t use tangents or handles. It creates curvature 

automatically. The position of the points, their intensity settings as well as their 

proximity to each other, determine the curvature of the shape. 

 

Fig. 3.12 B-Spline Courtesy-SilhouetteFX 

The weight (amount of pull on a point) decides how sharp or smooth it is. SilhouetteFX© 

employs variable weight intensities on a point by point basis. 

Table 3.2 B-Spline Curvature Control 

Mouse/Key board Control Action Curve 

Left click on screen Create B-

Spline 
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Hold left key and drag the 

point 

Move the 

curvature 

 

Alt+ drag the point to the 

right 

Create 

corner point 

 

Alt+ drag the point to left Create 

smooth point 

 

When right click on control point, you get these options. 

1. Corner- creates corners. 

2. B-Spline – smooth the curvature. 

3. Centre- Create a centre according to adjacent point. 

 
Fig. 3.13 (a) Corner 

 
Fig. 3.13 (b) B-Spline 

 
Fig. 3.13 (c) Centre 

Assignment – 1 

Shoot a video footage using smartphone or DSLR and create shape over the focus object 

using B- Spline. 

3.1.3 X-Spline 

X-Spline is a most popular and easily editable spline format. Its points divided in three 

different types: Cardinal, Corner or B-Spline as shown in Figure 3.14. 

 

Fig. 3.14 Curvature Control Courtesy-SilhouetteFX 
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Table 3.3 X-Spline Curvature control 

Mouse/Key board Control Action Curve 

Left click on screen X spline shape 

creates. 

 

Alt+ Drag the point to the 

left 

The tension of 

the point goes 

to cardinal 

 

Alt+ Drag the point to 

toward right 

The tension of 

the point goes 

to corner 

 

Alt+ Drag the point to 

extreme right 

The tension of 

the point goes 

to B-spline 

 

You can also create corner, cardinal, B-spline and centre by right clicking on the point 

and selecting appropriate curve as shown in Figure 3.15. 

 

Fig. 3.15 X-spline right click option Courtesy-Author 
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Practical Activity 3.2 – Create a shape over the focus object using X-Spline tool. 

Step 1. Select X-Spline (S) from the Toolbar.  

Step 2. Click on the screen to create a control point as shown in Figure 3.16. 

 

Fig. 3.16 Create a control point Courtesy-Author 

Step 3. Add as many points as you like as shown in Figure 3.17. 

 

Fig. 3.17 Add multiple point to create shape Courtesy-Author 

Step 4. You can adjust curve by dragging control point as shown in Figure 3.18. 

 

Fig. 3.18 Curve adjustment using control point Courtesy-Author 

Step 5. When finished adding points, click the first control point that you added to close 

the shape as shown in Figure 3.19. 

 

Fig. 3.19 Shape Completed Courtesy-Author 

Step 6. Use as many points as needed to create the shape, but avoid using more than 

necessary. It is easier to successfully animate the shape with fewer points. 
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Know More… 

Bezier is used in inorganic shape like chair, table, lamp-post and many more. 

B spline & X Spline is used in organic shape like human roto and tracking. 

If over the period of time shape is changed then use X spline, B-spline. 

Assignment 2 

Shoot/ download a human activity video and Extract human using X-spline. 

Table 3.4 Comparison between Bezier, B-Spline and X- Spline 

Comparison Point Bezier B-Spline X-Spline 

Created by Control point and 

tangent/handle 

Control point Control point 

Curvature of the 

Shape control by 

Tangents or Handles Position of point and 

amount of pull on a 

point 

Position of point and 

amount of pull on a 

point 

Conversion No Convert in Bezier. Convert in Bezier. 

Control point 

Options 

Linear, Corner, 

Cardinal, Center 

Corner, B-Spline, 

Center 

Corner, Cardinal, B-

Spline, Center 

Utilisation Inorganic Shape Organic Shape Organic Shape 

Converting B-Splines or X-Splines to Bezier Splines 

You may convert your B-Splines or X-Splines to Bezier Splines at any time. 

Step 1. Click on Reshape tool. 

 

Step 2. Select a B-Spline or X-Spline shape by dragging the reshape tool as shown in 

Figure 3.20. 

 

Fig. 3.20 Select the shape using Reshape tool Courtesy-Author 

Step 3. Select Actions > Edit > Convert to Bezier as shown in Figure 3.21. 
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Fig. 3.21 Bezier conversion option Courtesy-Author 

Step 4. Now spline has converted in to the Bezier shape as shown in Figure 3.22. 

 

Fig. 3.22 Shape is converted to Bezier spline Courtesy-Author 

Once you select Convert to Bezier, a couple of things happen. The visibility of the B-

Spline or X-Spline is toggled to off. A new Bezier Spline is created and is named the 

same as the B-Spline or X-Spline but has an * at the end of the name as shown in Figure 

3.23. 

 

Fig. 3.23 Star mark over spline on timeline Courtesy-Author 

3.1.4 Square and circle 

Square and circle are included in Bezier spline. It is controlled by control point and 

tangent. It is useful when focus object has circular and rectangular type of shapes. 

Let’s create a circle on an object which has circular shapes. 

Step 1. Click the centre of the roto node in trees window and select circle tool from the 

tool bar. Create a circle on the object as shown in Figure 3.24. 

 

Fig. 3.24 Circle is created Courtesy-Author 
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Step 2. Select Transform (T) in toolbar and move the shape over the focus object, as 

shown in Figure 3.25. 

 

Fig. 3.25 Move the Circle Shape Courtesy-Author 

Step 3. Reshape tool is used to move individual point. Select reshape tool in toolbar and 

adjust shape using control points and handles, as shown in Figure 3.26. 

 

Fig. 3.26 Circle adjustment according to focus object Courtesy-Author 

Step 4. If needed, add additional control point by pressing Alt key and click on the 

outline of the shape, as shown in Figure 3.27. 

 

Fig. 3.27 Add additional control point Courtesy-Author 

3.1.5 Open Shapes/ Open Poly 

Open shapes or open poly is the kind of shapes which is open ended or not connected 

with their beginning and end point. Open shapes are good for rotoscoping strands of 

hair or thin objects. So let’s create an open shape for the hair strand. 
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Step 1. For creating open shapes, select Bezier, B-Spline or X-Spline from the Toolbar. 

We will select X-Spline this time. Click on the screen to create a control point and add 

point over the hair strand, as shown in Figure 3.28. 

 

Fig. 3.28 Open Poly/Shape Courtesy-Author 

Step 2. When finished adding points, select the Reshape tool. You can also press the 

Esc key to finish the shape. 

Step 3. Select the open shape in Object List window, as shown in Figure 3.29. 

 

Fig. 3.29 Select spline on object list Courtesy-Author 

Step 4. To match the thickness of the hair, you should use Stroke Width. Select it on 

Object. Adjust the Stroke Width according to the thickness of the hair and choose a 

flat or round Cap Style as shown in Figure 3.30 (a) & (b). 

 

Fig. 3.30 (a) stroke width in object list Courtesy-Author 
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Fig. 3.30 (b) stroke width results in Viewer Courtesy-Author 

Step 5. Now select Reshape tool from toolbar and click on open shape, here two 

controlling handle appears – Red and green. Red control the stroke width and green 

controls the feather as shown in Figure 3.31. 

 

Fig. 3.31 Stroke width and feather handle Courtesy-Author 

Step 6. Below you can watch alpha and colour comp view of open poly shape as shown 

in Figure 3.32 (a) & (b). 

 
Fig. 3.32 (a) Alpha view of open poly 

 
Fig. 3.32 (b) Colour Composite View 

 

Know More… 

To watch Alpha view of the shape, click 2 times A on keyboard. While Colour Comp 

or Colour composite view of the object can be watched by changing on view in 

Viewer’s panel as shown in Figure 3.33 

 

Fig. 3.33 Colour Comp View Courtesy-Author 
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Blend Mode 

It controls how shapes are blended together. You can find blend mode in object window 

if shape is selected in object list window. (Figure 3.34) 

 

Fig. 3.34 Different Blend Mode Courtesy-Author 

Blend mode is very useful while working on multiple object. Let’s illustrate with 

Practical activity 3.2. 

Practical Activity 3.2 – Demonstrate the working of Bend mode while using 

multiple object. 

Step 1. To understand blending you need two basic shape which overlap each other. 

So first create two shapes into roto node using Square as shown in Figure 3.35 (a) & 

(b) 3.36.  

 

Fig. 3.35 (a) Multiple Shapes Courtesy-Author 

 

Fig. 3.36 (b) Object List Courtesy-Author 

Step 2. You can watch shapes in alpha mode by clicking ‘A’ twice as shown in Figure 

3.36. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

48 

 

Fig. 3.36 Alpha View Courtesy-Author 

Step 3. Now select the ‘Square1’ shape in object list window. Its properties are showing 

in object window as shown in Figure 3.37 (a) & (b). Here we can change blend mode. 

 

Fig. 3.37 (a) Select the shape Courtesy-Author 

 

Fig. 3.37 (b) Shape properties Courtesy-Author 

Step 4. Now change the blend mode and observe the changes in viewer panel as 

shown in Figure 3.38 (a) –(f). 

 
Fig. 3.38 (a) Blend Mode-Add 

 
Fig. 3.38 (b) Blend Mode- Subtract 
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Fig. 3.38 (c) Blend Mode- Multiply 

 
Fig. 3.38(d) Blend Mode- Difference 

 
Fig. 3.38 (e) Blend Mode- Max 

 
Fig. 3.38 (f) Blend Mode- Inside 

Blend mode is useful if you want to subtract any area. 

3.2 Reshape tool 

The Reshape (R) tool modifies shapes by adjusting their control points and tangents. 

Once you create shape, then it can be modified with the help of reshape. 

3.2.1 Adding Control Point 

Step 1. Select Reshape (R)  from the Toolbar. 

Step 2. Click Alt on a selected shape to add a control point as shown in Figure 3.39 

(a) & (b). 

 
Fig. 3.39 (a) Adding reshape point 

 
 Fig. 3.39 (b) Control Point added 

You can also add control point on uncompleted shape. It is very helpful when you 

stuck between incomplete shapes. Follow these simple steps to complete shape. 

Step 1. Select reshape tool  from your toolbar. 

Step 2. Click on your shape. You will see that shape points are enabled as shown in 

Figure 3.40. 
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Fig. 3.40 Enable Control Point Courtesy-Author 

Step 3. Now select the shape point where you want to move further and hold Alt key 

to create new point as shown in Figure 3.41. 

 

Fig. 3.41 Create New Point Courtesy-Author 

Step 4. Hold alt key to complete the shape as shown in Figure 3.42. 

 

Fig. 3.42 Shape is completed Courtesy-Author 

3.2.2 Deleting Control Point 

Select the control point and press delete key as shown in Figure 3.43. 

 

Fig. 3.43 Delete Control point Courtesy-Author 
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3.2.3 Moving Control Point 

Select one or more control point and drag it as shown in Figure 3.44. 

 

Fig. 3.44 Move Control point Courtesy-Author 

3.2.4 Magnetic Reshape Tool 

In magnetic Reshape tool, points near the cursor move more than the points away 

from curser as shown in Figure 3.45 (a) & (b). 

 
Fig. 3.45 (a) Magnetic reshape (before) 

 
Fig. 3.45 (b) Magnetic reshape (after) 

3.3 Feather 

You can observe a red handle at every shape point. It is called feather handle. Shape 

points can be feathered to create variable edge blur as shown in Figure 3.45 (c) & (d). 

 
Fig. 3.45 (a) ‘Feather handle’ in X-Spline 

 
  Fig.3.45 (b) Feather in alpha mode 

You can apply feather in two type of shape- 

a) Closed Shape 

b) Open Shape 

Know More… 

The display of feather handle can be hidden or seen using SHIFT+F. 
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3.3.1 Closed Shapes- 

When shape beginning point is connected with end point, then it is called Closed shape. 

Let’s create feather in closed shape. 

Step 1. Select Reshape (R)  from the Toolbar. 

Step 2. Select a shape point and a red, outward feather handle appears as shown in 

Figure 3.46. 

 

Fig. 3.46 Select Shape Point Courtesy-Author 

Twice click A, to see the alpha matte as shown in Figure 3.47. 

 

Fig. 3.47 Alpha Matte View Courtesy-Author 

Step 3. Dragging this red handle outward will pull the feather out as shown in Figure 

3.48. 

 
Fig. 3.48 (a) Dragging Red Handle Outward 

 
 Fig. 3.48 (b) Alpha View of Feather 

After the initial drag, the outer feather point can be dragged around independently. 
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Step 5. Multiple selected points can be dragged simultaneously by a proportionate 

amount as shown in Figure 3.49. 

 
Fig. 3.49 (a) Feather on multiple point 

 
Fig. 3.49 (b) Alpha View of Feather 

3.3.2 Open Shapes 

Open shapes is used in hair rotoscoping. 

Step 1. Make an open shape using B-spline or X-spline as shown in Figure 3.50. 

 

Fig. 3.50 Open Shape Courtesy-Author 

Step 1. Select Reshape (R)  from the Toolbar. 

Step 2. Select an open shape by using Reshape tool as shown in Figure 3.51. 

 

Fig. 3.51 Select control point using reshape tool Courtesy-Author 

Step 3. Adjust the Stroke Width to set its thickness and choose either a flat or round 

Cap Style in the Object window as shown in Figure 3.52. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

54 

 

Fig. 3.52 Increase Stroke Width on object window Courtesy-Author 

Step 4. Once you've done this, additional per-point feather handles appear in red colour 

as shown in Figure 3.53 for the Stroke Width and a green one for the Feather. 

 

Fig. 3.53 Feather Handle Courtesy-Author 

Step 5. Just drag on the handles to make adjustments as shown in Figure 3.54. 

 

Fig. 3.54 Adjust the feather using feather handle Courtesy-Author 

Click 2 times A (AA) to see the shape matte as shown in Figure 3.55. 

 

Fig. 3.55 Alpha View of Feather Courtesy-Author 

Step 6. Multiple selected points can be dragged simultaneously by a proportionate 

amount as shown in Figure 3.56. 
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Fig. 3.56 Feather on Multiple Selected points Courtesy-Author 

 

Fig. 3.57 Alpha View Courtesy-Author 

3.4 Navigating the viewer with tools: 

In SilhouetteFX© software, navigation in viewer is essential for rotoscoping. Most of the 

time, you need to enlarge the frame for see the detail of the focus object. 

Action Shortcut keys 

Maximize Viewer F3 

Zoom in + or move mouse wheel forward 

Zoom out - or move mouse wheel backward 

Navigate the object or panning SPACE + hold the left mouse button 

Go to the Next frame X 

Go to the previous frame Z 

3.5 Breakdown subject in to Shapes for rotoscoping 

As discussed in Chapter 1, you need to breakdown object in different shapes to perform 

roto work easily. Now you have the knowledge of different shape likes Bezier, B-Spline 

and X-Spline. Some important steps are mentioned here which will help you to convert 

subject in to shapes for rotoscoping. 

Analyze the Clip – Playback the video-clip and determine the frame that have complete 

shape of focus object with sharp detail. This frame requires maximum number of points 

to create shape which can be reduced, if not required further. 

Select a Spline Type – After selecting frame for rotoscoping, you need to determine 

spline type. In SilhouetteFX©, you can create shapes by using B-Splines, X-Splines, 

Bezier splines, Circles and Squares. 

Create Shapes with Less Points – Use as many points as needed to create the shape, 

but avoid using more than is necessary. The fewer the points, the easier it is to 

successfully animate the shape. Unnecessary shape complexity inevitably leads to 

inconsistency when editing points. 
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Create Multiple Shapes – Never try to roto the object by using single shape. Always 

create multiple shapes to Roto complex object. Drawing separate shapes for the major 

parts of an object give you finer control over motion. 

Now using these tips, lets create shapes for given object. 

Practical Activity 3.3 – Breakdown the given boat in to multiple shapes. 

Step 1. Analyze video footage before breakdown the object. Playback it many times and 

find out the frame which has complete shape and detail (Figure 3.57). 

 

Fig. 3.57 Playback the footage multiple times Courtesy-Author 

Step 2. Observe that first frame has complete shape and detail. So start roto from this 

frame but it is better to find frame with maximum detail and shape, whether it is 1st, 

25th or even last frame. Now see the last frame of the footage and compare it with first 

frame. It helps you to decide in shape breakdown (Figure 3.58). 

 

Fig. 3.58 Last Frame Courtesy-Author 

Step 3. After analyzing these two frames, breakdown the boat in following shapes so 

that they can easily animate (Figure 3.59). 
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Fig. 3.59 Shape Breakdown Visualisation Courtesy-Author 

Step 4. Select Bezier tool from tool panel and start tracing first shape (Figure 3.60). 

 

Fig. 3.60 Tracing the frame through Bezier spline Courtesy-Author 

Step 5. In the completion of the shape, click on the first point (Figure 3.61). 

 

Fig. 3.61 First Shape is completed Courtesy-Author 

Step 6. Once again check the Shape 1 and delete unnecessary points (Figure 3.62). 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

58 

 

Fig. 3.62 Delete unnecessary points Courtesy-Author 

Step 7. Now make second shape for this, once again select Bezier tool and make first 

point (Figure 3.63). 

 

Fig. 3.63 Create point for Second shape Courtesy-Author 

Step 8. By joining beginning and end point, shape will be completed (Figure 3.64). 

 

Fig. 3.64 Join beginning and end point Courtesy-Author 

Step 9. In this way, you can breakdown the subject in to different shape (Figure 3.65). 
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Fig. 3.65 Object breakdown in multiple shapes Courtesy-Author 

Step 10. Press twice the key with letter A on keyboard and watch the final object in 

alpha channel (Figure 3.66). 

 

Fig. 3.66 Output Alpha view Courtesy-Author 

Step 11. This is color composite output of the subject (Figure 3.67). 

 

Fig. 3.67 color composite output Courtesy-Author 

So, with the help of different splines you can breakdown your object in different shape, 

which helps you on rotoscoping. In the next chapter, we will learn to animate the shapes. 

Summary 
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Bezier is a same tool you used as the Photoshop or after effects pen tool. 

X-spline and B-spline is used for rotoscoping organic shapes like humans or animals. 

B-spline and X-spline don't use handles to control the shape; instead they create the 

curvature automatically. 

B-Spline and X-spline can be converted to Bezier but Bezier cannot be converted to any 

other shape. 

Square and Circle shape belong to Bezier shape. 

In any shapes, reshape tool is used to adjust individual points. 

Open shape or open poly is used to roto thin object such as hair strands. 

Blend mode can add, subtract, multiply and differentiate between two shapes. 

Never create single shape for whole object, break it into the multiple shapes for hassle 

free rotoscoping. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. B Spline, X Spline and Beziers are________(a) Animating Tools (b) Drawing Tools 
(c) Tracker (d) Paint tool 

2. Bezier splines are defined by (a) Control points (b) Tangents (c) Control points 
and tangents (d) Feather handle 

3. In Bezier spline, curvature appears by (a) Left click on screen (b) Hold down left 
click (c) Click and drag tangent handle (d) CTRL+drag tangent handle 

4. Short-key for bezier spline is (a) B (b) S (c) Shift+B (d) Shift+S 

5. B-Spline doesn't use (a) Curvature (b) tangents or handles (c) Depth (d) Cardinal 

6. Create corner point in B Spline by (a) Hold left key and drag the point (b) Alt+Drag 
the point (c) Left click on screen (d) Alt+drag the point to left 

7. X-Spline points does not have (a) Cardinal (b) Corner (c) B-Spline (d) Tracker 

8. In which shape, B spline and X Spline is not used (a) Inorganic shape (b) Organic 
shape (c) Complex Shape (d) Simple shape 

9. Open Shape is useful for (a) Face Roto (b) Hand Roto (c) Hair Roto (d) Cloth Roto 

10. Reshape tool modifies shapes by (a) adjusting control point (b) tangents (c) 
Control point and tangents (d) None of the above 

B. Fill in the blanks 

1. In Bezier tool tangent or handle controls______________. 

2. In Bezier tool, right clicking on any control point, cardinal appears which 

create_______. 

3. B-Spline creates ___________ automatically. 

4. Shape can be adjusted by _________ tool. 

5. In magnetic Reshape tool, points near the cursor____ than the points away from 
curser. 

6. Red handle in every shape point is called_________. 

7. Dragging red handle______ will pull the feather out. 

8. Short-key for go to the next frame is______. 

9. Create_______ shapes to Roto complex objects. 

10. Press _________on keyboard, to watch the final object in alpha channel. 
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C. True or False 

1. Square and circle are animating tools. 
2. Bezier tool is as similar as Pen tool in Photoshop. 
3. In Bezier, selecting corner by right clicking collapses both tangent point. 
4. You can create B-spline by right click on viewer. 
5. In X spline, you can create cardinal, corner and B-spline by right click on the 

point. 
6. Bezier can be used in organic shape. 
7. Once you select Convert to Bezier, the visibility of the B-Spline or X-Spline is 

toggled to off. 
8. To create a perfect square, hold down the CTRL key while clicking and dragging 

in the shape of a square. 
9. In open poly, you need to connect first point with end point. 
10. You need to adjust the stroke width to set the thickness of open shape. 

D. Short answer questions 

1. Write the use of different drawing tools used in rotoscoping. 
2. What is Bezier? When it is used. 
3. How to adjust Bezier curve? 
4. What is B-spline and X-spline? 
5. Write the Comparison between Bezier, B-spline and X-Spline. 
6. How can you control X-Spline Curvature? 
7. What is Reshape tool? Write its use on drawing shapes. 
8. How to add control point on uncompleted shape? 
9. What is Edge Feather? 

10. Write the use of Edge Feather in roto shape. 

11. Write the steps to break an object in multiple shapes. 

 

Session 4. Roto Artist – Roles and Responsibility 

 

In the last chapter, you have learned the object breakdown technique using splines and 

breakdown the boat in the multiple shapes. Now you need to animate shapes according 

to the subject movement. If you compare first frame of your subject with the last frame 

as shown in Figure 4.1 & Figure 4.2, then you can find that your boat is moving, 

although shape is still there. So here you need to animate the shapes over the object. 

 

Fig. 4.1 First frame of the boat with spline Courtesy-Author 
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Fig. 4.2 Last frame of the boat with spline Courtesy-Author 

Let us learn the two important tools that are required to animate the boat shape. 

1. Transform tool – to move the shape. 

2. Reshape tool – to adjust the shape according to focus object. 

4.1 Transform tool 

Transform tool is used to animate the shape. The boat which is breakdown into multiple 

shapes needs to change over time according to the object movement. For this you have 

to adjust the shape so that it exactly matches the focus object. The Transform tool 

affects an entire shape or a group of shapes. 

Enable the tool panel to locate the transform tool of roto node. Transform tool is divided 

in two modes as shown in Table 4.1. 

Table 4.1 Transform Mode 

Transform Mode Icon Shortcut Key 

Shape (Object) Mode 

 

T 

Point (Sub-object) Mode 

 

TT 

4.1.1 Shape (Object) Mode 

Shape mode deals with the shape as a whole, without changing the point individually. 

When you are working in a shape mode, a bounding box appears around the shape as 

shown in Figure 4.3. With this bounding box, a shape can be positioned, moved, scale, 

rotated, sheared or corner-pinned. 

It is preferable to manipulate the spline in Shape mode because it keeps the shape 

constant for the life of that shape and minimizes jitter. 

 

Fig. 4.3 Shape Mode Courtesy-Author 
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4.1.2 Point/ Sub-object Mode 

To manipulate small portion of the shape, you need to deal with point mode. Point Mode 

allows to position, move, scale, rotate and corner pin a selection of point in shapes using 

on screen controls. In Point mode you need to select control point by using reshape tool 

as shown in Figure 4.4 (a) then you can transform these point as shown in Figure 4.4 

(b). 

 

Fig. 4.4 (a) Select control Point 

 

Fig. 4.4 (b) Enable Point Mode 

Once you select the shape, you can modify it in both Shape and Point mode. 

Moving shape 

It is required to move shapes according to object rather than just moving it horizontally 

and vertically. Follow the following steps to moving the shape. 

Step 1. Make sure that Transform (T)  Shape Mode is enabled. 

Step 2. Select a shape or series of shapes as shown in Figure 4.5. 

 

Fig. 4.5 Select a Shape Courtesy-Author 

Step 3. Drag on the outline of one of the shapes, as shown in Figure 4.6. 

 

Fig. 4.6 Drag the outline of the shape Courtesy-Author 

Hold the shift key during the movement of the shape. It will constrain the movement by 

the first direction that you drag in. 

Nudging Shapes 
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Sometimes it is required to do the little movement of the shape. It is performed by 

Nudging Shapes. Shapes can be nudged horizontally or vertically using the arrow keys. 

Pressing the arrow key single time moves the shapes 1 pixel. Using the Shift key in 

conjunction with arrow keys moves the shapes by 10 pixels. 

Scaling Shapes 

Scaling changes the size of the shapes. Figure 4.7 (a) & (b) shows the shape before 

scaling and after scaling. To enable scaling tool, go to the bounding box corner. In 

scaling, hold down the shift key for proportion. 

 

Fig. 4.7 (a) Scaling shapes (before) 

 

Fig. 4.7 (b) Scaling shapes (after) 

Rotating 

It changes the angle of shape. It is very helpful in human rotoscoping because there you 

need to rotate the shapes according to object movement. 

To enable rotating hold down the Ctrl key on bounding box corner and drag the mouse 

to rotate the shape, as shown in Figure 4.8 (a) & (b). 

 
Fig. 4.8 (a) Rotating tools enable 

 
Fig. 4.8 (b) Rotating the shape 

Corner-Pinning Shapes 

The corner points of a shape’s bounding box can be corner-pinned. For instance, you 

can easily fit the shape into the corners of a boat, as shown in Fig. 4.9 (a) & (b). For 

Corner Pinning select the shape, hold Alt Key and drag the corner of the shape. 

 
Fig. 4.9 (a) Hold Alt key and select 

the corner 

 
      Fig.4.9 (b) Corner Pinning on 

the right top corner 
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Shearing Shapes 

It is a technique of transformation, which changes the shape of an object along X and Y 

axis. In shearing, shape being skewed horizontally or vertically. To perform shearing, 

hold the Ctrl key and drag on the midpoint of the shape bounding box either in vertical 

or horizontal axis, as shown in Fig. 4.10 (a) & (b). 

 

Fig. 4.10 (a) Shearing (before) 

 

Fig. 4.10 (b) Shearing (after) 

Anchor Point – A shape rotates around its anchor point, but scales from the opposite 

handle. Moving the anchor point changes the centre of rotation and scaling when using 

the on-screen controls. You can activate and deactivate anchor point by pressing (.) 

period key. You can also shift anchor point by holding down left mouse key and drag. 

As shown in Figure 4.11 (a) – (c). 

 
Fig. 4.11 (a) Anchor Point 

 
  Fig. 4.11 (b) Shifting 

Anchor Point 

 
Fig. 4.11 (c) Scales from 

opposite handle from 

anchor point 

Assignment 1 

Practice following tools to animate shape according to focus object. 

1. Moving 2. Shearing 3. Scaling4. Corner Pinning 5. Anchor Point 

4.2 Setting the Anchor Point and using special transformation tool 

Whenever you animate shapes, initially you need these three tools- move, rotate and 

scale. These are the short keys of these tools, as shown in Table 4.2 

Table 4.2 most widely used Transform tool 

Q Activate and Deactivate Moving tool 

W Activate and Deactivate rotation with anchor point 

E Activate and Deactivate Scale with anchor point 

Assignment 2 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

66 

Animate any breakdown shape of object by using Q (moving), W (rotation) and E (scale). 

Only use these short keys to modify the shapes. 

4.3 Using Reshape tool in transformation 

Reshape tool is used in drawing shape. But once you start moving shapes according to 

subject, you need to reshape it to cover the focus object as shown in Figure 4.12.   

 

Fig. 4.12 Reshape the group of key frames Courtesy-Author 

Know More… 

Never move an individual control point. Because it can create jittery movement. Always 

move group of point while using reshape tool. 

4.4 Key frame Techniques 

There are essentially two ways to animating shapes for rotoscoping- 

1. Timeline key framing 

2. Motion-based key framing 

Timeline key framing – It involves placing key frames at set intervals within the 

timeline, without taking into account the motion of the focus object. 

Motion-based key framing – In this technique, key frames are created on the basis of 

movement and direction of the focus object. 

4.4.1 Timeline Key framing – In this technique roto-artist establishes key frame on 

the timeline. It is useful when your focus object does not have definite movement but 

has similar shapes for long duration and even till disappearing from frame. It can be 

divided in two techniques. 

Bifurcation – It means division of something in to two branches or parts. In this 

technique the total number of frames is divided in two parts and then modifies it. To 

understand it, 

Suppose Total frames = 180 

So you need to modify shapes 1st and 180th frame. 

Then find middle frame, which is 90th frame, you need to modify it first. In this way, you 

can modify 45th, 23th and others middle frame till then, you get perfect movement of 

the shapes according to object.    

Practical Activity 4.1 – Animate the boat by using Bifurcation technique. 

We have already seen to breakdown the shape of the boat in Chapter 3. Now we will 

animate the shapes over the focus object (boat). 
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Step 1. Observe the shape breakdown in Figure 4.13 and decide which shape you want 

to animate first. Here you can see the object list and timeline. In object list you have all 

the shape and in timeline, key frame will be inserted. 

 

Fig. 4.13 Shape Breakdown Courtesy-Author 

Step 2. In Object list, disable all shape except Bezier. Now you can observe in Figure 

4.14, single shape is enabled on screen. 

 

Fig. 4.14 Disable all shapes except Bezier Courtesy-Author 

Step 3. To animate the shape according to focus object, select transform tool as shown 

in Figure 4.15 from tool panel. Click on transform tool, shape transform enables in 

viewer panel. 

 

Fig. 4.15 Select Transform tool Courtesy-Author 
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Step 4. Move to last frame, by pressing End key on keyboard. You can observe in Figure 

4.16, boat has changed place while shape is still. You need to move the shape by using 

Shape transform tool. 

 

Fig. 4.16 Move to last Frame Courtesy-Author 

Step 5. For moving the shape over object, place the cursor on the outline of the shape. 

The move tool will now be displayed as shown in Figure 4.17. Hold the left key and 

move the shape over the boat. 

 

Fig. 4.17 Drag the shape using Move tool Courtesy-Author 

Step 6. Observe that shape is not perfectly matching with object. So, you need to adjust 

its angle by pressing W key on keyboard which enables rotate tool as shown in Figure 

4.18. 

 

Fig. 4.18 Select Rotate tool Courtesy-Author 

Step 7. Once you adjust the angle, you need to adjust group of points. For this, select 

the Reshape Tool from tool bar and select group of point as shown in Figure 4.19 
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Fig. 4.19 Select Reshape tool Courtesy-Author 

Step 8. Drag the group of points with mouse and place it according to the boat as shown 

in Figure 4.20. 

 

Fig. 4.20 Drag group of points Courtesy-Author 

Step 9. In Figure 4.21, observe that key-frame is automatically placed in the last frame. 

It means as you animate the shapes, key-frame is inserted in timeline. 

 

Fig. 4.21 Key frame inserted in last frame Courtesy-Author 

Step 10. In bifurcation method, bifurcate the frame and modify the middle one. So, you 

need to modify 90th frame (Figure 4.22). 
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Fig. 4.22 Navigate the cursor in Middle Frame Courtesy-Author 

Step 11. Modify it with reshape tool as shown in Figure 4.23. 

 

Fig. 4.23 Modify the Shape Courtesy-Author 

Step 12. In this method, each time you need to modify the bifurcated frame as shown 

in Figure 4.24, until the correct movement of shape according to focus object is 

achieved. 

 

Fig. 4.24 Modify the Shape using Bifurcation Method Courtesy-Author 

4.5.2 Incremental Key Frames 

If the focus object to be isolated cannot be confined to any set key frame structure, then 

you may need incremental key frames to isolate that focus object. This involves creating 

a key frame for focus object, moving forward or backward a set number of frames, and 
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establishing another key. Repeat this key frame pattern until the shape is sufficiently 

isolated or is no longer the shape in which it started. 

 

Fig. 4.25 Frame Interval (10 frames) Courtesy-Author 

Practical Activity 4.2 – Animate the boat shape using incremental key-frame 

technique. 

We will again take the same boat and animate its shape by using incremental key frame 

technique. 

Step 1. In this technique, start animating frame from beginning. So, move viewer 

indicator to first frame (Figure 4.26). 

 

Fig. 4.26 First Frame Courtesy-Author 

Step 2. Now set the number of frames for frame incremental on frame steps. You can 

find frame steps on the right bottom of the viewer panel as shown in Figure 4.27. This 

time we will set 30 frame steps and press Enter. 

 

Fig. 4.27 Set the Frame Steps Courtesy-Author 

Step 3. Since you set 30 frame-steps, so as you press the X key the next frame will be 

30 frames forward as shown in Figure 4.28. 
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Fig. 4.28 Move 30 frame forward Courtesy-Author 

Step 4. Select transform tool (T) from tool panel as shown in Figure 4.29. A bounding 

box will show on viewer. Now you need to animate the shape according to focus object. 

 

Fig. 4.29 Select Transform tool Courtesy-Author 

Step 5. Go to corner of bounding box and hold Alt key to corner pinning the shape 

(Figure 4.30). 

 

Fig. 4.30 Corner Pinning the Shape Courtesy-Author 

Step 6. If required, select Reshape tool to modify the group of points (Figure 4.31). 
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Fig. 4.31 Select Reshape tool to modify the Shape Courtesy-Author 

Step 7. Once the shape adjustment is completed, Press X again to move 30 frames 

forward (Figure 4.32). 

 

Fig. 4.32 Move 30 Frame backward Courtesy-Author 

Step 8. Once the frame is forwarded, adjust the current frame using transform and 

reshape tool (Figure 4.33). 

 

Fig. 4.33 Adjust the Frame using Transform and Reshape tool Courtesy-Author 

Step 9. By using this method, you can forward the frame and adjust it. 
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Step 10. Once, you reached at the end frame. Go in between frame to adjust the shape 

movement according to focus object. You can also playback it frame by frame and make 

any adjustment you need. 

Summary- 

To animate any shape, you need Transform and Reshape tools. 

Shape mode deals with the shape as a whole, while point mode allows you to manipulate 

small portion of the shape. 

In Transform mode, you can move, nudge, scale, rotate, corner pin and shear the shape. 

Use these three tools- Q (Move), W (Rotate) and E (Scale), to animate the shape quickly. 

Anchor Point can be hidden or reveal by using (.) period key and the point can be moved 

by transform tool. 

In Bifurcation technique, all the frames are divided in two parts and then modified. 

You can set number of frame-step in incremental key frames. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. Transform tool is used to (a) Modify the control point (b) Animate the shape (c) 

Draw the shape (d) Track the shape 

2. Transform tool divided in (a) Shape mode (b) Point mode (c) layer mode (d) Shape 

and Point mode 

3. Keyboard shortcut of Shape mode is (a) T (b) TT (c) R (d) RR 

4. Shape mode deals with______ (a) Shape created with some control point (b) Shape 

as a whole (c) The control point individually (d) 

5. When you working in a shape mode (a) A bounding box appear around the shape 

(b) A dotted line appears around the shape (c) A circle appears around the shape 

(d) A control handle appears on control points 

6. In transform mode, move tool enables when place curser over the (a) Between two 

point in bounding box (b) Corner of bounding box (c) Centre of the bounding box 

(d) Outline of the shape 

7. Using the Shift key in conjunction with the Arrow keys moves the shapes- (a) 1 

pixel (b) 5 pixels (c) 10 pixels (d) 15 pixels 

8. For Corner Pinning, select the corner point of the shape and (a) Hold Ctrl key (b) 

Hold Shift key (c) Hold Alt key (d) Hold Page Down key 

9. A Shape rotates around its (a) Control Point (b) Anchor Point (c) Centre point of 

bounding box (d) Opposite control point 

B. Fill in the blanks 

1. Reshape tool is used to move _______ according to focus object. 

2. Keyboard shortcut of Point mode is____. 

3. Point mode manipulates ________of the shape. 

4. In Point mode you need to select control point by using __________. 

5. Scaling changes the ___________. 
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6. To enable rotating hold down the ______on bounding box corner. 

7. A shape rotates around its anchor point, but____ from the opposite handle. 

8. Q, W and ____ are the combination of transform tool. 

9. Timeline key-framing involves establishing key frames at________ . 

10. Creating a key frame for focus object, moving forward or backward in a set 

amount of frames is___________.   

C. True or False 

1. Transform tool is used to adjust the control point. 

2. Shape mode is also known as Point mode. 

3. Once you select the shape, you can modify it in both shape and point mode. 

4. Shapes can be nudged horizontally or vertically using the Arrow keys. 

5. You can activate and deactivate anchor point by (.) period key. 

6. In bifurcation technique, we select the in-between frames. 

D. Short answer questions 

1. Write the use of Transform tool? 

2. What is Shape Mode? Explain it. 

3. What is Point Mode? Write its uses in animating shape. 

4. How can you, (a) Rotate Shape (b) Corner-Pinning Shape 

5. Write the use of Anchor Point.  

6. Explain the transform tools, which are widely used while animating shape. 

7. in which situation, you should use Key frame technique?   

8. What is bifurcation key frame technique? Explain it with example.  

9. When is the Incremental key frame technique used? 

 

 

Module 2 

 

 

Roto Techniques in 

SilhouetteFX© 

 

Module Overview 

 

Most of the time, you may encounter some kind of blur in the footage, when you begin 

rotoscoping. This is either due to depth of field blur or motion blur. In this unit, you 

will understand these two blur types and their differences. Further, you will 

understand various methods to handle these blurs while rotoscoping. 

Tracker is a like a speed booster in rotoscoping. We will describe motion tracking and 

demonstrate the use of point, planer and mocha tracker. 

Roto-artist spends their maximum time in human rotoscoping. It is tedious task to 

perform because of unpredictable human movement. So, we will take a glance about 

human anatomy, breakdown of human shapes, isolating human extremities such as 

arms, legs, feet and hands. Further you will understand the palm and finger isolation 
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methods. In addition, you will come to know about Inverse kinematics (IK), which helps 

to capture natural human movement.  

 

Learning Outcomes 

After completing this module, you will be able to: 

• Understand how to apply blur and motion blur effects to enhance realism and 

movement in visual content. 

• Describe the learn to track motion within footage to accurately integrate and 

synchronize visual effects. 

• Develop skills in rotoscoping techniques specifically for human figures to ensure 

precise animation and visual integration. 

• Demonstrate the techniques for rotoscoping complex elements such as hair to 

achieve natural and seamless results. 

 

Module Structure 

Session 1. Blur and Motion Blur 

Session 2. Motion Tracking 

Session 3. Human Figure based Rotoscoping  

Session 4. Rotoscopy of Hair    

Session 1. Blur and Motion Blur 

In last chapter, you have learned two important aspect of rotoscoping, i.e. drawing the 

shape and its movement. In rotoscoping, it is always challenging to create shapes or 

animating it, which have blur and motion blur. Before going deep in that, you need to 

understand the difference between these two. 

In the first part of this chapter, you will understand about depth of field blur, which 

creates by the focal length of the camera. If the focal length remains same then amount 

of blur will be the same. But if the focal length changes, amount of blur will also be 

changed. In Figure 1.1, you can see the flower in focus while foreground and 

background are blurred or out of focus. This type of blur can be created by the focal 

length of the camera. 

 

Fig. 1.1 Blur created from focal length of the camera Courtesy-Pixabay.com 

While in other side, motion blur is slightly different from depth of field blur. Motion blur 

occurs when a focus object is in fast motion and camera is unable to capture all frames 
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as shown in Figure 1.2, where the ball is in motion and creating motion blur. Like in 

car racing or fighting scenes, if you are capturing the scene from your smart phone then 

definitely there will be a chance of motion blur except not using slow motion mode. 

Basically, in Motion blur focus object travels a great distance over a short number of 

frames. The image blurs because the camera’s shutter doesn’t open and close fast 

enough to visually capture the moment. 

While in other side, slow-motion footage is captured at a much higher number of frames 

per second. Thus it is not affected by motion blur because there are more frames to 

correctly capture the movement of the elements in the footage. Everybody have 

smartphone in their pocket with slow motion function. Motion blur is not uniform for 

complete footage; it depends upon the speed of the object while depth of field blur 

remains similar for complete shot. 

 

Fig. 1.2 Motion blur on table tennis ball Courtesy-Author 

Assignment 1 

Download or shoot a video clip and identify the difference between depth of field blur 

and motion blur. 

1.1 Depth of Field Blur 

Let us consider an object which has crispy sharp edge in the footage. Because most of 

time, there is a chance of edge blur. In the footage having some kind of blurriness, you 

have to blur your shapes, such that it can meet the focus object blurriness. This is your 

only target, when you roto any blur object. So first, find the blur setting that matches 

the object blurriness and second, keep that amount for the whole duration. 

Let us recall quickly, where you get this blur setting? When you create spline, it displays 

on object list while its control shows on object window, as shown in Figure 1.3. 

 

Fig. 1.3 Spline blur setting Courtesy-Author 

When using the mattes, compositor should know how much blur to apply to the mattes. 

As long as you keep your spline consistent with the edge of the focus object, the 

compositor will have the ability to blur that shape as per the requirement. 
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Consider the Figure 1.4 (a) & (b). Here we will try to isolate the person, who is sitting on 

foreground. Observe that the plant is crisp and clear on this video however the man is 

out of focus. To isolate the man from the frame, we are going to create a shape which 

has the same amount of blur as the frame has. 

 
Fig. 1.4 (a) Footage Courtesy-Author 

 
Fig. 1.4 (b) Focus edge Courtesy-Author 

Practical Activity 1.1– Create a shape for face having same amount of blurriness. 

Step 1. Create a project in SilhouetteFX©v7.1. Import footage and create a new session 

as shown in Figure 1.1. Insert roto node between source and output node. 

 

Fig. 1.5 Create a session Courtesy-Author 

Step 2. Select the X-spline and create shape into his face. When creating shape, 

reference to the edge and edge blur of focus object is very important. Once you get the 

position, keep it in same relative position further. 

Step 3. This spline has been placed on the extreme edge of the blurred focus object. It 

means that without any blur attached to the spline; the matte would appear solid, 

having no gradient at its edges. In Figure 1.6 (a) – (d) From a distance this spline looks 

great and seemingly isolates the focus object. 

 

Fig. 1.6 (a) Footage 

 

Fig. 1.6 (b) Spline 

positioned at extreme ends 

of blur object 
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Fig. 1.7 (c) Overlay matte 

 

Fig. 1.7 (d) Alpha matte 

Step 4. When you zoom in the focus object, you can see that solid edge of the shape 

does not accurately match with the gradient edge of the focus object, as shown in Figure 

1.8 (a). If you compare the edge gradient then the footage has gradient in cream colour, 

while in alpha channel and matte overlay, there is no gradient as shown in Figure 1.8 

(b). 

 
Fig. 1.8 (a) Comparison of Edge 

 
 Fig. 1.8 (b) Gradient in the edge Courtesy-Author 

Step 1. Now, to make this alpha matte more accurate, you have to use spline control to 

blur the edge of this spline. Since, we have placed the spline at the extreme end of the 

blur as shown in Figure 1.6 (b). So, set the blur type as Inner, to apply the blur effect 

inward as shown in Figure 1.9 (a), (b) & (c). 

   

Fig. 1.9 (a), (b) & (c) Spline controls Courtesy-Author 

By using spline blur setting, we are going to match the gradient of the focus object with 

shape. For this, we will compare, where the focus object gradient begins and ends to 

the correlating edge gradient of the spline. 
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Step 6. With an edge blur of 5 in Figure 1.10 (a), the blur doesn’t match the focus object. 

When, you increase blur value to 7 pixels, it become closer, but not accurate to compare 

the focus object edge gradient as shown in Figure 1.10 (b). If you compare between these 

two values, you will find that this spline needs a 10-pixel blur to accurately isolate the 

focus object, as shown in Figure 1.10 (c). 

 
Fig. 1.10 (a) 5 Pixel inner 

blur 

 
Fig. 1.10 (b) 7 Pixel inner 

blur 

 
Fig. 1.10 (c) 10 Pixel inner 

blur 

If you want to check whether the blur is correct, place the pointer where the blur on the 

footage begin and end. After that, toggle between alpha channel and footage. This allows 

to check whether the edge blur of matte matches the footage edge blur. 

If particular rotoscoping program doesn’t allow you to control the direction the blur will 

affect the spline. You have to find the spline placement that will correctly emulate the 

edge blur of the focus object. You need to figure out how your roto program of choice 

handles spline blur and compensate appropriately. 

Choosing how the blur affects the spline will seriously control how you place the spline 

on the blurred focus object. The values in Fig. 1.11 are pumped up to a 30-pixel blur to 

show the differences between the types of edge blur that can be applied to shape. 

Outer – This setting will make the matte 100 percent visible starting on the outside of 

the spline, and then gradually, over the amount of blur setting, it will become 0 percent 

visible. 

Centered – This blur setting will keep the pixels along the spline’s edge 50 percent 

visible. 

Inner – The spline will be 0 percent visible at the spline, and then the head will gradually 

become more visible as we go inward on the spline. 

Once it is established the appropriate blur that will accurately reflect the edge of the 

focus object, you need to keep your spline at the same distance from the focus object 

edge for the life of the spline. 

 

Fig. 1.11 Comparison of Outer, Centered and Inner blur Courtesy-Author 
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Assignment 2 

Capture a video with depth of field blur by using a smartphone or DSLR camera. Create 

a shape over it using SilhouetteFX© software and match its blur with focus object’s blur. 

1.2 Motion Blur 

Motion blur is different from blur achieved by focal length. It is the result of camera 

shutter. In motion blur, you don’t rely on spline control, as in focal length blur. Here 

you need to control the blur by the edge feather. 

As you know that the Edge feather is created by the feather handle and displayed as 

dotted lines as shown in Figure 1.12 (a), (b) & (c). 

 
Fig. 1.12 (a) Feather 

handle 

 
 Fig. 1.12 (b) Feather in 

dotted line 

 
Fig. 1.12 (c) Alpha 

channel 

Applying motion blur to the mattes you create is useful, if these mattes are accurately 

isolating the focus object. Isolating a focus object with high motion blur without 

including the graduated edges would make the mattes nearly impossible to use. This is 

something all roto artists must deal with on a pretty consistent basis. 

Table 1.1 Comparison between Depth of Field blur and Motion blur 

 Depth of Field blur Motion blur 

Created by Camera lens Slow shutter speed 

Effected by Focal length of lens, aperture and 

object distance 

Object speed 

Impact Cinematic, artistic Suspense, thriller 

Example Close-up of flower, Extreme close-up 

shots 

Action sequences, fast moving 

cars 

Practical Activity 1.2 – Create a matte for motion object. 

Step 1. Import the video frames in SilhouetteFX©v7.5 as shown in Figure 1.13. Select 

File> Import> media to import the video frames. 
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Fig. 1.13 Import Footage Courtesy-Author 

Step 2. Select Session> New session to create a new session. Name the session and 

click on OK button (Figure 1.14). 

 

Fig. 1.14 New Session Dialog box Courtesy-Author 

Step 3. Session is formed in trees window. Here you can observe the interface of the 

software as shown in Figure 1.11. 

 

Fig. 1.15 Session is created Courtesy-Author 

Step 4. To perform rotoscoping, find the roto node into Node window. Insert it between 

object and output node as shown in Figure 1.16. 
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Fig. 1.16 Insert Roto Node  Courtesy-Author 

Step 1. Press F3 to maximize viewer, Playback video frame on viewer panel. Focus on 

object sharpness and shape. Find the frame which you are going to start Roto. We found 

14th frame as shown in Figure 1.17, appropriate to start the roto. 

 

Fig. 1.17 Find out the appropriate frame to start roto Courtesy-Author 

Use L, K and J key respectively to Play, Pause and Reverse video on viewer’s panel. 

Step 6. Now press = key to zoom in to the palm as shown in Figure 1.18. 

 

Fig. 1.18 Magnify the Palm Courtesy-Author 

Step 7. To roto the object, select the Bezier tool as shown in Figure 1.19, from tool bar. 

 

Fig. 1.19 Bezier tool 

Step 8. Try to break the focus object in to multiple shapes. You can breakdown in to 

the finger, palm and hand as shown in Figure 1.20. 
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Fig. 1.20 Breakdown the focus object in multiple shapes Courtesy-Author 

Step 9. Once roto work is completed, you should check the shape’s outline in overlay 

and alpha view as shown in Figure 1.21. For this, Press A for Overlay view and AA for 

Alpha view. 

 
Fig. 1.21 (a) Overlay View 

 
Fig. 1.21(b) Alpha View Courtesy-Author 

Step 10. Press numeric Key 4 for Color comp view (Figure 1.22) and numeric key 0 to 

hide the outline of shape. Now view the output. Decide is there any requirement of the 

edge feather. If yes, then enable feather control. 

 

Fig. 1.22 Colour Comp View Courtesy-Author 

Step 11. Select feather handle in spline as shown in Figure 1.23 and use required 

feathers on the shapes. Feather can be viewed as a dotted outline in the shape. 
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Fig. 1.23 Select Feather Handle (Red dotted line) in Spline Courtesy-Author 

Step 12. Now see this Colour Comp output by pressing Numeric Key 4 (Figure 1.24). 

You can compare it with Figure 1.23. 

 

Fig. 1.24 Colour Comp View Courtesy-Author 

Step 12. You can see in timeline that we are rotoscoping in frame 15 as shown in Figure 

1.21. 

 

Fig. 1.25 15th Frame Courtesy-Author 

Step 13. Now use incremental key frame technique and set 5 frame intervals in Frame-

steps as shown in Figure 1.26. 
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Fig. 1.26 Set Frame interval Courtesy-Author 

Step 14. Press Z to move the frame backwards by 5 frames (Figure 1.27). Here you can 

see that object has moved while the shape is still in the last position. 

 

Fig. 1.27 Move Backward Courtesy-Author 

Step 11. Select the Shape transform (T) tool and rotate the shape as shown in Figure 

1.28. 

 

Fig. 1.28 Rotate the shape Courtesy-Author 

Step 11. Select the individual shape separately and adjust it using transform tool as 

shown in Figure 1.29. Keep remember Q, W, E for Move, rotation and scale. You can 

also use corner pinning. 

 

Fig. 1.29 Modify the shapes Courtesy-Author 
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Step 16. Now you need to adjust the shape using reshape tool and feather edge by 

adjust feather handle as shown in Figure 1.30. 

 

Fig. 1.30 Adjust the Shape using Reshape tool Courtesy-Author 

Step 17. Again move 5 frames backward (Figure 1.31) which is frame number 5 and 

modify the shape. 

 

Fig. 1.31 Move 5 frames Backward Courtesy-Author 

Step 18. By using incremental key frame technique, you have roto 1st, 5th, 10th and 15th 

frame. Observe this in Figure 1.32. 

 

1st Frame 

 

5th Frame 
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10th Frame 
 

15th Frame 

Fig. 1.32 Modification in Different Frames Courtesy-Author 

Now adjust in between frames and complete the rotoscoping of the hand. By using, 

incremental key frame technique, you can adjust the shapes which have motion blur 

easily. 

Summary 

Blur is of two types- Depth of field blur and Motion blur. 

Camera blur is created by the focal length while motion blur occurs when the object is 

in the fast motion and camera is unable to capture it. 

Watch the motion of the object carefully as you start and start working with the frame 

with have highest detail. 

As we did in the practical activity, try to transform whole shape using the transform tool 

like move, rotate and scale, before start editing individual point. 

Keep the control points of your shape on the same part of the object all of the way during 

the shot. 

Keep checking your work with the solid overlay view, by pressing numeric key 4. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. Depth of field blur is created by (a) Focal length of the camera (b) Motion of the 

object (c) Video effect from software (d) Focusing ring of the camera 

2. Motion blur occurs when a focus object moves (a) Great distance over a large 

number of frames (b) Great distance over a short number of frames (c) Minimum 

distance over a large number of frame (d) Minimum distance over a short number 

of frame 

3. You will get blur setting in (a) Object list (b) Object window (c) Tools (d) Timeline 

4. Without any blur attached to the spline, the matte would appear (a) Solid (b) 

Blurry (c) Solid with gradient in edge (d) Transparent 

5. Centered blur setting keep the pixels______ visible along the spline’s edge (a) 25% 

(b) 50% (c) 75% (d) 100% 

6. Edge feather can be controlled by (a) Focal Length (b) Feather Handle (c) Edge 

Feather (d) Spline 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

89 

B. Fill in the blanks 

1. If the focal length remains same then amount of blur will be _______. 

2. Slow-motion footage is captured at ______ number of frames per second. 

3. There is always a chance of______ blur in the footage which you are            

rotoscoping. 

4. To isolate the edge blur from the frame, you need to create the same amount    

of______ as the frame has. 

5. When spline was placed at the very extreme blurred edge of the focus       object, 

set the blur to affect ______. 

6. Centered blur setting will keep the pixels along the spline’s edge_____    visible. 

7. Press A for Overlay view and _____ for Alpha view. 

8. You can watch_______ output in viewer by pressing numeric key 4. 

C. True or False 

1. If you roto the blur object, then your job is to match the blurriness of the object 

with shape. 

2. If you want to check whether your blur is correct, then place the pointer where 

the blur on the footage begins. 

3. You need to keep your spline at that same distance from the focus object edge 

for the life of the spline. 

4. Press F2 for maximize viewer. 

5. Numeric key 0 is used to hide the outline of shape. 

D. Short answer questions 

1. What is depth of field blur? Explain the technique of rotoscoping of this type of 

blur. 

2. What is motion blur? How is this different from depth of field blur? 

3. How can you adjust the blurriness of the shape with object? 

4. Compare outer, centered and inner blur. 

5. Explain the use of different blur setting with suitable example. 

6. How can you match shape's blur with focus object? 

 

 

Session 2: Motion Tracking 

 

Roto-artist always searches a quickest and most straight forward path to extract focus 

object. It is largely frame by frame work. If you find any path to create an accurate matte 

without manually creating key frames for your shapes, you definitely want to try those 

methods. 

Tracking any elements of footage and attaching these tracking data to shapes can speed-

up the workload. When you follow an element of a video clip, the resulting track gives 

horizontal and vertical data of that element. This tracking data is translated by the 

computer into X and Y coordinates that can be applied to any shape. 
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In this chapter, you will be able to perform tracking on SilhouetteFX© software. There 

are three types of tracker in SilhouetteFX©– Point Tracker, Planer Tracker and Mocha 

planer tracker. However, Planer Tracker and Mocha planar tracker are considered into 

same group of tracker. 

2.1 Motion Tracking 

It is the process of tracking the movement of an object and applies it over a piece of 

footage. Once you get these tracking data from the selected point, you can apply it over 

other elements or objects. After applying tracking data over the object, its movement 

matches with footage movement. Initially, it is used in compositing to incorporate some 

element in scene which is not there. 

Fig. 2.1 Concept of Motion Tracking 

2.1.1 Use of Motion Tracking 

It is important to note that where you can use motion tracking technique. Let us take a 

quick look to know some important use of motion tracking. 

• Stabilize motion by utilizing tracking data. 

• Add elements such as text or solids to a composition. 

• Track a shape/mask over a moving target in rotoscoping. 

• Insert 3D computer generated objects into 2D footage. 

• Use in wire and rig removal. 

• Replace screens on a TV, Computer, or mobile device. 

These are just a few things, where motion tracking is used. From simple to complex 

compositions, this is a technique which you must know. 

2.2 SilhouetteFX© Motion Tracking 

In SilhouetteFX©, there are three motion tracking options. 

• Point Tracker 

• Planer Tracker 

• Mocha Planer Tracker 

Generally, SilhouetteFX© planer tracker and mocha planar tracker are counted under 

same category of planar tracker. 

2.2.1 Point Tracker 

In Point tracker, the area which is going to track is specified by track points in the layer 

panel. It offers one, two, three and even multiple point tracking. Some biggest 

advantages of using point tracker are- 

1. It is a 2D tracker. That is mostly used on inorganic shapes like chair, ball, car 

etc. 

2. It allows to choose any feature to track in a scene. 

3. It is most flexible and versatile tracker. 

Each point tracker contains (i) Match Area, (ii) Search Region and (iii) track point. In 

Combination, these three are called a “Tracker” as shown in Figure 2.2. 
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Fig. 2.2 Tracker Courtesy-Author 

Track Point – It is the actual point of tracking. In this point, the target layer or effect 

control point will be placed. By default, this is positioned at the center of the Feature 

Region, but can be moved, if needed. 

Match Area – It define the element in the layer that is about to be tracked. Keep in 

mind, that it should be clearly visible in whole duration of the track, even if the 

background, light and camera angle have been changed. 

Search Region – It is the area, which search to locate the tracked feature. It is like the 

boundary of the ball. The element you are tracking should not go beyond this region. 

Keeping search region small will result faster tracking, but there is a risk of the tracked 

feature leaving the search region between frames. 

Know More… 

Feature is the point within the object, which is used by the tracker. It may be any 

dot point in cricket ball, logo in a car and even any colour contrast differences. 

2.2.1.1 Creating One Point Tracker 

Track any single feature of the object in horizontal (x-axis) and vertical (y-axis) 

position, with little or no perspective change on the image. You can use this tracking 

information to move other elements during compositing. 

Now let us create Point tracker on the image frames. 

Practical Activity 1 – Create a single point tracker. 

Step 1. Open SilhouetteFX© software, Import footage, create session and insert roto 

node in trees window as shown in Figure 2.3. 

 

Fig. 2.3 Create a session Courtesy-Author 
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Step 2. Click on Roto Node on Tress window and Select the Tracker (Shift-T) in the 

Toolbar as shown in Figure 2.4. 

 

Fig. 2.4 Tracker Courtesy-Author 

Step 3. Go to the frame as shown in Figure 2.5, from where you want to start 

tracking. 

 

Fig. 2.5 Find suitable frame for tracking Courtesy-Author 

Step 4. Set the view to Foreground as shown in Figure 2.6 for the fastest speed when 

tracking. In the Foreground view, no processing occurs and therefore it is faster than 

View > Output. 

 

Fig. 2.6 View setting Courtesy-Author 

Step 5. Tracker window is located at the bottom of the screen; select the Point Tracker 

tab, as shown in Figure 2.7 

 

Fig. 2.7 Point Tracker tab Courtesy-Author 

Step 2. Press the Create button and place a tracker in the center of the image as 

shown in Figure 2.8. 

 

Fig. 2.8 Create a point tracker Courtesy-Author 
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Step 7. Click Alt at open space in the image. A magnify view appears as shown in 

Figure 2.9 to find out the perfect element for tracking. 

 

Fig. 2.9 Tracking point Courtesy-Author 

Step 8. Once you find the tracking element, click left mouse button for creating tracker 

as shown in Figure 2.10. 

 

Fig. 2.10 Create track point Courtesy-Author 

After creating the tracker, you have to adjust it according to match area. 

2.2.2 Moving and Scaling Tracker component 

As you know, tracker has three component – Track point, match area and search 

region. Sometimes you need to move the tracker at desired point and even scaling of 

tracker is required in some cases. 

Following are the steps for moving the tracker component. 

Step 1. Click exactly on the center of the Track point as shown in Figure 2.11 and 

drag it. It will move all the components of the Tracker: Match Area, Search Region and 

Track Point simultaneously. 

 

Fig. 2.11 Clicking and dragging the center point of tracker Courtesy-Author 

Step 2. Clicking and dragging within the area of the Match Area will move both the 

Search Region and Match Area simultaneously as shown in Figure 2.12, though only 

the track point will not move. This can be used for Offset Tracking when the original 

track point becomes obscured. 
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Fig. 2.12 Clicking and dragging within the area of the Match Area Courtesy-

Author 

Step 3. Clicking and dragging within the area of the Search Region will move only the 

Search Region as shown in Figure 2.13. 

 

Fig. 2.13 Clicking and dragging within the area of the search region Courtesy-

Author 

After moving the tracker, sometimes scaling is also required. 

Step 4. Clicking and dragging on the corners of the Match Area bounding box. It scales 

both the Match Area and Search Region as shown in Figure 2.14. 

 

Fig. 2.14 Clicking and dragging on the corners of the Match Area 

Step 5. Clicking and dragging on the corners of the Search Region bounding box 

scales only the Search Region as shown in Figure 2.15. 

 

Fig. 2.15 Clicking and dragging on the corners of the Search Region bounding 

box 

2.2.3 Pre-Processing the Object 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

95 

Once you select the feature region for tracking, you have the option in tracker to pre-

process the object with respect to contrast, sharpness, gamma, blur and noise by using 

video filters as shown in Figure 2.12. Keep in mind, it will not affect video clipping rather 

use to increase accuracy for tracking object. 

 

Fig. 2.16 Pre-processing option Courtesy-Author 

Let us use pre-processing over the object and understand the properties of each filter. 

For better result, right check on preview box as shown in Figure 2.17 (a) to show the 

result on viewer. 

Blur – It applies the blur over the image features as shown in Figure 2.17(b). 

  

Fig. 2.17 (a) & (b) Blur setting and its impact on object Courtesy-Author 

Sharpen – It sharpens the image features, as shown in Figure 2.18. 

  

Fig. 2.18 (a) & (b) Sharpen setting and its impact on object Courtesy-Author 

Contrast – increase the contrast of image features, as shown in Figure 2.19 (a). The 

result is shown in Figure 2.19 (b). 

  

Fig. 2.19 Contrast setting and its impact on object Courtesy-Author 

Gamma – It increases the brightness, as shown in Figure 2.19 (a). The changes will be 

affected in-between value of black and white points as shown in Figure 2.19 (b). 
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Fig. 2.20 Gamma setting and its impact on object Courtesy-Author 

De-noise – smooth out the noise while retaining the details. 

  

Fig. 2.21 De-noise setting and its impact on object Courtesy-Author 

Remove Flicker – It corrects image flicker or brightness variation of the image. 

Preview – It displays the pre-processing changes in the viewer. 

Smooth – It is used to smooth out tracking data. 

2.2.3 Tracking an Image 

After pre-processing the tracking features, you need to track the image. For this the 

various controls are used in Point tracker tab, as shown in Figure 2.22. 

 

Fig. 2.22 Different option in Point Tracker Courtesy-Author 

Create – A new tracker can be created into the center of the viewer by pressing create 

button. You can also create a new tracker by pressing Alt key on keyboard. 

Apply – After tracking the data, you need to apply it into the layer. Select layer, and 

click on Apply button, a match-move dialog box opens, as shown in Figure 2.23. Here 

you can determine how tracking data will be applied over footage. 

 

Fig. 2.23 Match move dialog box Courtesy-Author 

Average – Averages multiple tracks into a new destination track. A common technique 

is to track forwards from the first frame to the last, and then create a second track, 
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tracking backwards from the last frame to the first. These two trackers are then averaged 

together to derive a more accurate track. To average trackers, select more than one 

tracker and click the Average button. A new averaged tracker is created. 

Merge – If you have multiple trackers that cover different frame ranges, they can be 

merged into one tracker, automatically compensating for the different offsets. 

Behavior – Behavior decides the reference frame to check the accuracy of match area 

(Figure 2.24). 

 

Fig. 2.24 Behavior options Courtesy-Author 

Start frame – The match area is compared with starting frame. 

Every frame – The match area is compared with previous frame. 

Key Frames – In the difficult shot, it is better to set key frames initially for tracker, at 

various point of the clip. The match area is used it as reference. 

Tolerance – It describes the level of accuracy between the Match Area that the Tracker 

is searching for and area it actually finds when searching from frame to frame. A perfect 

match will have value of 100, while default value of tolerance is 75 (Figure 2.25). 

 

Fig. 2.25 Tolerance Courtesy-Author 

Tracking option – The tracker can track both forward and backward one frames at a 

time or can track for entire duration, as shown in Figure 2.26. 

 

Fig. 2.26 Tracking option Courtesy-Author 

Practical Activity 2.2 – Track the object by using one-point tracking feature. 

Step 1. Adjust the size and position of the Match Area and Search Region as shown in 

Figure 2.27. 
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Fig. 2.27 Adjust the position of match area and search region Courtesy-Author 

Step 2. Right click on the tracker. Select the color space to use in the Channel sub 

menu as shown in Figure 2.28. 

 

Fig. 2.28 Select the colour space Courtesy-Author 

Step 3. Hit either the forward or backward track button. Software will analyze the 

motion for each frame in the clip as shown in Figure 2.29. 

 

Fig. 2.29 Hit tracking button Courtesy-Author 

Step 4. After clicking the track forward/backward button, SilhouetteFX© automatically 

track the image. Tracking data is shown in the form of green lines as shown in Figure 

2.30. 

 

Fig. 2.30 Tracking data is showing in green line Courtesy-Author 

Step 5. Now create a shape over image as shown in Figure 2.31 by using X-Spline tool 

as shown in Figure 2.31. 
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Fig. 2.31 Shape layer is created Courtesy-Author 

Step 2. Select tracker in tool panel and also in object list. Now Point tracker tab will 

open as shown in Figure 2.32 (a) & 2.32 (b). 

 

Fig. 2.32 

(a) 

 

Fig. 2.32 (b) Tracker tool and its position into object list 

Step 7. In Point tracker tab, click on Apply button, which match the tracking data 

with shape as shown in Figure 2.33. 

 

Fig. 2.33 Click on Apply button on Point Tracker tab Courtesy-Author 

Step 8. After clicking on Apply button, a match move dialog box opens. Check the 

necessary options as shown in Figure 2.34 and click OK. 

 

Fig. 2.34 Match move dialog box Courtesy-Author 

Step 9. Now the shape starts moving according to the object. 

Know More… 

You can apply point tracker data only to the layer, not directly to the shape. So put 

the shape into the layer and then use tracking data. 

2.2.1.2 Two Point Tracker 

There is no difference in process between single point tracker and two point tracker. The 

only difference is that there are now two trackers. Two point trackers track not only the 

position but also scale and rotation. It is very useful when camera is panning or shots 

have any kind of rotation or perspective. 

Let us illustrate to use two point Tracker using the Practical Activity 2.3. 
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Practical Activity 2.3 – Demonstrate to use two point Tracker. 

Step 1. Import image sequence in SilhouetteFX©v7.5 as shown in Figure 2.35. Create 

session and insert roto nodes between source and output node in Trees window. 

 

Fig. 2.35 Import video-clip and create session Courtesy-Author 

Step 2. Click on tracker into roto tools, which opens Tracker window. Here, select Point 

tracker tab as shown in Figure 2.36. 

 

Fig. 2.36 Point tracker tab Courtesy-Author 

Step 3. Click on create button, a tracker will appear on the viewer panel as shown in 

Figure 2.37. Set the tracker in appropriate place and adjust its various regions. 

 

Fig. 2.37 Set the tracker Courtesy-Author 

Step 4. Create another tracker in the bottom part of the object as shown in Figure 2.38. 

 

Fig. 2.38 Create second point tracker Courtesy-Author 
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Step 5. Select both tracker in object list and Track forward/backward by pressing 

forward/backward button in point tracker tab as shown in Figure 2.39 (a) & (b). Track 

information has been saved in green line form. 

 

 

Fig. 2.39 (a) & (b) Select both tracker in object list and track Courtesy-Author 

Step 5. Now create a shape of object and put it into the layer as shown in Figure 2.40 

(a) and (b). Always keep tracker above the layer. 

 

 

Fig. 2.40 (a) & (b) Create shape of object Courtesy-Author 

Step 2. Now select both trackers in object list and click on Apply button on Point tracker 

tab as shown in Figure 2.41. 

 

Fig. 2.41 Apply the tracker in both shapes Courtesy-Author 

Step 7. As you click on Apply button, a match move dialog box appears as shown in 

Figure 2.42. Here two more options are enabling with existing one – rotation and scaling. 

Tick the entire checkboxes and click on OK button. 
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Fig. 2.42 Match move dialog box Courtesy-Author 

Step 8. Once tracking data is applied over shape, observe the movement of the shape, 

which is now, synchronize with video footage as shown in Figure 2.43. 

 
1st Frame 

 
20th Frame 

 
40th Frame 

 
60th Frame 

 
Last Frame 

Fig. 2.43 Observe the movement of the shape Courtesy-Author 

Step 9. Modify the shape at any frame to match the movement of object. 

Assignment 1 

Shoot a rotate video footage from your mobile/DSLR and track and isolate the object by 

using two point tracker. 

2.3 Planer Tracker 

Planar tracker means tracking over any X, Y plane such as roads, walls and many more. 

SilhouetteFX© includes two types of Planar Trackers: (i) Silhouette’s Planar Tracker and 

(ii) Imaginer’s mocha Planar Tracker. 

The workflow is same for both the planar tracker. If you want to get accurate tracking 

data from it, then learn to find planes of movement in the video clip and that plane 

should fit with the object, which you want to track. 

Sometimes it will be obvious; otherwise you may have to break your object into different 

planes of movement. 

Most notably, both Planar Trackers require a layer in the object list and have at least 

one shape within it to move the tracker. 

Know More… 

The Tracker is available as a separate node, but is also built into the Depth, Morph 

and Roto nodes. 

2.3.1 How Planar Tracking Works 

A planar tracker takes advantage of the fact that there are flat planes all around us in 

the man-made world of floors, walls and streets, and even in the natural world of desert, 

lake and sky. You can watch different planes in the row houses buildings as shown in 

Figure 2.44. Planar tracker uses these planes for calculations. 
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Fig. 2.44 Different Planes Courtesy-Sri aurobindo ashram 

First create a shape over the plane to identify it to planar tracker. After this, planar 

tracker compares the texture of the entire plane, frame by frame to track its movement 

in the frame. It utilizes the fact that the texture is a flat plane to optimize the tracking 

calculations to match the texture for translate, rotate, scale, skew, and perspective. 

Since planar tracker is seeking much larger image area than point tracker thus there is 

less chance that tracker will be lost path due to noise, dark images, variable light 

condition, obstructions and motion blur. 

SilhouetteFX©’s Planar Tracker 

As mentioned earlier, it tracks planes and surfaces instead of point. You get the 

following options while using Silhouette planar tracker, which shows as a planar tracker 

as shown in Figure 2.45. 

 

Fig. 2.45 SilhouetteFX©v7.5 planar tracker Courtesy-Author 

Planar Tracker Tab 

Channel – Here you can select the specific channel for planar tracker as shown in Figure 

2.46. 

 

Fig. 2.46 Channel Courtesy-Author 

Tracking Features – It helps the tracking points, where they will place. For example, if 

you select corner tracking feature, then most of feature shifted into the corner of a shape 

as shown in Figure 2.47. 
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Fig. 2.47 Tracking features Courtesy-Author 

Motion Model – It is related to the motion of the object, for instance if the object have 

X and Y axis movement then select Translation option, if the object also has slight 

movement in Z axis then select Affine option, while if it has larger perspective change 

then select perspective option in motion model as shown in Figure 2.48. 

 

Fig. 2.48 Motion model Courtesy-Author 

Min Features – It generates the minimum number of trackers, as shown in Figure. 

Max Features – It generates the maximum number of trackers, as shown in Figure. 

Min Distance – It decided the minimum distance between trackers. 

Max Age – The maximum number of frames, a specific tracker will live. 

Valid Tracks – It shows the total number of trackers available in current frame, as 

shown in Figure. 

Reference Frame – It displays the reference frame number. 

Track options – Tracker direction button is used to track backward and forward, as 

shown in Figure 2.49. 

 

Fig. 2.49 Tracking option Courtesy-Author 

Practical Activity 2.4 – Track the object by using SilhouetteFX©’s planar tracker. 

Step 1. Import some source footage and create a session as shown in Figure 2.50. In 

Trees window, add Roto node between source and output. 

 

Fig. 2.50 Import the footage and create session Courtesy-Author 

Step 2. Select the frame in viewer as shown in Figure 2.51, where you want to start 

tracking. In this footage, we will prefer last frame, which have maximum detail in object. 
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Fig. 2.51 Find the appropriate frame for tracking Courtesy-Author 

Step 3. Planar tracker can be applied into the layer only, so create a layer in the Object 

List using the Add Layer icon as shown in Figure 2.52. 

 

Fig. 2.52 Create a layer into the object list Courtesy-Author 

Step 4. In this footage, we are going to track river side building. For this, create a shape 

around the object inside a new layer to track as shown in Figure 2.53. Remember, shape 

should include some details of the object. Keep little extra room around the object. 

 

Fig. 2.53 Create a shape into the layer Courtesy-Author 

Step 5. Choose the Tracker by Shift-T key in the Toolbar. 

Step 2. Select Planar Tracker in the Tracker tab located at the bottom of screen, as 

shown in Figure 2.54. 

 

Fig. 2.54 Select planar tracker Courtesy-Author 

Step 7. Selecting planar tracker, lot of tracking features in red colour start displaying 

inside the shape, as shown in Figure 2.55. 
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Fig. 2.55 Tracking features in red colour Courtesy-Author 

Step 8. To track the object, click on track forward/backward button into planar tracker 

tab, as shown in Figure 2.52. With this, either you can track a single frame or complete 

frame at once. 

 

Fig. 2.56 Track the object Courtesy-Author 

Step 9. Now tracking is started, as shown in Figure 2.57. 

 

Fig. 2.57 Tracking is started Courtesy-Author 

Step 10. Press L key and Playback it on viewer to observe the accuracy of tracking. 

Step 11. Tracking data can also be observed by selecting stabilize tool in viewer panel 

and selecting Active Layer, as shown in Figure 2.58. 

 

Fig. 2.58 Selecting Active Layer Courtesy-Author 

Step 12. Now, keep the cursor at any point in the shape as shown in Figure 2.59, and 

playback the footage. Observe the cursor, if there is no change in footage placement 

then tracking is perfect. 
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Fig. 2.59 Keep the cursor at any point of shape Courtesy-Author 

Step 13. After this, select none in stabilize option, as shown in Figure 2.60. 

 

Fig. 2.60 Deselect stabilize option Courtesy-Author 

Step 14. Now you can add many shapes into this tracking layer, if the shape is placed 

on same geometric plane. 

Mocha Planar Tracker 

Mocha tracker is available within SilhouetteFX© tracker options. Setting up the mocha 

tracker is similar to setting another tracker especially planar tracker as shown in Figure 

2.61. 

 

Fig. 2.61 Mocha Tracker Courtesy-Author 

When you select Mocha planar tracker in SilhouetteFX©, you get following options. 

Channel – It determines which image channel tracker use to analyse the image. There 

are four channels available – luminance, red, green and blue. 

Motion – You can control motion parameters during track. 

 

Fig. 2.62 Motion option Courtesy-Author 

Translation – It determines the X and Y position of an object. 

Scale – It determines the size of the object. 

Rotation – It determines angle of the object. 

Shear – It skews the object along with camera movement. 

Perspective – It determines how the object is moving in perspective relative to the 

camera. 
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Horizontal/Vertical % – It determines the distance in pixels within the footage to 

search for next object position. 

Angle – If object is fast moving, and then set an angle of rotation to help the tracker to 

lock the detail correctly. 

Zoom% – You can set percentage value fast zooming object. 

Practical Activity 2.5 – Track the object by using Mocha Planar Tracker. 

Step 1. Import some footage in SilhouetteFX©. Create a session and insert roto node 

between Source and output node in Trees window, as shown in Figure 2.63. 

 

Fig. 2.63 Create a new session Courtesy-Author 

Step 2. Create a layer into object list. 

 

Fig. 2.64 Layer is created into object list Courtesy-Author 

Step 3. Now identify the frame that has complete shape and detail. Draw a shape over 

object in that frame. Keep this shape into the layer. 

 

Fig. 2.65 (a) & (b) Create shape into the layer Courtesy-Author 

Step 4. Select Tracker on toolbar and click on mocha tracker tab into the Tracker 

window, as shown in Figure 2.62. 

 

Fig. 2.66 Select various option in mocha tracker Courtesy-Author 
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Step 5. Here, you need to select various options like channels, motion, translation, 

scale, rotation, shear and perspective and then click on tracking option button. 

Step 2. Once you track an object, make some correction and use it for rotoscoping 

(Figure 2.66). 

 

Fig. 2.67 Correction on shape after tracking 

2.3.3 Use of Planar Tracking 

Like a point tracker, the tracking data generated by the planar tracker can be used in a 

wide variety of ways. 

2.3.3.1 Motion Tracking 

Similar to point tracker, motion tracking can be used to move one object to lock another 

object and move with it. Tracking data generates transformations, which is a description 

of the movement of an object in the image made up of translation (vertical and horizontal 

movement), rotation, scale, skew, and perspective. These transformations can be used 

to animate a graphic object like a logo to appear to stay locked to a moving object in the 

frame. 

 

Fig. 2.68 Motion tracking Courtesy-Author 

2.3.3.2 Corner Pinning 

In some situations, just knowing the transformation is not enough. You also need to 

have the information about the corners of the source image. Further These corners will 

replace frame by frame. For example, replace the video clip of a monitor by using this 

technique as shown in Figure 2.69. 

This is what corner pinning is all about. The tracking data is converted into the location 

of each of the four corners of a moving video monitor. For example, the source image is 

“corner pinned” to the monitor’s corners frame by frame. Some other uses of corner 

pinning are, tracking a picture into a picture frame or placing an outdoor scene through 

a window. 
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Fig. 2.69 Corner pinning Courtesy-Author 

2.3.3.3 Stabilizing 

The transformation data generated by the planar tracker can also be used to stabilize a 

plate just as with a point tracker. While they do output exactly the same type of 

transformation data (translate, rotate, scale) the virtue of the planar tracker is its ability 

to lock onto more difficult targets. 

2.3.3.4 Rotoscoping 

Planar trackers are also a very useful tool to assist with rotoscoping. There are many 

objects that are planar in the real world, and many others are not. Consider the human 

form, one of the most common rotoscoping targets. Surprisingly, the planar tracker will 

still get a good lock on a non-planar surface such as a face or hand. This tracking data 

can be applied to the roto shape. Through this a large part of the work being done by 

the machine. 

Summary 

Motion Tracking is the process of tracking the object and applies this data over a piece 

of footage or shapes. 

There are three motion tracking options in SilhouetteFX – Point Tracker, Planer Tracker 

and Mocha Planer Tracker. 

In Point Tracker, the tracking area is specified by Track point in layer panel. 

Point Tracker has three component – Track point, match area and search region. 

Select the Foreground view for the fastest tracking. 

Two-point tracker is used when camera is panning or shots have any kind of rotation 

or perspective. 

Planer tracker tracks over the surface which have X and Y plane such as roads, walls.   

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Which of the following tracker is not found in SilhouetteFX (a) Point tracker (b) 

Planar tracker (c) Camera tracker (d) Mocha tracker 

2. Motion tracking is used in (a) Compositing (b) Editing (c) Video shooting (d) Colour 

grading 

3. Point tracker is mostly used in (a) Organic shape (b) Inorganic shape (c) Simple 

shape (d) Complex shape 
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4. The element that track point does not contain (a) Match area (b) Search region 

(c) Track point (d) Match point 

5. By using one-point tracker, you can track any single feature of the object in (a) 

Horizontal axis (b) Vertical Axis (c) Both Horizontal and vertical axis (d) Z axis 

6. Tracker window is located at the _______ of the screen (a) Left (b) Right (c) Top (d) 

Bottom 

7. Pressing a 'create' button in Point tracker tab, the tracker is created on the ____ 

of the image (a) Center (b) Top right (c) Top left (d) Bottom 

8. Pre-processing change in viewer is displayed, when you click on ____ into pre-

processing (a) Display (b) Viewer (c) Preview (d) Composite 

9. Planar tracker compares ______ of the entire plane to track the movement (a) 

Contrast (b) Noise (c) Colour (d) Texture 

B. Fill in the blanks 

1. Motion tracking is the process of _______ the movement of an object. 

2. Motion tracking can be used to________ motion by utilizing tracking data. 

3. Point tracker is a ______ tracker. 

4. Set the View to _______ for the fastest speed, when tracking. 

5. In tracker, Clicking and dragging within the area of the______ will move only the 

Search Region. 

6. De-noise smooth-out the noise while retaining the_____. 

7. Two point tracker is used when the shot have any kind of rotation or _____. 

8. Planar tracker requires a layer in the_____. 

C. True or False 

1. Motion tracking is not used in wire and rig removal. 

2. Track point is the actual point you are tracking. 

3. You can decrease contrast of the object by using pre-processing into the tracker. 

4. Behavior decides the reference frame to check the accuracy of match area. 

5. Scaling and rotation is not available in single point tracking. 

D. Short answer questions 

1. What is motion tracking? 

2. Write the use of Motion Tracking. 

3. What is Point Tracker? When should you use Point Tracker? 

4. Explain match area, track point and search region. 

5. Write the use of pre-processing tab into the tracker? 

6. Where can we use two-point tracker? 

7. What is Planar Tracker? 

8. How Planar Tracker works? 

9. When should you use Planar Tracker? 

10. What is mocha Planar tracker? 

11. Write the use of Mocha Planar Tracker? 
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Session 3: Human Figure based Rotoscoping 

 

A Rotoartist spends their maximum time to isolate human figures, because in most 

cases the focus object is the human being. For this you need to create mattes which can 

isolate them from rest of the footage. Human roto is a tedious task because human 

doesn’t move in a linear way. Therefore, you need to breakdown complete human figure 

in to the smaller shapes. 

3.1 Understand the human movement 

It is essential to understand the human movement. Figure 3.1 shows the various 

position of human movement while walking. 

 

Fig. 3.1 Walk Cycle; Keys and in between Courtesy-Author 

Have you ever seen the puppet game show? The puppeteer shows the game by playing 

with puppet. There are similarities between puppet game and human roto, as both are 

based on human movement. 

In Human figure rotoscoping, it is essential to know the movement of human hands, 

fingers and legs. So before starting human rotoscoping, just watch the video footage 

again and again. Here you need to work in two steps. 

Differentiate shape based on their movement. 

Define the motion path of each individual sub-shape. For this disable all shapes and 

focus on a single shape at once. 

 

Fig. 3.2 Side poses of person moving Courtesy-Author 

In Figure 3.2, observe that a person is moving in a screen and your task is to isolate 

human shape from the footage. If you playback this video in a loop then you can focus 
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on movement, and breakdown it into different shape as shown in Figure 3.3. Let’s find 

out some measure movement from this footage. 

    

Fig. 3.3 Different sidewalk position Courtesy-Author 

In Figure 3.3, if you concentrate on person’s movement then you can easily divide it into 

the different shapes. It helps in isolating specific shape/edge of your focus object. Now 

a person can be divided in to different shapes based on movement. 

1. Head and chest 

2. Right Upper Arm 

3. Right Lower arm 

4. Right palm and fingers 

5. Left Palm and fingers 

6. Upper left leg 

7. Lower left leg 

8. Toes 

The breakdown of focus object into multiple shapes is shown in Figure 3.4. 

 

Fig. 3.4 Rotoscoping of man Courtesy-Author 

Assignment 1 

Study the movement of following organic shape. 

1. Human 2. Horse 3. Deer 4. Kangaroo 

Remember the following while performing human rotosocoping. 

1. Take a single shape at a time. 

2. Roto this shapes until it stop being an edge. 

3. Once this shape is finished, move to another shape. 
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4. You can choose any shape to roto but never leave it in middle just finish it. 

So, you can take left lower leg from Figure 3.4 and perform the rotoscoping. 

Practical Activity 3.1 – Rotoscoping left leg of the person. 

Step 1. To roto the left upper thigh, disable all shape except this, as shown in Figure 

3.5. 

 

Fig. 3.5 Disable all the shape Courtesy-Author 

Step 2. For animating the shape according to object, set 10 frame intervals into the 

frame-steps as shown in Figure 3.6. 

 

Fig. 3.6 Set Frame-steps Courtesy-Author 

Step 3. As you forward the footage 10 frames, you can see the shape is still in their 

last position, as seen in Figure 3.7. 

 

Fig. 3.7 Forward 10 frames Courtesy-Author 

Step 4. Transform the shape, you will find that it is easy to rotate shape from joint 

because it is a pivotal point of leg. After rotation you need some adjustment, which you 

can do by reshape tool as shown in Figure 3.8. 
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Fig. 3.8 Transform the shape on different frames Courtesy-Author 

This activity demonstrates the importance of human movement. Let us deal with 

different parts. 

3.2 Isolating Extremities 

During rotoscoping human figures, you need to isolate various limbs. So whenever 

isolating limbs like arms, legs, feet or hands. Consider two things always- 

1. The way these objects are constructed 

2. Where they rotate from. 

If we focus on arms and legs, they only have two pivot points relative to their 

construction. Arms pivot from shoulder and elbow. Legs bend from hip and knee. It 

means, human figure will not alter too much except these two points. Therefore, if you 

rotate shape from these points then it can be easily modified with focus object. 

   

Fig. 3.9 Hand movement through shoulder and elbow Courtesy-Author 

   

Fig. 3.10 Leg movement through Knee Courtesy-Author 

Practical Activity 3.2 – Create and animate shapes for leg movement. 

For rotoscoping leg movement, create project in SilhouetteFX©v3.5 software. Import the 

footage on source window and create session. Then insert roto nodes between object 

and output. 

Step 1. Search the frame to start creating shapes, as shown in Figure 3.11. 
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Fig. 3.11 Find the first frame to begin the roto Courtesy-Author 

Step 2. Select the Bezier tool from toolbar and create the shape. Create two shapes one 

for leg and other for toe, as shown in Figure 3.12. 

 

Fig. 3.12 Create the shape using Bezier tool Courtesy-Author 

Step 3. Set the frame interval of 10 frames in Frame-steps and move the frame by 

pressing X key as shown in Figure 3.13.  

 

Fig. 3.13 Move the frame in given interval Courtesy-Author 

Step 4. Select the transform tool and rotate the shape by pressing W as shown in Figure 

3.14. 

 

Fig. 3.14 Rotate the Shape Courtesy-Author 

Step 5. Forward 10 frame again by pressing X key and observe the shape as shown in 

Figure 3.15. 
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Fig. 3.15 Forward 10 frames Courtesy-Author 

Step 6. Once again you need to rotate the shape. Remember that rotation happens from 

its anchor point. So when you press W key it create anchor point and enables rotation 

tool as shown in Figure 3.16. 

 

Fig. 3.16 Rotate the shape Courtesy-Author 

Step 3. After rotation, observe that it is not perfectly overlap on focus object. It needs 

some adjustment. Use reshape (R) tool and adjust the point as shown in Figure 3.17. 

 

Fig. 3.17 Use Reshape tool to adjust the shape Courtesy-Author 

Step 8. Again, Press X on keypad to move 10 frame and observe the object movement 

as shown in Figure 3.18. 

 

Fig. 3.18 Forward 10 Frame Courtesy-Author 

Step 9. You have to use four things; Rotate (W), Move (Q), reshape and motion blur to 

animate the shape, as shown in Figure 3.19 (a) – (d). 
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Fig. 3.19 (a) Rotate 

 
Fig. 3.19 (b) Move 

 
Fig. 3.19 (c) Reshape 

 
Fig. 3.19 (d) Edge Feather 

Step 10. Again move 10 frame as shown in Figure 3.20, and observe the motion as 

shown in Figure 3.20. 

 

Fig. 3.20 Forward 10 Frame Courtesy-Author 

Step 11. Minimize motion blur on this frame, and modify as shown in Figure 3.21. 

 

Fig. 3.21 Minimize Motion blur Courtesy-Author 

Step 12. Now isolate 40 frames from 106 to 146 with using 10 frame intervals. Check 

frames between modified frames such as frame number 110, 120, 130, and 140 one by 

one as shown in Figure 3.22 (a) – (d). 
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Fig. 3.22 (a) Frame 110 

 
 Fig. 3.22 (b) Frame 120 

 
Fig. 3.22 (c) Frame 130 

 
 Fig. 3.22 (d) Frame 140 

Step 13. As you can see, all these frames need adjustment, so adjust the frame and 

check the random frame from 106 to 146 as shown in Figure 3.22. In this way, you can 

roto leg movement. 

Assignment 2 

Shoot the pushup video from DSLR or smartphone and isolate the person from video. 

As you have seen in above practical activity, you got maximum movement of legs from 

two pivotal points like knee and ankle joint. Now we will discuss about hand movement. 

3.3 Hands 

A roto artist may have to isolate number of hands from the video shot. Suppose, you 

have to insert visual effects character in the video frame that holds the hand of a 

character or to put a weapon on the hand. To incorporate these effects, rotoscoping of 

hands is required. 

Hand is slightly complex focus object to isolate, because it has fingers, palm, wrist and 

multiple pivot points. If you focus on finger, it can move in different direction. Legs and 

arms have only two pivot point. But in hand, each finger has three pivot points as shown 

in Figure 3.23 (a). 

   
Fig. 3.23 (a) Finger and (b) its perspective change 

It is possible to use single shapes for each finger but you have to aware about the 

movement of the fingers. There is also perspective issue in hand movement. When the 

finger curls forward while facing camera then it’s movement is straight forward. Observe 

the change in perspective of the finger in Figure 3.23 (b). However, hands are really easy 
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to breakdown into shapes. They always pivot from the same point. During the hand’s 

isolation, knowledge of hand movement plays a key role for correctly breaking it. 

The palm is a slightly different. Palm movement is complex and you need to use your 

instinct to break it in a shape. To start with to split up the palm is to create separate 

shapes for (i) The palm itself (ii) The meaty bit connected to the thumb as shown in 

Figure 3.24. 

 

Fig. 3.24 Shape breakdown of Palm Courtesy-Author 

During breakdown of the palm you need to focus on control point placement. Try to 

keep a point on the base of every finger when you are making palm shape. It will help 

as a marker which can make the shape consistent as shown in Figure 3.25. 

 

Fig. 3.25 Control point on the base of Finger Courtesy-Author 

The points which are added in the base of the fingers keeps their relative position, with 

respect to their relevant fingers, while hand is moving. If you create shapes correctly 

and with foresight, you can use that shape’s points as reference to keep your shapes 

correctly isolating the same edges of the focus object and avoid manipulating that shape 

in a sub-object level. These reference points are very helpful during isolating hands 

because it provides an easy visual reference. 

Practical Activity 3.3 – Demonstrate to Isolate the palm from video footage. 

Step 1. Breakdown the picture of hand in two different shapes and take 10 frame 

intervals to animate the shape as shown in Figure 3.26. Press X key to move the 10 

frame forward. After forwarding the frame by 10 frames the hand picture will look like 

as shown in Figure 3.27. 

 

Fig. 3.26 Frame Steps Courtesy-Author 

 

Fig. 3.27 Hand picture after forwarding by 10 frame Courtesy-Author 
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Step 2. Select Transform tool by pressing T key and adjust the shape. The hand picture 

will look like as shown in Figure 3.28. If needed, use reshape tool also. 

 

Fig. 3.28 Hand picture after using transform tool Courtesy-Author 

Step 4. Press X key to forward 10 frames again. The picture of hand after forwarding 

10 frames is shown in Figure 3.29 (a). Now adjust it by using Transform and Reshape 

tool as shown in Figure Figure 3.29 (b). For this use the Transform tool to adjust the 

position then use Reshape tool to control points. 

 
Fig. 3.29 (a) Forward 10 frame 

 
  Fig. 3.29 (b) Adjust the shape using 

transform and reshape 

Step 5. Press A to observe the shape in overlay mode. 

 

Fig. 3.30 Overlay Mode Courtesy-Author 

Step 6. Again press X to move 10 frames forward as shown in Figure 3.31 (a) and modify 

it as shown in Figure 3.31 (b). 
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Fig. 3.31 (a) Forward the shape 

 
Fig. 3.31 (b) Modify the shape 

Step 3. Thus you the frame can be modified in interval. The modified 40th and 50th frame 

are shown in Figure 3.32 (a) & (b). 

 
Fig. 3.32 (a) Frame 40th 

 
Fig. 3.32 (b) Frame 50th Courtesy-Author 

Step 8. Playback the footage and observe its shape in proper interval of frames as shown 

in Figure 3.33. Check in between frames again and adjust it. 

 
Frame 5 

 
Frame 15 

 
Frame 25 
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Frame 35 Frame 45 

 
Frame 55 

Fig. 3.33 Shape of different frames Courtesy-Author 

Observe the Figure 3.33 that the shape of palm has been modified according to the focus 

object. Next create shape for fingers. In the next Practical Activity 3.4, we see how to 

animate multiple shapes of fingers. You must be aware about the complexity of finger 

movement. So try to animate a single finger at once. You also need to arrange shapes in 

object list which helps to identify the shapes. 

Practical activity 3.4 – Demonstrate to isolate the fingers from video footage. 

In the previous Practical activity 3.3, it is demonstrated to isolate the palm. Now let us 

continue on the same footage and isolate the finger in the following steps. 

Step 1. Navigate the first frame and create shapes for fingers using X spline or any 

other spline as shown in Figure 3.34. 

 

Fig. 3.34 Create multiple shapes Courtesy-Author 

Step 2. Now observe the object list as shown in Figure 3.35 to manage the multiple 

shapes. Now we will work on index finger so disable all shapes except the finger as 

shown in Figure 3.36. 

 

Fig. 3.35 Object List Courtesy-Author 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

124 

 

Fig. 3.36 Disable all shapes except index finger Courtesy-Author 

Step 3. Next, set 5 frame intervals as shown in Figure 3.37. 

 

Fig. 3.37 Set Frame-steps Courtesy-Author 

Step 4. Press X key to move the 5 frames further and modify the frame. Observe the 

5th frame and 10th frame as shown in Figure 3.38 (a) & (b). 

 
Fig. 3.38 (a) 5th Frame 

 
Fig. 3.38 (b) 10th Frame 

Step 5. Observe the Figure 3.39 (a) by moving to 15th frame the finger starts bending. 

Now you have to move the shapes from its pivot point by using transform tool. After this 

you need to adjust the shape by reshape tool. 

 
Fig. 3.39 (a) 15th Frame 

 
Fig. 3.39 (b) Move the shape and 

rotate the middle Point using 

rotate (W) tool 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

125 

 
Fig. 3.39 (c) Rotate upper 

pivot point 

 
Fig. 3.39 (b) Move the shape and 

rotate the middle Point using 

rotate (W) tool 

Step 6. Now observe the 20th frame in Figure 3.40 (a). It is required to modify it using 

Transform and Reshape tool as shown in Figure 3.40 (b), (c), (d). 

 
Fig. 3.40 (a) 20th frame 

 
Fig. 3.40 (b) Adjust the position and 

rotate the shape from its pivot 

point 

 
Fig. 3.40 (c) Rotate middle 

and upper shape by pivot 

point 

 
Fig. 3.40 (d) Transform and adjust 

all shape by using transform and 

reshape 

Step 3. Now move to frame 20th, 25th, 30th, 35th and 40th. Observe these frames in Figure 

3.41 (a) to (e) that have little change. Modify it according to focus object. Keep focus on 

the object which connects with outer edge. 
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Fig. 3.41 (a) 20th Frame 

 
Fig. 3.41 (b) 25th frame 

 
Fig. 3.41 (c) 30th frame 

 
Fig. 3.41 (d) 35th frame 

 
Fig. 3.41 (e) 40th frame 

Step 8. Now move to 45th frame by pressing X key on keyboard. Observe the frame in 

Figure 3.42 (a). Use pivot point to move, transform and readjust as shown in Figure 

3.42 (b), (c), (d). Adjust motion blur by feather handle. 
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Fig. 3.42 (a) 45th Frame 

 
Fig. 3.42 (b) Adjust lower shape by 

rotate and move too 

 
Fig. 3.43 (c) Select middle and 

upper shape 

 
Fig. 3.43 (d) Final shape Rotate it 

Step 9. Further modify the 50th frame like first frame as shown in Figure 3.44. 
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Fig. 3.44 (a) 50th Frame 

 
Fig. 3.44 (b) Rotate the 

lower shape 

 
Fig. 3.44 (c) Final Frame 

It is possible to isolate all fingers by using the steps given in Practical Activity 3.4. 

3.4 Joints 

It is observed that when creating a shape for extremities, there is a definite pattern. 

Most of the shape in extremities begin and end their movement around their pivot point 

as shown in Figure 3.45. 

 

Fig. 3.45 Joints Courtesy-Author 

These joints are not doing the same movement as legs and arms, because it can bend, 

distort and rotate. It also squeezes and expands according to the movement. Let’s take 

a look at the gentleman taking push-ups in Figure 3.46. His upper arm and forearm 

shapes established already, but the joints between them need to be isolated as well. 

   

   

Fig. 3.46 Bicep’s Movement and their joint Courtesy-Author 
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You can create a single shape for joints. But in that situation, you need to create lot of 

point and it will become complicated with their movement. So it is better to create small 

multiple shapes for joints which can move easily. We will create two shapes on the elbow 

joint and move it in 5 frame interval as shown in Figure 3.43. Let’s check the result. 

   

Fig. 3.47 Two shapes created in Bicap’s joint (Green outline) Courtesy-Author 

   

Fig. 3.48 Matte view of bicep’s with multiple spline on joint Courtesy-Author 

It is clear from the Figure 3.47 and 3.48 that creating multiple shapes is the best option 

for joint movement. We have created only two points for bicep’s joint. For more, create 

additional shapes for smooth movement during isolating the focus object. 

3.5 Overlap the shapes 

We are breaking an object into multiple shapes. When we are creating these shapes, 

you must remember that these shapes jointly represent an object and it should create 

smooth edges as shown in Figure 3.49. 

  

Fig. 3.49 Smooth edge created in Palm isolation Courtesy-Author 

Now disable all shapes in Figure 3.49 and create multiple splines for middle finger. 

a. Let’s create it without overlapping the shapes. 

 
Fig. 3.50 (a) Finger splines 

         
Fig. 3.50 (b) Colour 

overlay 

 
Fig. 3.50 (c) alpha 

view 
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Observe that the shapes are not overlap then it will not look as a complete shape and 

its edges are not smooth. 

b. Now overlap the multiple shapes. After overlapping the splines, the final shapes don’t 

have any hard edges. Observe the alpha view in Figure 3.51, the shape has smooth edge. 

 
Fig. 3.51 (a) Finger splines 

 
Fig. 3.51 (b) Colour overlay 

 
Fig. 3.51 (c) alpha view 

3.6 Inverse Kinematics (IK) 

As you may be aware that human movement is natural and is performed by the joints. 

So understanding these natural movements enable you to perform human roto easily. 

Inverse kinematics (IK) helps to capture these natural movements. ‘Inverse’ means 

reverse and ‘Kinematics’ means motion. So Inverse Kinematics (IK) means motion, which 

already happened. For example, the person showing in the Figure 3.52 has completed 

his movements. You have to recapture and recalculate his motion. This is called as 

Inverse kinematics. It is demonstrated in Practical Activity 3.5. 

 

Fig. 3.52 Person is moving Courtesy-Author 

More to know – In inverse Kinematics, you 

need not to perform rotoscoping. You have to 

recapture natural movement of human figure 

and then adjust shapes manually. 

Practical Activity 3.5 – Recapture the movement of the person’s right leg by Inverse 

Kinematics (IK). 

Step 1. First import the image sequence in Silhouette software. Create a session in 

trees window and insert roto nodes as shown in Figure 3.53. 
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Fig. 3.53 Create a session in trees window Courtesy-Author 

Step 2. Breakdown the left leg in shapes as shown in Figure 3.54 using X-Spline. 

(a) Thigh (b) Knee (c) Shin (d) Ankle (e) Foot 

 

Fig. 3.54 Breakdown of object in different shape 

Step 3. Rename the shape in object list as shown in Figure 3.55. 

 

Fig. 3.55 Object list Courtesy-Author 

Step 4. Now organize the shape in different layers. Imagine the joint which is important 

during movement. Create layers for every joint like thigh, knee, ankle, foot. These are 

the steps. 

a. Create a layer for Right leg (Figure 3.56) and insert all the shapes on it. 

 

Fig. 3.56 Insert all shapes in Right Leg layer Courtesy-Author 

b. Now create a new layer and rename it as Knee (Figure 3.57). Insert knee and shin 

shape on it. Drag and drop this Knee layer under right leg layer. 
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Fig. 3.57 Insert Shin and Knee in Knee layer Courtesy-Author 

c. Now create ankle layer and insert ankle shape on it as shown in Figure 3.58. 

 

Fig. 3.58 Ankle Layer is created Courtesy-Author 

d. Now place ankle layer under knee layer. 

 

Fig. 3.59 Ankle Layer place under knee layer Courtesy-Author 

e. Now create foot layer under ankle layer and insert the foot shape as shown in Figure 

3.60. 

 

Fig. 3.60 Foot layer place under Ankle layer Courtesy-Author 

Step 5. Now select layer and enable the rotate option in object window as shown in 

Figure 3.61(b). 
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Fig. 3.61 (a) Right Leg Layer is selected Courtesy-Author 

 

Fig. 3.61 (b) Enable rotate option in object window Courtesy-Author 

Step 6. Enable rotate option for remaining layer as shown in Figure 3.62. 

 

Fig. 3.62 Enable rotate option Courtesy-Author 

Step 3. Adjust the joint position of each layer. For this perform following steps. 

a. Select right leg layer and choose transform tool. An anchor point displays on viewer 

as shown in Figure 3.63. 

 

Fig. 3.63 Anchor/Joint Position Courtesy-Author 

b. Place anchor point on upper thigh as shown in Figure 3.64. This is the first point of 

IK. 
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Fig. 3.64 First Joint Position Courtesy-Author 

Step 8. Now select remaining layers one by one and place their anchor point on joint as 

shown in Figure 3.65. 

 

Fig. 3.65 Anchor point is placed on joint Courtesy-Author 

Step 9. Now select IK tool on tool panel as shown in Figure 3.66. 

 

Fig. 3.66 IK Tool 

Step 10. Click on IK tool, the anchor point converts in joints. Make sure to select all 

the layers while you turn on IK tool. Observe the magic after clicking on IK as shown in 

Figure 3.67. 

 

Fig. 3.67 Joints are connected Courtesy-Author 

Step 11. If you click on anchor point then all the above shape from this joint will be 

selected. You can rotate all selected shape from their joints. However, if you click 

between anchor point then only the selected shape will rotate as shown in Figure 3.68. 
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Fig. 3.68 (a) Rotate all shapes from joint 

 
 Fig. 3.68 (b) Rotate selected shape 

Step 12. Bring all the shapes in original position. 

Step 13. Observe that shape is not moving, when you forward the video as shown in 

Figure 3.69. 

 

Fig. 3.69 Shape is not moving with object Courtesy-Author 

Step 14. So use tracker to transform the shape. Move to first frame and select tracker. 

Follow the following steps of tracking. 

a. Select point tracker as shown in Figure 3.70 (a) & (b) and click on Create option. A 

tracker will be appeared on object list. Place it over the Right leg layer. You can select 

the tracking point on viewer as shown in Figure 3.71. 

 

Fig. 3.70 (a) Point tracker is created  Courtesy-Author 

 

Fig. 3.70 (b) Place the tracker over the right leg layer Courtesy-Author 
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Fig. 3.71 Tracking Point Courtesy-Author 

b. Now click on “Track Forward” or “Track Forward one frame” button to track the 

motion of object as shown in Figure 3.72. 

 

Fig. 3.72 Track forward button Courtesy-Author 

c. Observe the tracking progress in viewer as shown in Figure 3.73. If you find any 

difficulties in tracking, stop it and correct the track manually using anchor point. 

 

Fig. 3.73 Point tracking is completed Courtesy-Author 

d. Now as you see, shape is still placed on first frame. So apply tracker on the layer after 

tracking. 

 

Fig. 3.74 Point tracking is completed Courtesy-Author 

e. Observe the tracking on 5 frame intervals as shown in Figure 3.75 (a), (b), (c), (d), that 

the shapes are moving with object. 
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Fig. 3.75 (a) First Frame 

 
Fig. 3.75 (b) Fifth Frame 

 
Fig. 3.75 (c) Tenth Frame 

 
Fig. 3.75 (d) last Frame 

Step 15. Now move to the first frame as shown in Figure 3.76. 

 

Fig. 3.76 First frame with IK Courtesy-Author 

Step 16. Move to Fifth frame and adjust the movement by IK tool as shown in Figure 

3.77 (a) & (b). 

 
Fig. 3.77 (a) First frame (before) 

 
 Fig. 3.77 (b) First frame (after) 

Step 13. We will move a random frame say, 20th frame and adjust the movement by IK 

tool as shown in Figure 3.78 (a) & (b). 
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Fig. 3.78 (a) 20th frame (before) 

 
Fig. 3.78 (b) 20th frame (after) 

Step 18. Thus, it can be seen that inverse kinematics (IK) is useful to capture natural 

movement. As IK is not performing rotoscoping, it captures movement which can be 

finished later by using reshape and transform tool. 

Assignment 3 

Download horse running video and isolate the horse leg using IK tool. 

Summary 

• In human figure rotoscoping, it is necessary to know the movement of human 

hands, fingers and feet. 

• During isolating extremities, consider the way objects are constructed and where 

they rotate from. 

• To work faster, use shortcut keys to Rotate, Move, Reshape and Motion blur. 

• Consider perspective issues during the roto of hand and finger movement. 

• While the hand is moving, the points placed to the base of the fingers maintain 

their relative location to their respective fingers. 

• Organize the shapes into object list so that you can easily locate the shape. 

• Overlap multiple shapes during human rotoscoping, so that it represents the 

object rather than the shapes. 

• Inverse Kinematics is useful to capture natural movement. 

 

CHECK YOUR PROGRESS 

 

A. Multiple Choice Questions 

1. In Human figure rotoscoping, which movement is not necessary to know (a) 

Hands (b) Fingers (c) Legs (d) Eyes 

2. Remember the following things while perform human rotoscoping (a) Take a 

single shape at a time (b) Roto some frames of each shapes (c) Move to another 

shape without finish first shape (d) Take any random shape and start roto 

3. Arms and legs have____ Pivot points (a) One (b) Two (c) Three (d) Four 

4. In hands, each finger has___ Pivot points (a) Two (b)Three (c)Four (d)Five 

5. There is____ issue in hand movement (a) Joint (b) Focus (c) Perspective (d) 

Anatomy 
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6. During breakdown of palm, keep a point on the_______ of every finger (a) Corner 

(b) Top (c) Joint (d) Base 

7. Create_________ are the best option for joint movement (a) Single shape (b) Two 

shape (c) Multiple shapes (d) Open shape 

8. While breakdown an object in multiple shapes, _____ these shapes (a) Separate 

(b) Overlap (c) Join (d) Intersect 

9. Inverse kinematics means motion, which is____ (a) Already happened (b) Going 

to happen (c) Backward (d) Forward 

B. Fill in the blanks 

1. Differentiate shape based on their ______. 

2. You can choose any shape for roto but never leave it in______. 

3. It's easy to rotate shapes from______ because it is a pivot point. 

4. Arms pivot from ________ and elbow. 

5. During breakdown of the palm, you need to focus on ________ placement. 

6. You also need to arrange shapes in____ which helps you to identify the shape. 

7. Most of the shape in extremities begin and end their movement around their ____. 

8. In IK, we perform recapture and _________ the motion. 

C. True or False 

1. During rotoscoping human figures, you need to isolate various limbs. 

2. Legs bend from hip and ankle. 

3. Hands have single pivot points. 

4. You can create single shapes for joints which can move easily. 

5. In Inverse Kinematics, you will not perform rotoscoping. 

6. During IK, Anchor point is placed in joint. 

D. Short answer questions 

1. Write the connection between human anatomy and human roto? 

2. What is the important point to remember while performing human roto? 

3. How can you isolate the extremities? 

4. What is the need of Hand roto? Explain it with suitable example. 

5. How to isolate hand and palm? 

6. In how many shapes, you should breakdown fingers during roto? 

7. Write the rotoscoping technique of isolating joints. 

8. Why we need to overlap the shape during human roto? 

9. What is Inverse Kinematics? 

10. How can you organize the shape in different layers while performing IK? 

11. Make a list of objects which can be isolated by using Inverse Kinematics. 
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Session 4. Rotoscopy of Hair 
 

 

Till now, we have seen the rotoscoping of organic and inorganic objects. Now let us see 

rotoscoping of objects as mattes and how these objects are isolated from its background. 

Fig. 4.1 A person is imagine surrounding in a matte 

The rotoscoping of human shape includes human body parts such as hands, legs and 

fingers. Finger rotoscoping is slightly difficult due to lot of pivot movement during finger 

roto. In hair rotoscoping, you have to consider face either individual hair or strands of 

hair which are free to move. 

Hair is a small and blurry, even slightly head rotation can change everything about 

hair’s edge. Hair is like thousands of tiny, boneless limbs that have no uniform 

movement and it is affected by the little breezes. 

 
Fig. 4.2 (a) Different hair style 

Courtesy-Freepik.com 

 
Fig. 4.2 (b) Curly hair 

Courtesy-medium.com 

Observe in Figure 4.2 (a) that numerous hair styles make hair rotoscoping complicated. 

The most irritating is the curly hairs shown in Figure 4.2 (b). It needs special attention 

to each individual hair which is tiny, like invisible. The hairs set by gel are good enough, 

but you will not get it always. To start with the hair rotoscoping, divide hairs in two 

shapes - (i) Basic Shape (ii) Standouts 

4.1 Basic Shapes 

It is a section of hair which appears in whole and it has definable edge that can be 

isolated with shapes. It will not change their contour to great extent. So first step is to 

identify these hairs and isolate it. Observe the Figure 4.3. Here you need to create basic 

shapes for those hairs which have fix shapes. 

 

Fig. 4.3 Picture to perform hair rotoscoping Courtesy-Author 
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Practical Activity 4.1 – Create basic shape of hairs to the given footage. 

Before creating basic shapes of hairs, you need to create project in Silhouette FX© 

software, then import the given footage. Create session and insert roto nodes between 

the footage and output. Then follow the following steps. 

Step 1. Play-back the footage and select the video frame which has complete shape and 

sharpness as shown in Figure 4.4. 

 
Ist frame 

 
109th frame 

 
210th  frame 

Fig. 4.4 Frames with complete shape and sharpness 

Now observe all the three frames in Figure 4.4 and select the best frame to start the 

rotoscopy. Generally we start with the first frame but here it seems to be 109th is a 

perfect frame for rotoscoping. It also describes the hair style which suites best to start 

roto from this frame. 

Step 2. Once you select the frame, you need to select spline for roto. You can choose 

anyone from X spline, B spline and Bezier. This time we will select X-spline from Roto 

tool panel. 

  

Step 3. Now you need to create basic shape by X-spline. Press Plus (+) button to zoom 

in the footage, and use Spacebar to navigate within footage. 

Step 4. Use X-spline tool and draw the shape of left side head as shown in Figure 4.5. 

Ensure the overlapping of the shape properly so that it creates perfect edge. 

 
Fig. 4.5 (a) Shape of left side head 

 
Fig. 4.5 (b) Alpha view Courtesy-Author 

Step 5. You need to make a layer on object list to put all these splines together. It will 

help you to identify the splines later. 
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Fig. 4.6 Manage different shapes Courtesy-Author 

Step 6. Now you need to create shapes for right side of hair as shown in Figure 4.7 (a). 

Again select X-spline by pressing S on keyboard and create the shapes. Don’t forget to 

create object list as shown in Figure 4.7 (b). 

 
Fig. 4.7 (a) Right side Shape 

 
         Fig. 4.7 (b) Object list Courtesy-Author 

Step 7. After creating these shapes, check the edge feather as shown in Figure 4.8 (a). 

Always confirm from compositor that they need edge feather on the matte or not. 

 
Fig. 4.8 (a) Edge Feather 

 
Fig. 4.8 (b) Alpha Matte Courtesy-Author 

Step 4. To complete the basic shapes, create shapes for face also, although it is not 

necessary while working with hair rotoscoping. We will divide face in two parts and 

create separate shapes for ears as shown in Figure 4.9. 

 

Fig. 4.9 Breakdown of object in different shapes Courtesy-Author 

Step 9. Observe that the face splines colour is green. You can change spline colour on 

object list as shown in Figure 4.10. 
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Fig. 4.10 (a) select the spline outline colour 

 
Fig. 4.10 (b) Change spline 

colour 

Step 10. Let us check the alpha matte and solid view of video frame. 

 
Fig. 4.11 (a) Alpha matte 

 
Fig. 4.11 (b) Solid Comp View 

After completing the basic shapes, let us now move towards standout shapes. 

4.2 Standout Shapes 

If you observe the top of the head you will find stragglers that are not easily covered by 

basic shape. After creating solid edge for focus object, next step is to identify the strands 

of hair that is not included in basic shapes. Now the problem is, how to identify these 

strands as they are large in numbers. 

To identify these strands, don’t magnify the frame and press F in keyboard to see its 

whole view. Then identify the strands as shown in Figure 4.12 (a) After this, magnify the 

strand as shown in Figure 4.12 (b) and observe the technique that you can apply on it. 

 
Fig. 4.12 (a) Visible hair Strands 

 
Fig. 4.12 (b) Magnify hair strand 

Isolating the individual hairs is complex task. So we will use open poly which is specially 

used for hair roto. 

Open Shapes/ Open Poly 

In open poly, create shapes using splines. Here you do not need to close it by connecting 

with first point. Let us create it using the following steps. 
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Step 1. Select X-spline and create control points as shown in Figure 4.13. Press “Esc” 

key to close the shapes. 

 
Fig. 4.13 (a) Create control points 

 
   Fig. 4.13 (b) Press Esc to close the shape 

Step 2. Again select the shape using Reshape and view its properties on Object window 

as shown in Figure 4.14. 

 

Fig. 4.14 Properties of spline Courtesy-Author 

Step 3. You need Stroke Width to perform hair roto. You can also change its color either 

from object window or from object list as shown in Figure 4.15 (a). Don’t increase stroke 

width more than 2px for hair roto. 

 
Fig. 4.15 (a) Spline Properties on 

object window 

 
Fig. 4.15(b) Spline Courtesy-

Author 

Step 4. You can watch its alpha view as shown in Figure 4.16. 

 

Fig. 4.16 Alpha View Courtesy-Author 
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Open poly is very useful in hair roto. Now you have open poly in your tool list to deal 

with these hair stragglers but how can you select the first hair straggler. Start with 

simplest straggler which has their shape majority of time and movement easy to figure 

out. We will discuss it when animate these stragglers. Now create shape for these 

strands and stragglers as demonstrated in Practical. 

Practical Activity 4.2 – Demonstrate to Isolate strands and stragglers hair shapes 

of given person by using Open poly. 

In Practical Activity 4.1, we have created basic shapes of hair for focus object. Now we 

will create shapes for strands and straggler. 

Step 1. Take an overview of the focus object with basic shapes. Magnify the strands 

which are located on the upper section of the head. Observe these stranglers as shown 

in Figure 4.17. 

 
Fig. 4.17 (a) Basic 

shapes of focus object 

Courtesy-Author 

 
Fig. 4.17 (b) Hair stranglers 

Step 2. Disable all the shape and focus on these stragglers as shown in Figure 4.18. 

 

Fig. 4.18 Disable shapes Courtesy-Author 

Step 3. Select X-spline or any other spline tool and create open poly shapes for these 

stranglers. Create one colour for each strand which helps you during movement. Ensure 

that all these shapes have their root in head. After creating shape, increase its stroke 

width by 2px in object window, as shown in Figure 4.19. 

 
Fig. 4.19 (a) Open shape 

 
Fig. 4.19 (b) Shape properties Courtesy-
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Author 

Step 4. After applying the stroke over open poly, select open shape. It shows 2 handles 

red and green as shown in Figure 4.20 (a). Red controls the thickness of stroke while 

green combines blur on strokes. 

 
Fig. 4.20 (a) Stroke Handles 

 
        Fig. 4.20 (b) Open shape Alpha/matte 

view Courtesy-Author 

Step 5. Create open shapes for the entire adjacent straggler and keep it on same group 

and colour as shown in Figure 4.21. 

 
Fig. 4.21 (a) Group of 

hair strangler 

 
Fig. 4.21 (b) Object list 

Step 6. In this way, it is possible to isolate the straggler and strands of hair as shown 

in Figure 4.22. 

 

Fig. 4.22 Final result Courtesy-Author 

Step 7. Observe it in different view as shown in Figure 4.23. 
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Colour Overlay 

 
Matte View 

 
Colour Composite 

Comp 

Fig. 4.23 Different view 

Till now you have learned to isolate the basic shapes and straggler hairs from a single 

frame. In the next chapter we will learn to create animating shapes for focus object. 

Assignment 1 

Shoot/download a video of a person and divide the hairs in basic shapes and standout. 

4.3 Animate the shapes 

To animate the shapes first animate the basic shapes and then animate strands and 

straggler. 

Consider the following tips to animate the shapes 

1. Ask your client in the beginning about the need of transparency feather or not. 

2. Never use tracking while doing hair roto. 

3. Never move root of hair roto. 

4. Always check hair roto once you complete single hair. 

5. Never add stroke and cap at the beginning of hair roto because it will   affect 

system performance. 

6. Open poly hair roto is not always necessary. 

7. Always use X-Spline and B-Spline. 

8. Always do prep before you roto such as stabilisation, blur requirement. 

9. Complete single hair then go for others. 

10. Always organise your layers and name your hairs color. 

11. Make a group of 10-10 hairs. 

4.3.1 Animate the basic shape 

Remember these tips, while animating the shape. Now we will animate the basic shape 

of hair. We animate the hairs in two segments. First we will animate the basic shape of 

hair and then animate the strangler hair. 

Practical Activity 4.3 – Animate the basic shape of hair. 

Step 1. To animate basic hair shape one by one, disable all shapes except left head hair 

from object list. To disable the shape go to the object list and disable the visible icon. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

148 

 

Fig. 4.24 Disable the layers Courtesy-Author 

Step 2. Set 5 frame Frame-steps as shown in Figure 4.25 to skip in-between frames. 

 

Fig. 4.25 Set frame-steps Courtesy-Author 

Step 3. Press Z to move five frames backward and adjust the shape as shown in Figure 

4.26. 

 

Fig. 4.26 Move 5 frames backward Courtesy-Author 

Step 4. Press Z again to move 5 frames backward and adjust the shape as shown in 

Figure 4.27. 

 

Fig. 4.27 Move backward again Courtesy-Author 

Step 5. Use transform tool while animating the shape. After transform, use reshape tool 

if required to adjust the shape. By using this technique, you can animate backward 

frames. The frames before and after the transform are shown in Figure 4.24. 
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162th frame (before) 

 
162th frame (after) 

 
150th frame (before) 

 
150th frame (after) 

Fig. 4.28 Modify the shapes Courtesy-Author 

Step 6. By using this technique, you can modify and animate basic shape of hair. 

4.3.2 Animate the standout shape 

After animating basic shape, next animate standout hair. During this, you will animate 

open poly. Remember the following points while animating standout hair. 

1. Never left open shape in middle, which you select for animate. 

2. Complete selected open shape first, and then move to another shape. 

3. The root of hair should always be in the head. 

4. Apply the stroke on open poly at the end. 

5. Never use blur and cap in hair open shape. 

6. Use the stroke width of 1 or 2 pixels for single hair. 

7. Animate the selected hair until it disappears. 

Practical Activity 4.4 – Demonstrate to Animate the standout shape of hair. 

Step 1. Disable all the shape except the open poly which is to be animated (Figure 4.29). 

 

Fig. 4.29 Enable hair strand Courtesy-Author 

Step 2. Disable its stroke. Enable it after completing animation (Figure 4.30). 
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Fig. 4.30 Disable stroke Courtesy-Author 

Step 3. Move backward frame by frame by pressing Z on keyboard as shown in Figure 

4.31 and animate the spline according to selected hair till the shape disappears. 

 
Fig. 170th Frame 

 
Fig. 166th Frame 

 
Fig. 162th Frame 

 
Fig. 158th Frame 

 
Fig. 152th Frame 

 
Fig. 148th Frame 

Fig. 4.31 Animating the shapes Courtesy-Author 

Step 4. Once the roto of single hair is completed, enable the stroke width as shown in 

Figure 4.32. 

 
Fig. 4.32 (a) Stroke Width 

 
Fig. 4.32 (b) Stroke applied on open shape 

Step 5. Animate the other hairs, in same group (Figure 4.33). 
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Fig. 4.33 Animate group of hairs Courtesy-Author 

Step 6. Apply stroke widths to all shapes. Press ‘A’ twice to enable alpha view and watch 

the Matte. 

   

Fig. 4.34 Alpha View of different frames Courtesy-Author 

Summary 

• In Hair rotoscoping, classified hair in two shapes- Basic and standout. 

• Basic shapes are a section of hair which appears in whole and has definable 

edges. They will not change their contour to great extent. 

• Standout is a kind of straggler hairs that is not covered by basic shapes. 

• Use Open Poly/open shape to create Hair standout shapes. 

• Animate the hairs in two segments. Initially animate the basic shape and then 

strangler hair. 

• Complete selected open shape first, and then move to another shape. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. In hair rotoscoping, you need to divide hairs in (a) Basic shape (b) Standouts (c) 
Basic shape and standouts (d) Simple and complex shape 

2. In hair rotoscoping, basic shapes change their (a) Root (b) Path (c) Contour (d) 
Thickness 

3. Before creating the basic shape of hairs, select video frame which have (a) Shapes 
(b) Sharpness (c) Complete shapes and sharpness (d) Blurriness 

4. In hair rotoscoping, you do not need ______ spline (a) X Spline (b) B Spline (c) 
Bezier (d) Circle 

5. You can change spline's colour from (a) Object list (b) Trees window (c) Viewer (d) 
Sources window 

6. In hair rotoscoping, Standouts are (a) Group of hairs (b) Single hair (c) Hair 
stragglers (d) Straight hairs 

7. In open poly always keep (a) overlapping shapes (b) different shapes close each 
other (c) Colour of the shapes same (d) Opacity of the shape minimum 

8. When you click open poly shape in viewer it shows (a) Red and blue handle (b) 
Yellow and Red handle (c) Red and Green handle (d) Red handle 

9. Create open shapes for the entire adjacent straggler and keep it on (a) Same group 
(b) Same colour (c) Same opacity (d) Same group and colour 

10. In hair rotoscoping, first you need to animate (a) Individual strand (b) Hair 
Stragglers (c) Basic shape (d) Complex shape 

B. Fill in the blanks 
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1. The section of hair which appears in whole and has definable edge is called______. 

2. Always confirm from ______ that they need edge feather on the matte or not. 

3. You can change stroke width color either from ______ or from object list. 

4. Start with simplest straggler which has their shape ___________. 

5. In stroke width, red controls the________ of stroke. 

6. Always check hair roto once you complete __________. 

7. The____ of hair should always be in the head. 

C. True or False 

1. You can increase stroke width more than 2px for hair roto. 

2. Don't use tracking while doing hair roto. 

3. During hair roto, organize your layers and name your hairs color. 

4. To identify strands, magnify the frame. 

5. Apply the stroke on open poly at the end. 

D. Answer in short 

1. How can you divide the various shapes in hair rotoscoping? 

2. What is basic shape? Write its qualities. 

3. What is standout? How to identify these shapes? 

4. What is the use of open poly in hair rotoscoping? 

5. What are the different controls of stroke width? How it is useful. 

6. What are the important tips you need to consider before animating the shape? 

 

Module 3 Advanced Roto Techniques 
and Applications 

 

Module Overview 

There are some amazing nodes in SilhouetteFX©, such as Power matte and zmatte node 

which can make your work easier. In this unit, you will understand the uses of these 

two nodes. 

Power Matte uses trimap, which has three regions into image – Foreground, that you 

want to cut, background that you want to get rid of and unknown. There are two 

methods used to generate these regions – Open shape and close shape method. zMatte 

is another node, that creates matte quickly and simply by using minimum parameters. 

It uses two methods – (i) green/blue screen keying (ii) without blue/green screen. 

Further, in this unit, we will discuss about different issues of video footage which we 

are commonly known as scene salvage. Most of the time, it is preplanned post 

production process, such as wire removal and rig removal. Here, you will also 

understand its repairing methods like clone brushes and clean plates. Next, it reveals 

the secret behind 3 and you will understand 3D basics like stereography, convergence 

and many more. Further we will discuss about stereo conversion method, which is 

largely used to convert flat 2D film into 3D. It is a post-production technique. At the end 

of the unit, you will understand the technique of stereo roto which is a main part of 

stereo conversion workflow. 
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Learning Outcomes 

After completing this module, you will be able to: 

• Explore key nodes in Silhouette software and how they can be utilized for efficient 

rotoscoping. 

• Demonstrate techniques for salvaging and restoring problematic scenes in visual 

effects workflows. 

• Understand the process and techniques for stereo rotoscoping to create depth 

and dimensionality in 3D visual effects. 

 

Module Structure 

Session 1: Useful Nodes of Silhouette 

Session 2: Scene Salvage 

Session 3: Stereo Roto  

Session 1: Useful Nodes of Silhouette 

 

A lot of attention is required when performing roto, especially in the edge because it can 

create jitter and spoil all the work done. In reality, you need to draw rough outlines to 

extract the shape. In this this chapter, you will go through some amazing nodes which 

can make your work easier. 

Using proprietary matte extraction techniques, the Power Matte and zMatte node are 

capable of extracting almost any object in an image quickly and simply even if you are 

dealing with fine hair detail, smoke, or reflections. They are easy to use and provide the 

tools required for good, bad, or ugly shots. 

1.1 Power Matte 

Power Matte is an easy to use interactive image matting tool. It is capable of extracting 

almost any object in an image. It is essential to know about the foreground and 

background when working with Power Matte. Figure 1.1 shows the foreground and 

background area. 

Foreground – Area within the frame which you want to extract. 

Background – Area which you want to remove from the frame. 

 

Fig. 1.1 Foreground and Background, Courtesy- pixabay.com 

Once you draw shapes on these areas, Power matte continuously estimates the 

transparency value for every pixel in the image, based on a small sample of foreground 
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and background pixels. This method is more efficient and requires minimum effort to 

isolate high quality mattes for foreground. Since shapes are required for Power Matte, 

it has its shape tools similar to those in the Roto node. 

1.1.1 Matte Creation 

Power Matte uses open or closed shapes to define the object to isolate or extract. Here, 

the shapes can be loose and don’t need to follow exactly around the edges as shown in 

Figure 1.2 (a) & (b). Areas not defined by shapes are considered unknown areas and are 

automatically computed by Power Matte. 

 
Fig. 1.2 (a) Open Shape 

 
Fig. 1.2 (b) Close Shape 

1.1.2 Trimaps 

Power Matte generates an immediate matte result by using foreground and background 

shapes called a Trimap. A pre-segmented image is created by using trimap consisting of 

three regions – foreground, background and unknown. Foreground is a portion of the 

image to cut out. Background is a portion of the image to get rid of. The remaining part 

of the image is referred as unknown. Partial opacity values are then computed only for 

pixels inside the unknown region. There are two Trimap methods used: (i) Open Shape 

and (ii) Closed Shape. When creating mattes, start with the Open Shape Method and 

move on to the Closed Shape Method if the results are not satisfying. 

 

Fig. 1.3 Trimap 

1.1.3 Open Shape Method 

In open shape method, Power Matte needs few open shapes to define foreground and 

background area of the image. The areas which are not covered either by foreground or 

background shapes are considered unknown areas and partial opacity value is being 

computed in this area. 

Open shape method requires little user input. However when the colour ambiguity 

presents between foreground and background, the closed shape method creates more 

accurate matte results. You should know the fact that open shape method requires 

slightly longer time to render as it requires extra calculation steps. 

Practical Activity 1.1 – Demonstrate to extract an object by using open shape 

method. 

Step 1. Import some source footage as shown in Figure 1.4 and create a session. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

155 

 

Fig. 1.4 Create a session Courtesy-Author 

Step 2. In the Trees window, insert Power Matte node and connect it to the source node 

as shown in Figure 1.5. 

 

Fig. 1.5 Insert Power Matte node Courtesy-Author 

Step 3. Single-click in the centre of the Power Matte node to view and edit the Node as 

shown in Figure 1.6. 

 

Fig. 1.6 Power Matte node Parameter 
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Step 4. Define foreground area by drawing an open shape around the inner edge of the 

object as shown in Figure 1.7. For this, select Bezier, B-Spline or X-Spline from the 

Toolbar. 

 

Fig. 1.7 Foreground Area Courtesy-Author 

Step 5. When finished adding points, press the Esc key to finish the open shape. 

Step 6. Now, you need to draw shapes to define background areas as shown in Figure 

1.8. 

 

Fig. 1.8 Background Area Courtesy-Author 

Step 7. In the Object List, feel free to change the name and color of your shapes as 

shown in Figure 1.1. 

 

Fig. 1.9 Object List  Courtesy-Author 

For example, name the inner shape Foreground and change the color to red. Also, name 

the outer shape Background and left their color set to green as shown in Figure 1.10. 

Although this is not a necessary step, it helps to identify the shapes are being used for. 

Power Matte won’t process until you assign the shapes as either foreground or 

background. 
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Fig. 1.10 Foreground and background shape’s colour Courtesy-Author 

Step 8. Select the inner, foreground shape in object list as shown in Figure 1.11 (a) and 

set type to Foreground in the Object window as shown in Figure 1.11 (b). 

 

Fig. 1.11 (a) object list Courtesy-Author 

 

Fig. 1.11 (b) object Properties Courtesy-Author 

Step 1. Select all the outer, background shapes in object list and set the type to 

Background in the Object window as shown in Figure 1.12 (a) & (b). 

 

Fig. 1.12 (a) object list Courtesy-Author 

 

Fig. 1.12 (b) object Properties Courtesy-Author 

Step 10. Draw as many as required open shapes as shown in Figure 1.13. Make sure 

to set its type like foreground or background in object window. 
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Fig. 1.13 Draw additional open shapes Courtesy-Author 

Step 11. Once a foreground and background shapes are assigned, Power Matte 

processes the Matte, as shown in Figure 1.14. 

 

Fig. 1.14 Matte Display Courtesy-Author 

Step 12. The Viewer displays the composite of foreground over the background based 

on your shapes. Import background object on project and connect it with background 

node of power matte as shown in Figure 1.15 (a) & (b). 

 

Fig. 1.15 (a) Connect background node  Courtesy-Author 

 

Fig. 1.16 (b) Composite View Courtesy-Author 

Step 13. Now you need to animate the open shape according to movement of object, 

first set the View to Foreground. This way Power Matte is not constantly trying to update 

when you change a parameter. 
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Fig. 1.17 Foreground view Courtesy-Author 

Step 14. Animate the foreground and background shapes over time so that they follow 

the motion of focus object. However, since you already assigned the shapes as 

foreground and background, Power Matte will try and update every time you adjust the 

shapes. 

It is best to use the Tracker (Shift-T) to animate the motion of your shapes as it will 

most likely ensure that the motion is consistent from frame to frame. 

 

Fig. 1.18 Animate the shapes Courtesy-Author 

Step 15. Play back the clip, to make sure that the shapes are properly following object. 

Step 16. Use View > Matte to display the generated matte. 

Step 17. Hit the Play button to check your results. When you hit the Play button, Power 

Matte renders each frame. 

Step 18. If at any time you want to turn off the display of the shapes, click the Overlay 

icon above the Viewer or press 0 (number zero) shortcut key. 

In the generated matte, foreground white is, background is black and any gray areas in 

between represent a level of transparency as shown in Figure 1.19. If the matte is not 

acceptable after processing, you can either adjust the shapes or add additional shapes 

near the region where the matte is not accurate. 
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Fig. 1.19 Foreground, background and transparency in a matte Courtesy-Author 

 

Fig. 1.20 Composite view of matte Courtesy-Author 

More to Know 

If you see gray areas in the foreground object that should be completely white, 

make additional foreground shapes in those areas. 

If you see gray areas in the background that should be completely black, make 

additional background shapes in those areas. 

Gray values in Unknown areas can be reduced by increasing the deartifact value 

located in the Node parameters. 

You can enhance computer performance while using Power matte by either: 

Set the View to Foreground while editing shapes. Set the Update mode to Manual and 

hit the Enter key when you want to process as shown in Figure 1.21 

 

Fig. 1.21 Manual Update Mode Courtesy-Author 

Use a lower quality proxy image by using the Proxy pull-down menu above the Viewer, 

as shown in Figure 1.22. 
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Fig. 1.22 Proxy Size Setting Courtesy-Author 

To remove fringing around the object being cut out, go to the Node parameters and turn 

on Color Estimation as shown in Figure 1.23. 

 

Fig. 1.23 Colour Estimation Courtesy-Author 

More to Know 

Colour Estimation – It estimates the colours of foreground in unknown and 

semi-transparent areas. Colour estimation is Off by default and when activated, 

it prevents fringing which is needed for smooth compositing as shown in Figure 

1.23 (a) & (b). 

 
Fig. 1.23 (a) Colour Estimation OFF 

 
Fig. 1.23 (b) Colour Estimation ON 

Courtesy-SilhouetteFX.com 
 

Open Shape Method Tips 

• Make sure to draw enough foreground and background shapes. Always draw, 

open inner shape within the object and outer open shape outside the object. 

• The shapes are created near the boundary of the object, yet it is not drawn exactly 

over the object. 

• Keep the foreground and background shape in different colour, it will help you to 

identify the object, also you should keep the foreground and background object 

colour in mind, so that you can select contrast colour. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

162 

• While viewing the matte, if you find any gray areas in the foreground object then 

do necessary change in foreground shapes to make it completely white. If you see 

gray matte areas in the background that should be completely black. 

• The general rule is, to not put different foreground and background shapes too 

close together unless you need it. 

1.1.4 Closed Shape Method 

In Close Shape method, closed shapes are used to mark definite foreground and 

background area of the image. The areas, which is not comes under these two are 

consider as unmarked area. For these areas, partial opacity value is computed for the 

pixels. So, always try to keep any hair details, transparent or blurry portions under 

these unknown areas. 

Table 1: Difference between Open Shape and Closed Shape method 

Characteristics/situations Open Shape  Closed shape 

Regions Foreground, background 

and unknown 

Foreground, background 

and unknown 

Method used Uses open shape to 

mark foreground and 

background area 

Uses closed shape to mark 

definite foreground and 

background area 

Trimap process Slightly Slower Faster 

If colour ambiguity exist in 

Foreground and background 

Not working Create more accurate matte 

Foreground object with 

background holes 

Used in this situation Cannot handle 

Practical Activity 1.2 – Demonstrate to extract an object by using Close shape 

method. 

Step 1. Import some source footage and create a session, as shown in Figure 1.24. 

 

Fig. 1.24 Import footage and create session Courtesy-Author 

Step 2. In the Trees window, add a Power Matte node between source and output, as 

shown in Figure 1.25. 
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Fig. 1.25 Power Matte Node Courtesy-Author 

Step 3. Define foreground area by drawing a closed shape. Draw a shape around the 

inner edge of the object as shown in Figure 1.26. To close the shape, click on the first 

point that you created. 

 

Fig. 1.26 Closed Shape Courtesy-Author 

Step 4. To inform Power Matte that you are using a closed shape, enable Filled in the 

Object window as well as set the type of shape to Foreground as shown in Figure 1.27. 

 

Fig. 1.27 Enable Filled in object window Courtesy-Author 

Step 5. Now, draw closed shapes to define background area as shown in Figure 1.28. It 

is the area which you want to remove from the clip. 

 

Fig. 1.28 Draw background area Courtesy-Author 
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Step 6. After drawing the background shape, enable Filled in the Object window and 

set the Type for this shape to Background as shown in Figure 1.29. Don’t forget, to click 

on invert box, because background area is opposite side from closed shape. 

 

Fig. 1.29 Enable Filled in object window Courtesy-Author 

Step 7. As foreground and background shapes are assigned as shown in Figure 1.30. 

Power Matte processes the Matte. 

 

Fig. 1.30 Matte View 

Step 8. You can use color node as a background and can change its color on object 

window as shown in Figure 1.31. 

 
Fig. 1.31 (a) Color Node 

 
Fig. 1.31 (b) Node Window 

Step 1. The Viewer displays the composite of the foreground over the background 

based on your shapes, as shown in Figure 1.32. 
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Fig. 1.32 Composite View Courtesy-Author 

Step 10. Animate the foreground and background shapes over time as shown in Figure 

1.33. For this either use key frame bifurcation technique or choose tracker. 

 

Fig. 1.33 Animating the shapes Courtesy-Author 

Step 11. Use View > Matte to display the generated matte. 

Step 12. Hit the Play button to check your results so far. 

Step 13. At any time if you want to turn off the display of the shapes, click on 0 (number 

zero as shown in Figure 1.34 (a) & (b)). 

 
Fig. 1.34 (a) Overlay ON 

 
Fig. 1.34 (b) Overlay OFF 

Choose View > Composite to display the Composite. 

Closed Shape Method Tips 

If the foreground object is completely surrounded by background, a quick way to define 

the background area is to first draw a closed shape around the outside of the foreground 

and then invert the shape in the Object Parameters. 

Ideally, the unknown region, which is not defined with foreground or background 

shapes, should only cover transparent pixels whose actual values are not completely 

foreground or background. In other words, the unknown region includes hair detail, 

transparent or blurry portions of the image. 

1.2 zMatte 

In first glance, you can interpret zmatte as a chroma key tools but it is far better than 

that. Using proprietary matte extraction techniques, zMatte quickly and simply creates 
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mattes with minimal parameters even if you are dealing with fine hair detail, smoke, or 

reflections. 

zmatte creates mattes using: 

• Green/Blue screen keying 

• Generating matte without blue/green screen 

1.2.1 Green/Blue screen keying 

zMatte can be used to create single matte for blue/green screen footage. Here you have 

two options to use inner/outer keying method. 

• Primary matte – It has gray values in the foreground’s edge. This will give a nice, 

smooth edge in the final composite. 

1. Secondary matte – It is used to fill in any gray areas of the Primary Matte while 

retaining the gray values in the edge. You can do this by adjusting the Blur, 

Shrink/Grow and/or Wrap parameters of the Secondary Matte to retain the 

Primary Matte’s edge values. 

So let’s create single matte for blue screen footage. 

Practical Activity 1.3 – Create matte for blue screen footage by using green/blue 

screen keying. 

Step 1. Import some green or blue screen source footage and create a session as shown 

in Figure 1.35. 

 

Fig. 1.35 Import Source footage Courtesy-Author 

Step 2. In the Trees window, add a zMatte node between source and output node as 

shown in Figure 1.36. 

 

Fig. 1.36 Insert zMatte Node Courtesy-Author 

Step 3. Click on the center of the zMatte node to view and edit it. 

Step 4. Select Primary Matte from the View pop-up menu as shown in Figure 1.37. 
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Fig. 1.37 Primary matte Courtesy-Author 

Step 5. Set the Primary Matte > Extract; On to Blue or Green Screen as shown in 

Figure 1.38. 

 
Fig. 1.38 (a) Extract on green screen 

 
Fig. 1.38 (b) View impact on viewer 

Step 6. From the view menu, select primary matte, as shown in Figure 1.31. 

 

Fig. 1.39 Primary Matte View Courtesy-Author 

Step 7. Adjust the Background slider, as shown in Figure 1.40, so that the background 

area will completely black 

 
Fig. 1.40 (a) Adjust background 

slider Courtesy-Author 

 
Fig. 1.40 (b) Primary matte View 

Step 8. Set the Foreground slider as shown in Figure 1.41, so that the Primary Matte 

has gray values, especially in the edges. 
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Fig. 1.41 (a) Adjust Foreground 

slider Courtesy-Author 

 
Fig. 1.41 (b) Primary matte View 

Step 1. Expand the Secondary Matte group and click on the Enable checkbox as shown 

in Figure 1.42 (a). You can see the Secondary Matte in the Viewer as shown in Figure 

1.42 (b). 

 

Fig. 1.42 (a) Enable Secondary 

Matte 

 

  Fig. 1.42 (b) Secondary Matte View 

Step 10. Set the Secondary Matte > Extract On to the same setting as the Primary 

Matte. 

Step 11. Adjust the Secondary Matte so that the foreground is completely white and 

the background is completely black. 

 

Fig. 1.43 Adjust the secondary matte Courtesy-Author 

Step 12. Switch the View menu to Combined Matte as shown in Figure 1.43. The 

Combined Matte view shows the combination of the two mattes. 
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Fig. 1.44 Combined matte view Courtesy-Author 

Step 13. Adjust the Secondary Matte> Wrap parameter as shown in Figure 1.45 to pull 

back the hard edges of the Secondary Matte to reveal the gray edges of the Primary 

Matte as shown in Figure 1.46. 

 
Fig. 1.45 Wrap Parameter 

 
Fig. 1.46 Combined Matte View 

You could also use Secondary Matte > Shrink/Grow and Blur separately or in 

conjunction with Wrap to blend the two mattes together. 

Step 14. Change the View pop-up menu to Composite as shown in Figure 1.47. If you 

do not have input a background, then foreground will be composited over black. 

 

Fig. 1.47 Composite View Courtesy-Author 

Step 15. If you have a video clip that you want to use for the background, then connect 

it in to the background input of zMatte as shown in Figure 1.48. The foreground will 

then be composited over the background. 
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Fig. 1.48 Composite View when input background Courtesy-Author 

• If you see any color spill from the blue or green screen, it can be eliminated using the 

Color Suppression controls. 

• Expand the Color Suppression group and click the Enable check box. Adjust the 

Color Suppression > Foreground and Range controls as required. 

Know more… 

If you are not going to use the Inner/Outer Keying method, you would adjust the 

Foreground slider so that the foreground values would be completely white in the 

Primary Matte. In this case, a Secondary Matte would not be used. 

1.2.2 Holdout Matte 

A Holdout Matte defines foreground areas that should not be keyed out. zMatte has 

Holdout Matte as an auxiliary input that can come from a source image or a node like 

Roto. If there are foreground areas that are not keying properly, hook a Roto node into 

the Holdout Matte input. Roto the appropriate foreground areas and they will be added 

to the output matte. 

Fig. 1.49 Holdout Matte 

1.2.3 Garbage Matte 

Garbage Matte defines background areas that should be keyed out. Garbage matte is 

also an auxiliary input. 

If there are background areas that are not keying properly, hook a Roto node into the 

Garbage Matte input. Roto the appropriate background areas and they will be 

subtracted from the output matte. 

Fig. 1.50 Garbage Matte 

Summary 

• Power Matte is an easy to use interactive image matting tool. 

• Power matte continuously estimates the transparency value for every pixel in the 

image, based on a small sample of foreground and background pixels. 

• There are two trimap methods are used; Open Shape and Closed Shape. 

• Start with the Open Shape method and move on to Closed Shape if the result is 

not satisfying. 

• Assign foreground and background shape to process the power matte. 
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• To turn off the display of the shapes, click Overlay icon above the Viewer or press 

0 (number zero) shortcut key. 

• zMatte quickly and simply creates mattes with minimal parameters if you are 

dealing with fine hair detail, smoke or reflections. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Foreground is the area, which you want to (a) extract from the frame (b) remove 

from the frame (c) superimpose in the frame (d) highlight in the frame 

2. Tools of Power matte are similar to (a) Paint Node (b) Depth Node (c) Roto Node 

(d) zMatte 

3. The following region is not included in Trimap (a) Foreground (b) Background (c) 

Unknown (d) Middle space 

4. In Power Matte, White signifies (a) Solid foreground (b) Solid background (c) 

Partial opacity (d) Full transparency 

5. Define foreground area by drawing an open shape around the (a) On the outer 

edge of object (b) Edge of the object (c) Inner edge of the object (d) Far from 

background object 

6. Power Matte processes the matte when______ assign (a) Foreground shape (b) 

Background Shape (c) Unknown Shape (d) Foreground and Background 

7. zMatte cannot create mattes by using (a) Blue Screen (b) Green Screen (c) 

Luminance (d)Yellow screen 

8. Holdout Matte defines (a) Background area that should be keyed out (b) 

Foreground area that should not be keyed out (c) Foreground and background 

area that should be keyed out (d) Background area that should be keyed out 

B. Fill in the blanks 

1. Power Matte uses______ and Closed shape to create matte. 

2. If you see gray areas in the background that should be completely______. 

3. Colour______ prevents fringing to create a seamless composite. 

4. In Open Shape method, the general rule is to not put different_____ shapes too 

close together. 

5. When using a closed shape in power matte, enable Filled in the _____ window. 

6. Primary matte has grey values in the ________ edge. 

C. True or False 

1. When creating mattes, start with the Close Shape Method and move on to the 

Open shape. 

2. Set the Update mode to Manual and hit the Enter key when you want to process. 

3. Closed Shape trimaps process slightly slower than Open Shape trimaps. 

4. Adjust the wrap parameter in secondary matte, to pull back the hard edge of 

secondary matte to reveal the gray area of primary matte. 

5. Holdout Matte comes from a source image or a node like Roto. 
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D. Short answer questions 

1. What is Power matte? 

2. What is Foreground and background area in power matte? 

3. What is Trimaps? 

4. Explain open and close shape method of matte creation? 

5. When should open shape method use? 

6. Why we should assign shape name in object list while using power matte? 

7. What is zmatte? 

8. What are the different methods of keying in zmatte? 

9. Explain Holdout matte with its use? 

10. What is Garbage matte? 

 

 

Session 2: Scene Salvage 

 

Scene salvage covers a broad range of issues. They have one common thing is to fix the 

errors in picture. Sometimes these are production accidents such as a scratch on the 

film, a hair in the gate, flashing frames, or a light leak. 

Sometimes they are pre-planned post production processes such as wire and rig removal 

where it was planned to fix them after principal photography. Sometimes it is just a 

normal part of life like dust busting. Many of the tasks described here are considered 

entry-level work and may be the first type of job in digital compositing. 

  

Fig. 2.1 Movie stills- wire removal Courtesy-Marvel Studio 

The production accident problems are the most challenging to fix because they are by 

definition, unplanned acts against nature and can be complex to deal with. Some of 

them are simply not possible to fix. A regular VFX shot can be complex, but at least 

somebody sat down and thought through the best way to build the shot and prepare 

elements appropriately as shown in Figure 2.1. 

This chapter works through several examples of common scene salvaging problems. It 

demonstrates many of the techniques used to perform those repairs. These repair 

techniques include clone brushes, clean plates, and many others. 

2.1 Wire removal 

The explosion, in success of wild adventure films has triggered a similar explosion in 

the usage of "wire gags" where a character playing the role of hero is wearing a belt 

under his clothes attached to wires and pulleys, as shown in Figure 2.2 (a) & (b). At the 

other end of the cables, the muscular guys are pulling on them at the perfect time to lift 
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the hero, so he can climb over tall buildings. Keep in mind that the wires must be 

disconnected before the shot can be used. 

  

Fig.2.2 (a) & (b) VFX shots where hero is trussed up with a wire Courtesy- marvel 

Studio 

2.2 Rig removal 

When a motion control shot is done on a model, it has to be supported by some kind of 

armature or rig, as shown in Figure 2.3. Sometimes, the armature is static and the 

camera moves, but rig can also be a motion control device that moves the model around. 

 

Fig. 2.3 Rigging of model 

Assignment 1 – Study the rig removal of different character stop motion video films. 

2.3 Wire /rig removal 

Wire removal can be performed by two different ways. 

2.3.1 Wire/Rig Removal by Painting Frame by Frame 

Wire removal is performed in post-production. However, it is very tedious process, 

because painting on each frame is extremely difficult. In this process, we use clone tool, 

which is working on single frame. Cloning is much more effective, as it clones not just 

colour but grain and noise also, which makes the space almost similar to the adjacent 

place. 

2.3.2 Wire/Rig Removal by Patching Over the Top 

Painting frame by frame is extremely difficult. Hence it is required to find out any 

solution to remove the wire in faster way. First solution is to clean frame from some 

other point in the video clip and secondly paste it over the top of the rig or wire to 

remove. It works well when camera is not moving and shots are steady. 

There is another approach, to create clean plate. In this process, you need to remove 

the wire in a single frame and use this frame as a clean plate with others frames. 

Observe every frame while painting, if you see any change on brightness. 

Know More… 

Clean Plate – A clean plate is an “empty” piece of video or still image of a scene. It has 

same composition, lighting and movement compare to final frame. Basically, it is a 

background shot, which is used in visual effects. When you need to remove any objects 

like wire, rig from frame. It can be any static shot or may be an aerial shot. (Figure 2.4 

(a) & (b). 
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Fig. 2.4 (a) Video Frame 

 
Fig. 2.4 (b) Clean Plate 

 

2.4 Paint in SilhouetteFX© 

Now use paint tool to remove the wire or rig. There are different ways of painting in 

SilhouetteFX©. So let us explore paint tool in SilhouetteFX©, as shown in Figure 2.5 

 

Fig. 2.5 SilhouetteFX© Paint Tools Courtesy-Author 

Let’s demonstrate to use these tools in Practical Activity 2.1. 

Practical Activity 2.1– Demonstrate to use different paint tools. 

Step 1. Import a video frames in silhouette software as shown in Figure 2.6. Observe 

the effects of paint tools on this frame. 

 

Fig. 2.6 Viewer panel Courtesy-Author 

Step 2. Insert Paint node between source and output in trees window (Figure 2.7). 

 

Fig. 2.7 Paint node Courtesy-Author 

Step 3. Now, observe the paint tools on the extreme left as shown in Figure 2.5. 

Step 4. On selecting paint tool from the tools panel, shows controls in Paint window.  

For instance select the clone brush and observe its control as shown in Figure 2.6. 
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Fig. 2.8 Paint brush controls Courtesy-Author 

Step 5. Let us select paint brushes one by one and observe its uses. 

Black and White 

 

Fig. 2.9 Impact of black and white brush Courtesy-Author 

Blemish – The Blemish brush is useful for removing facial blemishes on film originated 

footage. It combines the Blur and Grain brushes. 

Blur – It blurs the images. 

Clone – Paints the image using another part of the image or other image with the ability 

to grade (color correct), blur or sharpen the clone source. In Figure 2.10 (a) we are going 

to remove the rope. 

 
Fig. 2.10 (a) Original Video Frame 

 
Fig. 2.10 (b) Rope is removed by 

Clone Stroke Courtesy-Author 

Colour – Paint the image with selected colour. 

Colour Correct – The image is painted using colour, brightness and contrast 

adjustment. 
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Fig. 2.11 (a) Before Colour Correct 

 
Fig. 2.11 (b) After Colour Correct 

Cut-out – cut the selection of image and paste it over the required area. The picture 

before cut out and after cut out is shown in Figure 2.12 (a) & (b). 

 

Fig. 2.12 (a) Cut-out (before) Courtesy-Author 

 

Fig. 2.12 (b) Cut-out- after (cut out the building and paste it) Courtesy-Author 

Drag – Smudge or smear an area of the image. When the brush first starts, it makes a 

copy of the area under the brush and then on subsequent samples it stamps that area 

down in the new location with a blend. 

Eraser – It erases previously painted brush strokes and revert the image in its original 

form. 

 
Fig. 2.13 (a) Clone Stroke 

clean the rope 

 
Fig 2.13 (b) Rope appears again after erased 

the Clone Stroke Courtesy-Author 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

177 

Grain – It paints the grain over the image as shown in Figure 2.14. 

 

Fig. 2.14 Grain stroke Courtesy-Author 

Mosaic – It divides the picture in to the square tiles as shown in Figure 2.15. 

Mosaic 

 

Fig. 2.15 Mosaic Stroke Courtesy-Author 

Repair – It paints the image with the color level sampled at the beginning of each stroke. 

Scatter – It scatters pixels in a random fashion. 

 
Fig. 2.16 (a) Original Video Frame 

 
Fig. 2.16 (b) Scatter stroke over video 

frame 

2.4.1 Profile 

Once you select paint tool, you can customize your brush setting in profile tab. 

 

Fig. 2.17 Profile tab Courtesy-Author 
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In Profile tab, you can select brush type (circle or square), brush size, opacity, softness, 

flatness, angle and spacing. 

Know More… 

The size of the brush can be changed by pressing bracket [and] key. You can also 

resize it by holding Ctrl key and drag the left mouse key. 

2.5 Paint the frame by Clone brush 

Clone brush is one of the key tool used to remove the wires in the frames. In Photoshop 

you can remove the unwanted element from the frame. Basically it takes sample from 

other parts of the image and even it can take the samples from other image sources and 

paint it over the required place. 

The controls for the Clone brush are split into three tabs – Clone Tab, Grade tab, and 

Warp tab as shown in Figure 2.18. 

2.5.1 Clone Tab – It deals with the timing and transformation of Clone source. 

 

Fig. 2.18 Clone Tab Courtesy-Author 

2.5.2 Source control – In clone tab, we have source control as shown in Figure 2.19, 

in which we select the paint source and the frame number which we will select for 

cloning. 

 

Fig. 2.19 Source control Courtesy-Author 

In frame number, you can select the required frame, which works as a clone source. 

2.5.3 Transform Control – It enables you to position, scale, rotate, skew and corner 

pin the Clone source. When you select any frame as a clone source then transform 

control help to match it with target frame. 

 

Fig. 2.20 Transform Control Courtesy-Author 

2.5.4 Clone viewing option – It helps to position the clone source. These are onion 

skin overlay, align, vertical split and horizontal split. 

 

Fig. 2.21 Clone Viewing Option Courtesy-Author 
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Onion skin – It mixes clone sources and target. 

Align – Align inverts the clone source and mixes it with the foreground. 

Vertical split – Compare the clone source and target using a vertical split. 

Horizontal split – Compare the clone source and target using a horizontal split. It is 

shown in Figure 2.22 (a) – (d). 

 
Fig. 2.22 (a) onion skin 

 
Fig. 2.22 (b) Align 

 

Fig. 2.22 (c) Vertical Split 

 

Fig. 2.22 (d) Horizontal Split 

Let us perform an activity where we select the frame and match it. 

Practical Activity 2.2 – Demonstrate to remove the frame from given video clip. 

Step1. Import a video in SilhouetteFX© as shown in Figure 2.23. Create a new session 

and Insert paint node between source and output in Tree window. 

 

Fig. 2.23 Insert Paint Node Courtesy-Author 

Step 2. Clone tool is selected in paint toolbar. Now observe the change in clone tab as 

shown in Figure 2.24. When you playback the video, frame number is changing on 

Clone tab. 

Fig. 2.24 Frame number is changing on Clone Tab Courtesy-Author 

Step 3. Now we will find out most appropriate frame to paint. As shown in Figure 2.25 

frame 47 is a blank frame which is most suitable because it has all the background 

details. So we will clone from frame 47. 
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Fig. 2.25 Blank Frame Courtesy-Author 

Step 4. Now navigate first frame on viewer screen as shown in Figure 2.26 (a) and fill 

frame number 47 in clone tabs as shown Figure 2.26 (a). 

 
Fig. 2.26 (a) Viewer’s first frame 

 
Fig. 2.26 (b) Clone Source 

Step 5. Observe both frames in a single one by using clone viewing option, which is 

onion skin, align, vertical split and horizontal split as shown in Figure 2.22 (a), (b), (c) 

and (d). 

Step 6. We will prefer vertical split because it helps to align the clone and source frame. 

Now select Vertical split as shown in Figure 2.27 and transform the clone source 

according to source frame. 

 

Fig. 2.27 Vertical Split Courtesy-Author 

Step 7. Now select clone tool from tool panel. Resize the brush by bracket [and] key as 

shown in Figure 2.28. 
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Fig. 2.28 Clone Tool Courtesy-Author 

Step 8. You can also use Caps-lock key to switch between target frame and vertical 

split as shown in Figure 2.29 (a) & (b). 

 
Fig. 2.29 (a) Caps-lock on 

 
Fig. 2.29 (b) Caps-lock off 

Step 9. Now select clone tool, resize the brush either from profile tab or just pressing 

the bracket key and start painting the frame as shown in Figure 2.30. 

 

Fig. 2.30 Start Painting the frame by Clone tool Courtesy-Author 

Step 2. Take extra care while you are painting the corner of the object. After finishing 

the painting, the object will be disappeared from the frame as shown in Figure 2.31. 

 

Fig. 2.31 Object is disappeared from the Target frame Courtesy-Author 
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Step 11. In this way, you can remove the object from every frame. Let us take another 

frame such as frame number 25 and observe it in vertical split. Remember that your 

clone frame is still frame number 47. So, in vertical split it will show frame number 25 

as a target frame and frame number 47, as a clone frame as shown in Figure 2.32. 

 

Fig. 2.32 Target and Clone Frame Courtesy-Author 

Step 12. Utilize step 9 and 10 to clean the target frame as shown in Figure 2.33. 

 

Fig. 2.33 Clean frame Courtesy-Author 

Step 13. You can easily remove any obstacle from frames, by using these steps. 

2.5.5 Grade/ Filter Tab – It contains colour correction controls while the filter tab is 

used for blur and sharpening. It does not correct colour on target frame but colour 

correct the clone frame. So, keep in mind, that it is useful for matching the colour of 

clone frame with target frame as shown in Figure 2.34. 

 

Fig. 2.34 Grade/Filter Tab Courtesy-Author 
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Let us demonstrate it with activity. 

1. Take target and clone frame in vertical split as performed earlier as shown in Figure 

2.35 (a & (b). 

 

Fig. 2.35 (a) Vertical split , Courtesy-Author 

 

Fig. 2.35 (b) Grade/ Filter default value Courtesy-Author 

2. Now, slide the value of gain and gamma. Observe its impact on clone frame as shown 

in Figure 2.36 and Figure 2.37. 

 

Fig. 2.36 Grade/Filter custom value Courtesy-Author 

 

Fig. 2.37 Colour grade control impact on clone frame Courtesy-Author 

Now you can understand that value of grade and filters only impact on clone frame. It 

is mostly used to match both frames. 

2.5.6 Warp tab – The Warp tab in the Clone Brush allows you to warp specific image 

areas using pins, while leaving other areas untouched. Adjustments can range from 

subtle nip and tucks to something more obvious like repositioning an arm or leg. 
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Fig. 2.38 Warp Tab Courtesy-Author 

Practical Activity 2.3 – Create Clean Plate from video and utilize it for removing 

the wire. 

You may not always get a blank frame in video. So, create it by using some other frame 

of the video, which is called clean plate. A clean plate is a kind of blank frame which is 

work as a background when you are going to remove an obstacle from the frame. 

So, let us understand the process of creating clean plate from the video frame and utilize 

this frame to remove the obstacle. Keep in mind that this clean plate works only when 

the video is not moving. 

Step1. Watch the video again and again, before starting to work on video. Identify the 

object to remove from frame. In this video you need to remove the object showing in red 

arrow in Figure 2.39 

 

Fig. 2.39 Identify the object which needs to remove in target frame Courtesy-

Author 

Step 2. Import the video frames in SilhouetteFX©. Create new session on trees window. 

Insert paint node as shown in Figure 2.40. Now, all set for creating clean plate. 

 

Fig. 2.40 Insert Paint Node Courtesy-Author 

Step 3. Identify the target and clone frame for creating clean plate. After playback it is 

observed that there is no frame which is clean and have no rope and wire. So you need 

to use clone tool and paint it manually. 

Use these three steps. 
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• Select Clone Tool 

1. Search nearest similar pixel, Press shift and drag toward target. 

2. Drag the stroke over the target. 

 
Fig. 2.41(a) Press shift and drag toward 

target 

 
  Fig.2.41(b) Drag the stroke over 

the target Courtesy-Author 

Step 4. By using clone brush, you can remove all the obstacles from the frame. Observe 

the Figure 2.42, all the obstacles from the frame has removed. 

 
Fig. 2.42 (a) Original frame 

 
Fig.2.42 (b) After using clone brush 

Step 5. Now this frame will work as a clean plate for rest of the video frame. So you 

need to export this single frame. To export the frame, 

(a) Select Output node in trees window as shown in Figure 2.43. 

 

Fig. 2.43 Output Node Courtesy-Author 

(b) Select output parameters like format and file location as shown in Figure 2.44. 
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Fig. 2.44 Output Window Courtesy-Author 

(c) Go to the Session> Render Session. Select the desired setting and click on render 

as shown in Figure 2.45. Your file will be saved on desired location. 

 

Fig.2.45 Render Options Courtesy-Author 

Step 6. Now import clean plate in SilhouetteFX©v7.5 software as shown in Figure 2.46. 

 

Fig. 2.46 Clean plate imported on software Courtesy-Author 

Step 7. Insert clean plate on trees window and connect it with input-1 in Paint node 

as shown in Figure 2.47. 

 

Fig. 2.47 Clean plate connected with input-1 in paint node 

Step 8. Now move to Clone control, Focus on these settings,  as shown in Figure 2.48. 

(a) Source – Input 1 because we have connected clean plate with Input 1. 
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(b) Frame – 0 because clean plate has single frame. Its frame number is 0.   

 

Fig. 2.48 Clone Control Settings 

Step 9. You can switch between clean plate and target frame which is current frame in 

viewer by pressing Caps Lock key as shown in Figure 2.49. 

 
Fig. 2.49 (a) Caps-lock off (onion skin 

mode) 

 
Fig. 2.49 (b) Caps-lock on (Current  

Frame/ target frame) Courtesy-Author 

Step 2. Move the selected clone brush over the object which has been cleaned on the 

clean plate and drag the brush over it as shown in Figure 2.50. 

 

Fig. 2.50 Hold left mouse and drag the brush over the object which is removed in 

clean plate 

Step11. After the completion, the frame is cleaned as shown in Figure 2.51. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

188 

 

Fig. 2.51 Frame; after the removing of obstacles Courtesy-Author 

Step 12. Follow these steps to clean each frames. Remember to set source frames in 

clone control every time you will move forward and select new frame. 

Assignment 2. Shoot a video and remove unwanted object like aeroplane, electric pole 

and many more from it. 

Summary 

Wire Removal and Rig Removal are the widely used technique in VFX, which requires 

massive rotoscoping. 

If the object is not in motion, then creating Clean Plate is a faster way technique to 

paint. 

In paint node, Clone tool is mostly used to remove wires. 

Select the source frame in Clone tab; this will work as a reference frame to paint the 

other frames. 

There are four clone viewing options- Onion Skin, Align, Vertical split and Horizontal 

split. 

Use Caps-lock key to switch between clone and source frame. 

  

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Scene salvage does not cover (a) Scratch on the film (b) Flashing frames (c) Light 

leaks (d) Audio noise 

2. Pre-planned post production process is (a) Wire removal (b) Hair in the gate (c) 

Dust busting (d) Lens flare 

3. Wire removal technique is used in (a) Action sequences (b) Motion control shot 

(c) Animation (d) Stop motion 

4. Clean plate is______ (a) Frame with an object (b) Foreground object (c) 

Background object (d) Empty piece of frame of a scene. 

5. Which node is required to remove wire/rig (a) Roto (b) Paint (c) Power matte (d) 

zMatte 

6. Blemish brush combines (a) Blur and grain brush (b) Blur and Clone brush (c) 

Eraser and grain brush (d) Clone and grain brush 
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7. In paint tool, Clone brush (a) Blur the image (b) Paints the image using another 

part of the image or other image (c) Erase the image  (d) Paint the image using 

selected colour 

8. In paint tool, Eraser brush (a) Erase painted stroke (b) Erase the background 

object (c) Erase the painted stroke and revert the image (d) Erase the foreground 

object 

9. In clone brush, clone tab deals with (a) Timing (b) Transformation (c) Timing and 

transformation (d) Position 

10. Clone viewing option doesn't includes (a) Onion Skin (b) Align (c) Vertical split (d) 

Diagonal split 

B. Fill in the blanks 

1. In Visual effects shot, hero is trussed up with a________. 

2. We use_______ tool in wire removal by painting frame by frame. 

3. Clean plate work well when camera is not_______ and shots are_______. 

4. The Blemish brush is useful for removing ___________. 

5. Mosaic divides the picture in to the ______tiles. 

6. Once you select paint tool, you can customize your brush setting in________. 

7. The tool which takes samples from the other parts of the image is called________. 

8. You can select the required frame in_______ under source control which   work 

as a clone source. 

9. Onion skin mixes clone sources and ________. 

10. Grade tab contains __________. 

C. True or False 

1. Wire removal is performed in pre-production. 

2. Cloning is much more effective, as it clones not just colour but grain     or noise. 

3. The size of the brush can be changed by pressing bracket key. 

4. Align inverts the clone source and mixes it with the background. 

5. You can use Caps lock key to switch between target frame and clone viewing 

options. 

D. Short answer questions 

1. What is scene salvage? 

2. What is wire removal? When is this technique used? 

3. How the wire removal can be performed? 

4. What is clean plate? Explain various method of creating clean plate. 

5. Write the use of clean plate in wire removal. 

6. Write different brushes included in Paint tool. 

7. Why clone tool is so important? Explain. 

8. Write the control of clone brush tool. 

9. Write different clone viewing options. When is it used? 

10. How can we create clean plate from the video clip? 
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Session 3. Stereo Roto 

 

Stereo is the same terminology commonly used as 3D with little difference. Film and 

video production team such as cinematographers, Visual effects artist, editors and 

colorist often use the term stereo, while if it is displayed in cinema theaters, television, 

then it is known as “3D” as shown in Figure 3.1 3D television view. 

 

Fig. 3.1 3D television view 

Today, entire movie process has been digitized, that made stereo production much 

easier and higher quality. No matter in which format you have filmed movie, you need 

to digitize it for further post production workflow. Because now editing, visual effects 

and even projection is also converted in digital platform. A digital production pipeline 

results in a much higher-quality movie than all-film process could ever be. 

Even digitization of theatrical projection system is responsible for stereo movies 

production. The same projector that displays stereo can also display regular movies. No 

extra equipment to purchase. No dual prints to purchase for projection. Along with this 

goes much higher-quality stereo projection technology using polarized light and glasses 

instead of the old red and blue anaglyph glasses. In short, the digital process has made 

stereo movies practical, high quality, and reasonably economical. 

3.1 Stereography 

Let us understand this term. It is a technique of creating and projecting stereo movie. 

It is based on human visual system. In reality, the human capacity to perceive the depth 

of a scene in the real world is made up of many distinct visual signals, but the only 

reference used for a stereo film is "stereopsis," where a human watch a scene from two 

slightly different point of view. 

View the "inter-pupillary" distance from two eyes. The distance between the pupils, 

spaced approximately 2.5 inches from each other, as shown in Figure 3.2. 

Fig. 3.2 Two eyes views 

Do you know, that both eyes produce two slightly different views of any scene, later 

brain “fuses” those images by matching the feature between them. Basically, this fusion 

creates stereo vision. 

If the features don’t match, there will be no fusion. The offset or slightly difference 

between matched features is the depth cue to the brain. It uses these offsets to sort the 
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various surfaces in the scene into their relative depth positions so that you can get a 

stereo image. 

Convergence of the eyes is also another perception in stereo viewing. It is the angle 

between the eyes line of sight as they lock onto a target. But the human eyes do more 

than converge on a target. They also focus on that same target. So the eyes create two 

separate responses to a 3D scene—convergence and focus, which work together when 

we look at a 3D object in the real world. 

The 3D movie projector is always focused on the screen. As object change, depth in the 

scene the convergence shifts in and out of the screen, but the focus is locked at the 

screen plane. As a result, a 3D movie is an unnatural act to the brain because the 

convergence and focus are not locked together like in the real world. This is difficult for 

some people to do. So they get headaches or eyestrain. In fact, about 15% of the general 

population cannot do this trick at all so they cannot see the 3D in a 3D movie. 

3.2 Convergence 

When working with the stereo, you will hear many times about convergence. 

Convergence is the point in Z axis, where the eyes converge to meet at the same point, 

or intersect. The Figure 3.3 demonstrates how the point of convergence determines the 

parallax by drawing the red and blue lines of the left and right lines of sight. In the 

positive parallax positions, the depth of the object will be behind the screen, while in 

negative parallax, the depth will be in front of the screen, while there is no depth in zero 

parallax position. 

Fig. 3.3 Convergence and parallax 

The zero parallax is very important because it defines the screen plane. When looking 

at an anaglyph image any objects that have no red/blue ghost outline are at zero 

parallax as shown in Figure 3.4 and are on the screen plane. 

 

Fig. 3.4 Anaglyph view of 3D object 

Shifting the parallax of an object will move that object in and out of the screen. This 

becomes very important for stereo compositing and stereo conversion as we often need 

to adjust the parallax of the various objects in the frame to create a good stereo 

experience for the audience. You must have heard the terms “setting the convergence” 

or making an object “the point of convergence.” This really means to set the object on 

the screen plane with zero parallax. 

3.3 Viewing Stereo 

Once you have the left and right eye views, the next challenge is to project the correct 

view to each eye in such a way that the other eye does not see it. One of the oldest, 

cheapest, and poorest-quality methods is “anaglyph”—the old red and blue (cyan, really) 
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glasses, as shown in Figure 3.5. If you have a pair of anaglyph glasses, it would be a 

good time to get them out and try them on the stereo image. Anaglyph suffers from a 

number of deficiencies. Color purity and brightness are reduced, and with high contrast 

images there will be “ghosting” where one eye’s view “leaks” into the other eye. 

 

Fig. 3.5 Anaglyph glasses 

When you watch a 3D movie in theater, the technology is polarized light and glasses, 

Which is known as “passive “glasses, since they are not required any electronics. It is 

inexpensive, but the quality is much better than anaglyph glasses. These glasses also 

have drawback of reduce brightness, due to polarize filter. For a workstation, “active” 

glasses are used. These glasses have LCD shutters synced to the monitor. Since active 

glasses are electronic accessories, they are expensive, costing well over 100$ per pair. 

  

Fig. 3.6 (a) & (b) Active and passive 3D glass 

3.4 Stereo Conversion 

In this process, we convert 2D movie in stereo 3D film by using difficult post-production 

workflow. In stereo conversion, massive amount of roto work required. For this reason, 

most stereo conversion is being done largely in India. Even if the stereo conversion is 

performed in the USA, its roto work is done mostly out of the country.    

Many stereo 3D movies are actually produced using the “checkerboard” method where 

some scenes are shot in stereo and others are converted to stereo in post-production. 

Each approach, shooting in stereo and converting to stereo, has its advantages and 

drawbacks. So the decision is made scene by scene as to which method to use and they 

are inter-cut in the final movie. The big advantage of stereo conversion is that, it is 

possible to set the stereo depth and convergence of each shot for best artistic results 

since its stereo is being constructed from scratch. 

Doing a stereo conversion on a feature film is a non-trivial project, and not just from 

the labor standpoint. There are definite technical issues to address as well as a variety 

of artistic issues to get right. In this section we will take a close look at the entire stereo 

conversion process. 
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Fig. 3.7 Stereo workflow Courtesy-Author 

In the workflow given in Figure 3.7, you can observe that stereo conversion process 

can be divided in three major steps. 

• Stereo roto – where we separate the foreground and background. 

• Depth map creation – In this steps, we create displacement map, by using roto 

shapes. 

• Stereo conversion – Here, we convert 2D object in 3D by using displacement map. 

Know More… 

Displacement Map – It uses black and white color to represent distance/depth in 

an image. Anything that is close to the camera will be represented by white and 

thing which is in distance from the camera is represented by black. (Figure 3.8 (a) 

& (b). 

 
Fig. 3.8 (a) Original image 

Courtesy-medium.com 

 
Fig. 3.8 (b) Displacement 

map 
 

So first, we will try to use this stereo conversion technique in a still image, which help 

us to understand the process of stereo conversion. For this complete process two 

software are used namely Adobe Photoshop© for creating displacement map and Adobe 

after Effects© to utilize displacement map for stereo conversion. 

Let us demonstrate it in the Practical Activity 3.1. 

Practical Activity 3.1 – Create displacement map for an image. 

Step 1. Import image in the software Adobe Photoshop CC 2019. 

Step 2. Create a new layer and fill it from black. Keep the black opacity 50% as shown 

in Figure 3.9. 
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Fig. 3.9 Create new layer and fill it with black Courtesy-Author 

Step 3. Select brush tool from toolbar and keep opacity of the brush around 20% as 

shown in Figure 3.10. 

 

Fig. 3.10 brush tool and its toolbar Courtesy-Author 

Step 4. You can adjust the size of the brush by right clicking on canvas. The control of 

the brush is shown in to Figure 3.11. 

 

Fig. 3.11 Brush control Courtesy-Author 

Step 5. Select the white colour in foreground and paint it over the girl as shown in 

Figure 3.12. 

 

Fig. 3.12 Paint white colour over object Courtesy-Author 
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Step 6. Use the brush again in front hair, so that it can become whiter than others. 

Increase the opacity of black layer to see the progress in depth map as shown in Figure 

3.13. 

  

Fig. 3.13 (a) & (b) Impact of brush on layer Courtesy-Author 

Step 7. Now decrease the size of the brush by right clicking on it, and use the brush 

again over nose, eyes, lips and eyebrow as shown in Figure 3.14. 

 

Fig. 3.14 Use the brush again over nose, eyes, lips and eyebrow Courtesy-Author 

Step 8. Now, finally use the brush again over nose then keep layer opacity 100% and 

observe displacement map as shown in Figure 3.15. 

  

Fig. 3.15 (a) & (b) Use the brush over nose Courtesy-Author 

Step 9. Save the file in .PNG format in Photoshop. 

This in this Practical Activity 3.1, we have created displacement map with the help of 

Adobe Photoshop. Now, we will use it, to create stereo image in Adobe after Effect in the 

Practical Activity 3.2. 
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Practical Activity 3.2 – Utilize displacement map for creating stereo image in 

Adobe after Effects. 

Step 1. Open Adobe After Effects software and import both image and displacement 

image as shown in Figure 3.16. 

 

Fig. 3.16 Import the images into After Effects Courtesy-Author 

Step 2. Right click on displaced image and create new composition from selection as 

shown in Figure 3.17. 

 

Fig. 3.17 Pre-compose the selected image Courtesy-Author 

Step 3. Now, displacement Comp is created as shown in Figure 3.18. 

 

Fig. 3.18 Comp is created Courtesy-Author 

Step 4. Repeat the steps, to create girl image comp as shown in Figure 3.19. 

 

Fig. 3.19 Girl image comp Courtesy-Author 

Step 5. Now, insert displacement map comp above girl image in timeline and disable 

displacement map, as shown in the Figure 3.20. 
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Fig. 3.20 Insert displacement comp over girl image in timeline Courtesy-Author 

Step 6. Search displacement map in effect and preset window as shown in Figure 3.21. 

 

Fig. 3.21 Search displacement map filter Courtesy-Author 

Step 7. Apply it over the girl image, as shown in Figure 3.22. 

 

Fig. 3.22 Apply the filter in girl image Courtesy-Author 

Step 8. In effect control window, select displacement map image as a displacement layer 

as shown in Figure 3.23. 

 

Fig. 3.23 Select displacement layer Courtesy-Author 

Step 9. Keep the rest of the setting, as shown in Figure 3.24. 
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Fig. 3.24 Displacement map setting Courtesy-Author 

Step 10. Now change the setting of horizontal and vertical displacement and observe 

this image in stereo more easily. 

So, now you have some idea about stereo conversion. But, you might be thinking about 

the use of roto in stereoscopic conversion process, because it is mentioned earlier but 

not used yet, in stereo image conversion. So let’s discuss about the first step of stereo 

conversion. 

3.5 Stereo Roto 

Basically it is the rotoscoping technique. However here you require rotoscoping in detail 

as shown in Figure 3.25 for instance. If you are rotoscoping any human face then during 

rotoscoping, your focus will be on outside edges of the face like ears, chin, neck. But in 

case of stereo roto, you need to isolate each part of the face separately like eyes, 

eyebrows, lips, ears, chins, hairs, neck and many more. 

A depth isolation of different part is required to send these shape to stereo conversion 

department, who create z-depth or we can say displacement map from this stereo roto. 

and later displacement map is used in stereo conversion. 

 

Fig. 3.25 Stereo Roto of the face Courtesy-Author 

Practical Activity 3.3 – Create stereo roto of the person. 

Step 1. Create a project in SilhouetteFX©v7.5, import image sequence. Creates session 

and insert roto node between source and output as shown in Figure 3.26. 
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Fig. 3.26 Create a session Courtesy-Author 

Step 2. Now playback the image sequence and evaluate the depth into face as shown 

in Figure 3.27, like nose is situated in front while eye is slightly in depth than cheek. In 

this way, you can separate different object into the face. 

 

Fig. 3.27 Evaluate the depth in a face Courtesy-Author 

Step 3. First, we will roto the nose by using Bezier spline tool as shown in Figure 3.28. 

 

Fig. 3.28 Roto the nose by using Bezier tool Courtesy-Author 

Step 4. Rename the object whenever you create any shape as shown in Figure 3.29. It 

helps the stereo conversion team to find out the object easily. 

 

Fig. 3.29 Rename the shape Courtesy-Author 
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Step 5. After creating the shape, you can use tracker to follow the object path. This 

time, we will select planar tracker, as shown in Figure 3.30. 

 

Fig. 3.30 Use planar tracker Courtesy-Author 

Step 6. Click on tracker icon shown in Figure 3.31 in roto tool panel. 

 

Fig. 3.31 Tracker icon 

Step 7. Tracker will applicable over any layer. So first create a layer and keep the shape 

into it. 

 

Fig. 3.32 Create a new layer and put the shape into it Courtesy-Author 

Step 8. Once the layer is selected, click on tracking option into planer tracker tab as 

shown in Figure 3.33. 

 

Fig. 3.33 Apply planar tracker over selected layer Courtesy-Author 

Step 9. If tracker is not up to mark, then you can also use manual tracking option, as 

shown in Figure 3.34. 
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Fig. 3.34 Manual tracking  Courtesy-Author 

Step 10. After rotoscoping nose, create shape for lips as shown in Figure 3.35. 

 

 

Fig. 3.35 (a) & (b) Create upper lips shape Courtesy-Author 

Step 3. Now, both eyes are rotoscoped by using Bezier tool as shown in Figure 3.36. 

 

Fig. 3.36 Rotoscoping eyes Courtesy-Author 

Step 12. Always check the object list and manage it as shown in Figure 3.37. Keep the 

shape under same group. 

 

Fig. 3.37 Manage object list Courtesy-Author 

Step 13. For tracking right eye, select mocha tracker as shown in Figure 3.38. It gives 

more accurate tracking than other tracker. 
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Fig. 3.38 Use mocha tracker for right eye tracking Courtesy-Author 

Step 14. By using Bezier tool, the shape of eyes, eyebrows, cheek, lips are formed as 

shown in Figure 3.39. 

 

Fig. 3.39 Different shapes of face are isolated Courtesy-Author 

Step 15. Keep the shape under familiar group as shown in Figure 3.40. 

 

Fig. 3.40 Keep the shape in familiar group Courtesy-Author 

Step 16. Once the major shapes have been created, you need to create base shape 

around the face as shown in Figure 3.41. It will cover the blank spaces of all shapes. 

 

Fig. 3.41 Create base shape around the face Courtesy-Author 

Step 17. Now, watch the complete view of face as shown in Figure 3.42. 
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Fig. 3.42 Complete view of the face Courtesy-Author 

Step 18. Following the above steps completed the stereo roto of the person as shown in 

Figure 3.43. 

 

Fig. 3.43 Stereo roto of the person Courtesy-Author 

Step19. Press A in keyboard for alpha view as shown in Figure 3.44. 

 

Fig. 3.44 Alpha view Courtesy-Author 

Step 20. Arrange the all layer and shapes carefully, as shown in Figure 3.45. 
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Fig. 3.45 Manage different shapes in object list Courtesy-Author 

After stereo roto, you need to send these shapes to stereo conversion department, which 

creates depth map/displacement map by using these shapes into Nuke, After Effects 

software. Displacement map is a similar process which is used in Adobe Photoshop for 

image 3D conversion. 

3.6 Key to good stereo conversion 

• A strong working relationship with the overall supervisors. 

• A strong relationship with the vendors, so that relevant files such as keys and 

mattes can be provided. 

• Pre-production planning is much important in visual effects work. So, it is better 

to involve stereo conversion company during this phase. 

• Time is another factor with stereo conversion because here is huge volume of 

work, ensuring the schedule allows time for roto. 

• Some other aspects of film making also affect conversion such as speed of camera 

movement, framing and staging. If you can identify the main stereo moments in 

the script and shoot in this way that, how they will be converted in stereo, then 

you can create impact on final conversion. 

• Finally, try to make a good film in stereo not a good stereo film. 

Summary 

Stereography is a technique of creating and projecting 3D movie. 

Convergence and focus work together to provide your eyes the feel of 3D object in the 

real world. 

In the positive parallax, the depth of the object will be behind, while in negative parallax 

depth will be in front of the screen and you will not see any depth in zero parallax. 

Three types of glasses are used for 3D viewing, - Anaglyph glasses, passive glasses and 

active glasses. 

In Stereo conversion, 2D movies are converted into 3D movies in postproduction. 

Stereo Roto is a rotoscoping technique, where you need to roto each part of human 

figure separately such as eyes, eyebrows, lips, ears etc. 
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CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. The term stereo commonly known as (a) 2D (b) 2.5D (c) 3D (d) 7D 

2. The term stereo is not used by (a) Cinematographer (b) Video editor (c) VFX 

artist (d) Audience 

3. The inter-pupillary distance between two eyes is (a) 1.5 inch (b) 2 inch (c) 2.5 

inch (d) 3 inch 

4. Eye creates these responses in 3D scene (a) Convergence (b) Focus (c) 

Convergence and Focus (d) Motion blur 

5. In the positive parallax position, the depth of the object will be (a) in front of the 

scene (b) behind the scene (c) on the screen plane (d) Corner of the scene 

6. When looking at an anaglyph image any objects that have no red/blue ghost 

outline are (a) zero parallax (b) Positive parallax (c) negative parallax (d) Null 

parallax 

7. In checker board method (a) Movies picturise in 2D and later converted in 

stereo (b) Some parts of the movie is picturise in 3D while some is converted in 

stereo in post-production (c) Complete movie is shooted in 3D (d) Some part of 

movie is included animation 

8. Which steps, is not included in stereo conversion (a) Stereo roto (b) Stereo audio 

conversion (c) Colour grading (d) Colour correction 

B. Fill in the blanks 

1. Today, entire movie process has been ________. 

2. Digital process has made stereo movies practical, _____and reasonably____. 

3. Stereography is based on __________. 

4. Both eyes produce two _______ view of the scene. 

5. Displacement Map uses black and white color to represent ____in an image. 

6. Passive glasses are widely used in________.    

C. True or False 

1. A digital production pipeline results in a much higher-quality movie than an all-

film process could ever be. 

2. Different digital projector is needed in cinema theatre, to watch 3D movie. 

3. Stereopsis is the reference, which is used for a stereo film from human visual 

system. 

4. In negative parallax, the depth will be inside of the screen. 

5. Displacement map can be created after stereo conversion. 

D. Short answer questioins 

1. Write the difference between 3D and stereo? 

2. What is stereography? 

3. What is stereopsis? 

4. Explain Positive, negative and zero parallex. 

5. How can you view stereo movie? 
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6. What is stereo conversion? 

7. Write major steps of stereo conversion. 

8. What is displacement map? How can it be created? 

9. What is stereo roto? Explain its utilization in stereo conversion. 

10. Write key points for good stereo conversion. 

 

Module 4. Finalizing Matte 

 

Module Overview 

 

In this module, we will discuss about some amazing tools which are used in the 

finishing stage of creating mattes. For instance, you are animating a roto shape 

and suddenly you need little adjustment in the shape and all key-frames. Here 

you can use Multi-frame tool, which helps to adjust shape in multiple key-frames. 

During human rotoscoping, you are handling lot of shapes. However, at once few 

shapes are in used while others are just increasing the numbers. At that moment, 

every time you drag this unused shape out from the screen. Here opacity controls 

allow you to disable these unused shapes to keep their opacity zero. 

Further in this unit, you will understand the techniques of rendering and 

exporting shapes. We will also focus on, exporting/importing mattes between 

compositing software like Adobe After Effects and editing software Adobe 

Premiere. 

It is important to understand the synchronisation between various departments 

before beginning a career as a roto-artist. At the end, we will discuss about various 

departments like CGI, VFX, SFX and FX with their interconnections. We will also 

compare between most popular software used by these departments. 

 

Learning Outcomes 

 

After completing this module, you will be able to: 

• Describe the learn the final steps and best practices for completing and refining 

rotoscoping work. 

• Understand how to render and export shapes from rotoscoping projects for use in 

various applications. 

• Familiarize yourself with setting up an efficient and organized work environment 

for rotoscoping tasks. 
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Module Structure 

Session 1: Finishing the Rotoscoping 

Session 2: Rendering and Exporting Shapes  

Session 3. Rotoscoping Work Environment 

Session 1. Finishing the Rotoscoping 

 

Rotoscoping technique allows VFX artist to correct the things in post-production. 

Although it is time consuming, but its result is really amazing. It is the same techniques 

which are used by the Fleischer and Disney studios. Here you find some amazing tools 

in digital rotoscoping that helps to accelerate your work. We are discussing about the 

finishing the rotoscoping. In this chapter, you will understand the techniques like multi-

frame, extracting the tracking data from the shapes and opacity control in the timeline. 

1.1 Create a shape and track it 

Although you have learned it in previous chapters, it is a kind of link, which will help 

you to reveal a magical ‘multi-frame’ tool. 

Practical Activity 1.1 – Import a video clip into the SilhouetteFX© software and 

animate it by point tracker. 

Step 1. Insert the roto node between source and output, as shown in Figure 1.1. 

 

Fig. 1.1 Insert roto node Courtesy-Author 

Step 2. Create two shapes for iris and pupil by using circle shape, as shown in Figure 

1.2 (a). 
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Fig. 1.2 (a) Shapes of Iris and Pupil Fig. 1.2 (b) Object list 

Step 3. Select pupil in object list, its controls will be shown on object window (Figure 

1.3 (a)). In this window, choose subtract in blend mode. It will remove the inner circle 

from selection. 

 
Fig. 1.3 (a) Object window 

 
Fig. 1.3 (b) Overlay View 

Step 4. Now animate the shapes created according the eye movement. For this you need 

tracker. Before start tracking, create a layer and put these shapes on it, because 

trackers work on layer. 

 

Fig. 1.4 Layer is created Courtesy-Author 

Step 5. Use the tracker tool point tracker as shown in Figure 1.5 in roto node to create 

motion path of video. 

 

Fig. 1.5 Point Tracker tab Courtesy-Author 

Step 6. Select the frame on viewer and click on create button on point tracker tab. A 

tracker will be appeared on viewer and object list as shown in Figure 1.6. 
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Fig. 1.6 tracker Courtesy-Author 

Step 7. You need to place the tracker on the spot which has highest contrast. Use the 

pre-processing controls to find that spot. Make sure that preview is on in pre-

processing tab. 

 
Fig. 1.7 (a) Pre-processing 

Controls 

 
Fig. 1.7 (b) Effect of Pre-processing on viewer 

Step 8. You have got tracking spot. Now you can disable preview in pre-processing 

window and start backward/forward tracking by pressing controls on point tracking 

tab as shown in Figure 1.8. 

 

Fig. 1.8 Tracking controls 

Step 9. You can watch the tracking path in the Figure 1.9. 

 

Fig. 1.9 Tracking Path Courtesy-Author 

Step 10. Go to the first point on timeline, from where tracker started then click on 

Apply button on point tracker. A match move dialog box opens. Select your priorities 

and click on OK button. 
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Fig. 1.10 (a) Frame in which 

tracking started Courtesy-Author 

 
Fig. 1.10 (b) Match move dialog box 

Step 11. Now tracker is applied on the layer. You can check shape movement by 

playback video on viewer. 

 

1st Frame    10th  Frame   20th Frame 

 

50st Frame    100th Frame   210th Frame 

Fig. 1.11 Shape movement in different frames Courtesy-Author 

Step 1. In above pictures, shapes are in red and green outline. Observe that shapes are 

not changing place from 1st to 210th frame. This is because of tracker. 

Step 13. You can adjust shapes by changing it at any points. It will create key frames. 

 

Fig. 1.12 Key-frame is created while adjusting shapes Courtesy-Author 

Now you have animated shapes. You can observe that there is a need of adjustment on 

pupil’s shape. We are also forgetting to give some feather in the corner. Here you can 

utilize multi-frame tool. 
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Fig. 1.13 different shapes Courtesy-Author 

1.2 Multi-frame tool 

Suppose you have created shapes for an object to perform rotoscoping. You have 

transformed it in halfway. Suddenly you feel that you need some adjustment in basic 

shapes. What you will do now? To adjust the shape on every key frame will take lot of 

time. Here you can use Multi frame. 

Normally, adjusting a shape or points on a shape creates key frame only on that 

particular frame. When Multi Frame is activated, it modifies the Transform and Reshape 

tools to make adjustments across all previously set key frames or a selection of key 

frames. A red outline is drawn around the Viewer to know that Multi-frame is active. 

 

Fig. 1.14 Multi-frame Tool Courtesy-Author 

 

Fig. 1.15 Multi-frame range bar Courtesy-Author 

To use Multi-Frame, select it from the Toolbar. Then, drag the red ends of the Multi-

Frame range bar at the top of the Timeline to limit the key frames affected by Multi-

Frame. 

Practical Activity 2 – Adjusts eye’s shape by using Multi-frame tool. 

Step 1. Activate multi-frame tab by clicking on its icon. 

Step 2. Change multi-frame range as required. It displays in red colour on timeline as 

shown in Figure 1.16. 
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Fig. 1.16 Multi-frame Range 

Step 3. Now you can transform any frame within multi-frame range. In Figure 1.17 (a) 

and (b), you can observe modification in shapes and use of feather. 

 
Fig. 1.17 (a) Frame 

before transform 

Courtesy-Author 

 
Fig. 1.17 (b) 

Frame after 

transform 

Step 4. Once you transform a single frame it will be applied on the all frames in multi-

frame range. So, you can use multi-frame tool to modify all the shapes at once in the 

selected range. 

1.3 Extracting tracker from the shape 

In Practical Activity 1.1, we have created tracker for layer-1. Now to create another 

shape, how will you track it? Are you going to create another tracker or can use the 

previous tracker?  In this situation, you can use previous tracker. Let’s understand the 

process. 

Practical Activity 1.3 – Demonstrate to Extract the tracker and use it over another 

layer. 

Step 1. Create another shape on the viewer by using Bezier tool as shown in Figure 

1.18. 

 

Fig. 1.18 Shape is created on viewer Courtesy-Author 

Step 2. The shape is automatically created in layer-1 as shown in Figure 1.19. 

 

Fig. 1.19 Shape is showing on object list Courtesy-Author 

Step 3. Playback the frames and observe that this shape is already animating. It 

happened because of tracker as shown in Figure 1.20. 
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1st Frame 

 
100th Frame 

 
200th Frame 

Fig. 1.20 Shape movement in different frames Courtesy-Author 

Step 4. In previous situation, shape is already placed in the same layer which is affected 

by tracker. But you cannot place all the shapes in a single layer. You have to create 

different shapes for breaking the object into the shapes. So we will cut ‘Bezier’ shape 

and place it in different layer as shown in Figure 1.21. 

 

Fig. 1.21 Bezier shape is placed in new layer Courtesy-Author 

Step 5. Playback the frames and observe that Bezier shape is not moving because it has 

been separated from tracker as shown in Figure 1.22. 

 

Fig. 1.22 Bezier shape is separated Courtesy-Author 

Step 6. Now, we will copy tracker and paste it over the layer-1 as shown in Figure 1.23. 

 

Fig. 1.23 Tracker is placed over layer-1 Courtesy-Author 

Step 7. Enable tracker tool on toolbar and click apply button on tracker tab as shown 

in Figure 1.24. 

 

Fig. 1.24 (a) Tracker icon 
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Fig. 1.24 (b) Click on apply button Courtesy-Author 

Step 8. Now Bezier shape is animated according to the copied tracker. You can watch 

these frames as shown in Figure 1.25. 

 
1st Frame 

 
100th Frame 

 
200th Frame 

Fig. 1.25 Shape is animated according to tracker Courtesy-Author 

It is clear that how you can use a single tracker multiple times in different shape. It will 

save your time and also helps in animating the shapes. Keep in mind, this technique 

works well if the shapes have similar movement otherwise it will not animate shapes 

perfectly. 

1.4 Opacity control in timeline 

Opacity means transparency of the shapes. Like if a shape is opaque, it means its 

opacity is 0% and if a shape is fully transparent then its opacity is 100%. 

A question may arise that in rotoscoping, we need to breakdown object in different 

shapes and animate it according to object movement. Then why this opacity control is 

required. 

Recall the Chapter 11 of human roto, where you have dealt with many shapes. You have 

to carry these shapes even they don’t have any use in between. It was really irritating 

to see these unwanted shapes in roto frame because it makes the rotoscoping 

complicated. 

To overcome this problem, there are two possible ways. 

Drag the unused shape outside the viewer/screen. 

Keep the opacity at 0% till these shapes have no use. 

Let us understand it with an activity. 

Here is a face roto of a person, your task is to hide both ear’s shape which is showing 

in the green colour in the Figure 1.26. When they are not placed in the outer edge or 

you can say when they don’t have any use. 

 

Fig. 1.26 Face Roto of the Person Courtesy-Author 

In the Figure 1.26, you are watching the 9th frame of the video. Now we will move in the 

first frame and the last frame which is 24th frame to observe the ear position. 
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Fig. 1.27 (a) First Frame 

 
Fig.1.27 (b) Last Frame 

If you compare first and last frame, then you will find that, 

1. In the first frame, left ear is not visible so its shape is useless at this frame. 

2. In the last frame, right ear is not visible so its shape is also useless here. 

Now you can understand, these shapes are really irritating when they don’t have any 

use in particular frame. So, you need to remove these shapes from the frame as 

mentioned in earlier techniques. 

First follow, 

Method 1 

Drag the unused shape outside the viewer. 

Step 1. Go to the 9th frame and move towards first frame. Find-out the frame in which, 

left ear is not visible. 

Step 2. You will find 6th frame when the left ear is not visible on viewer. It means you 

can throw out this shape from the frame. It doesn’t mean that you need to delete this 

shape as shown in figure 1.28. We will bring this shape back when the ear will visible 

on the upcoming frame. 

 

Fig. 1.28 Left ears is not visible in 6th frame Courtesy-Author 

Step 3. Now select Transform tool from the toolbar and drag this shape outside the 

frame as shown in Figure 1.29. 
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Fig. 1.29 Drag left ear’s shape outside the frame Courtesy-Author 

Step 4. By the same process you can hide right ear’s shape from 10th frame. When right 

ear is invisible from the frame. 

 
Fig. 1.30 (a) Drag right ear’s 

shape 

 
Fig. 1.30 (b) Key-frame position of shape outside 

the frame 

Step 5. You can bring back the shape by same way but remember to insert a key frame 

before bringing back the shape so that it will take only 2 frames to comeback. 

 
Fig. 1.31 (a) Frame before shape 

back 

 
Fig.1.31 (b) Position key-frame 

 
Fig. 1.32 (a) Shape return on 

viewer 

 
Fig. 1.32 (b) Relative key frame 
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You have learned first method to get rid of useless or idle shapes. Now we will use second 

method to solve this problem. 

Method 2 

Keep the opacity at 0% till these shapes have no use. 

In this method, you need to control the opacity of the shape. It is a useful method which 

helps you to understand the importance of timeline. 

Step 1. We will delete those position key-frame and keep the frame in earlier position 

as shown in Figure 1.33. 

 
Fig. 1.33 (a) First Frame 

 
Fig. 1.33 (b) Last Frame 

Step 2. Again if we observe 8th frame, then you can find that both the ears are visible. 

From this point if we move backward then left ear will be invisible and if move forward 

then right ear will be invisible, as shown in Figure 1.33 (b). 

 

Fig. 1.34 8th frame 

Step 3. First, we will move backward from 8th frame and find out when the left ear is 

invisible from the frame. It’s the 6th frame shown in Figure 1.35. 

 

Fig. 1.35 6th frame 

Step 4. Now select the transform tool and click on the left ear’s shape. Its control is 

displayed on object window as shown in Figure 1.36 (a) & (b). 
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Fig. 1.36 (a) Transform tool on 

left ear 

 
Fig. 1.36 (b) Left 

ear shape’s control 

Step 5. Click on the opacity control timer on object window. You can see that opacity 

control is added in timeline under the left ear as shown in Figure 1.37. 

 
Fig. 1.37 (a) Opacity control timer 

 
Fig. 1.37 (b) Opacity control in 

timeline 

Step 6. In this frame, change the opacity value to 0. Observe a key frame on timeline 

as we change the opacity value.   

 
Fig. 1.38 (a) Opacity value is changed    

 
   Fig. 1.38 (a) Opacity key-

frame 

Step 7. Now deselect all the shape from the object list and play the video frames 

backward now ear’s shape is invisible from 6th frame backward. 

 
7th Frame 

 
6th Frame 

 
1st Frame 

Fig. 1.39 Opacity key-frame 

Step 8. Just think that how can you watch these shapes even in zero opacity. You just 

need to click on shape name as shown in Figure 1.40 (a) and your shape will visible on 

viewer panel. 
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Fig. 1.40 (a) Click on shape name 

 

Fig. 1.40 (b) Shape is visible on viewer’s panel 

Step 9. To bring back these shapes on viewer for roto then change its opacity value 

100%. 

So now you have learn the techniques like multi-frame, tracking extraction from shapes 

and opacity control. 

Summary 

You can make adjustment on multiple frames at once by using Multi-frame tool. 

You can use single tracker in multiple times in different shapes. 

To remove unused shape from viewer panel, either drag it out from the Viewer panel or 

Keep the shape's opacity to zero, until the shape is in use. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Place the tracker on the spot, which has highest______ (a) Brightness (b) 

Sharpness (c) Contrast (d) Noise 

2. You can do backward/forward tracking in (a) Pre-processing control (b) I/O tab 

(c) Point tracker tab (d) Multi-frame 

3. Which of the following is drawn around the Viewer to know that Multi-frame is 

active (a) Green outline (b) Red outline (c) Yellow Outline (d) Blue Outline 

4. Which of the following is applied in multi-frame tool, once you transform a single 

frame (a) All backward frame in multi-frame range (b) All forward frame in multi-

frame range (c) All frames in multi-frame range (d) On single frame 

5. You can copy tracker and paste it over the______ (a) Shape (b) Layer (c) Object (d) 

Shape and layer 

6. Opacity means________ of the shape (a) Colour value (b) Brightness (c) 

Transparency (d) Saturation 

7. If a shape is opaque, it means opacity is (a) 0% (b) 50% (c) 75% (d) 100% 

B. Fill in the blanks 

1. After tracking, you can check Shape movement by_______ the video on Viewer. 

2. When you adjust shapes, it creates ________ on timeline. 

3. Multi-frame allows you to make adjustments across_____________. 

4. You can use a single tracker ______time in different shapes. 
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5. During human rotoscoping, keep the opacity_____ percent until the shape is in 

use. 

C. True or False 

1. Drag the red ends of the Multi-Frame range bar at the bottom of the             

timeline to limit the key frames affected by Multi-Frame. 

2. If you want to modify shape in multiple frames then you need to use     Multi-

frame. 

3. Opacity control has the ability to hide the shape, which helps you to            focus 

on important shapes.         

D. Short answer questions 

1. What is Multi-frame tool? 

2. How can you use multi-frame tool? 

3. Write the process of extracting tracker from any shape. 

4. What is opacity control? 

5. Why we need opacity controls during animating shapes?    

 

Session 2: Rendering and Exporting Shapes 

Till now we have performed rotoscoping of different objects such as organic and 

inorganic objects. We have also learned the techniques about wire and rig removal. But 

we have never discussed about the final output. In this chapter, you will understand 

the techniques of rendering the mattes and rendering setting. How can you use these 

mattes in compositing software Adobe After Effects and editing software Adobe Premiere. 

You will also learn to import and export shapes from SilhouetteFX© and utilization of 

shapes in compositing shapes. 

2.1 Rendering 

Rendering is a process that involves the generation of a two-dimensional or three-

dimensional image from a model by using application programs. Rendering is mostly 

used in architectural structures, computer games and animation films, simulators, TV 

special effects and design visualisation. The methods and features used may differ 

depending on the project. Rendering aims to improve productivity and reduce design 

costs. 

After completing the work in Silhouette©, you need to render the final result. Do you 

remember the boat which we have used in earlier session? Now it is the time to get the 

final output from the boat as shown in Figure 2.1. First, we will quickly watch the project 

again, so that you can remind it easily. 
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Fig. 2.1 SilhouetteFX© Project Courtesy-Author 

Let us demonstrate to render the shapes in Practical Activity 2.1. 

Practical Activity 2.1 – Render the focus object. 

Step 1. In the Trees window, add output nodes after the nodes to render as shown in 

Figure 2.2. If output node is already added, then click on that node on trees window. 

 

Fig. 2.2 Add Output Node in Tree Window Courtesy-Author 

Step 2. In the Output node, set the file format type. The format setting allows you to 

select from various file formats. You can save the file in the various file formats such as 

– Cineon, DPX, TIFF, JPG, Open EXR, PNG, SGI, TIFF and Targa as shown in Figure 

2.3. 

 

Fig. 2.3 Select File Format Courtesy-Author 

Step 3. Enter the path and file name for the rendered file in the File field. For this, click 

the Browse icon on the right, as shown in Figure 2.4 

 

Fig. 2.4 Enter the Path and File Name Courtesy-Author 

As far as file naming is concerned, you only have to type in a name as periods, hash 

marks for padding, as shown in Figure 2.5. Here, file extensions are not required unless 

you want to manually enter them. For example, if you choose to manually enter the file 

padding and extension, the filename should have 3 things: 

• The image name 

1. # for the frame placeholder. 
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2. An extension: .exr = exr files, .cin = Cineon files, .tif = Tiff files, etc. 

Therefore, if you enter a name something like test.####.exr, SilhouetteFX© will render 

out test.0001.exr, test.0002.exr, etc. 

 

Fig. 2.5 File Padding and Extension Courtesy-Author 

Step 4. You can confirm how the files will be formatted by looking it on output node 

sample field, as shown in the Figure 2.6 

 

Fig. 2.6 Output node sample field Courtesy-Author 

Step 5. Choose the appropriate channels to render. You can choose from RGB, Alpha 

and Depth, as shown in the Figure 2.7. 

 

Fig. 2.7 Different channels Courtesy-Author 

Step 6. If you are rendering stereo project, select whether you want to render the Left, 

Right or Both. The Left and Right Views are simultaneously using the Views popup 

menu. 

 

Fig. 2.8 Stereo View setting Courtesy-Author 

Step 7. After all these selection and settings, go to Session > Render Session or press 

Ctrl+R. 

Step 8. The Render Options window opens as shown in Figure 2.9. 

 

Fig. 2.9 Render Options Courtesy-Author 

Step 9. Choose whether to render All Output Nodes or just the Selected Output Nodes 

as shown in Figure 2.10. If you choose selected output node then it needs to be 

selected for working the option. 
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Fig. 2.10 Render Options Courtesy-Author 

Step 10. Select all frames from the Range option to render as shown in Figure 2.11. 

 

Fig. 2.11 Range Selection Courtesy-Author 

Step 11. Enable Preview and select Render as shown in Figure 2.12. 

 

Fig. 2.12 Rendering in progress Courtesy-Author 

Step 12. After the completion of rendering, File will be saved on destination folder. 

More to know 

You can utilize some other option while perform rendering. For this select Action> 

Render; here you will get these three option- 

• Layers to Separate Files – Renders layers to separate files. 

1. Shapes to File Tree – Renders all shapes in the selected Roto node, each to 

its own file, organized by folders based on layer names. 

2. Shapes to Separate Files – Renders shapes to separate files. 

2.2 Utilization of matte in After Effects 

Once the work is completed the role of compositor begins. But it is important for a Roto-

Artist to understand the further process. You may be curious about how these shapes 

helps compositor in compositing. So let’s learn this process through Practical Activity 

2.2. 

Practical Activity 2.2 – Import shapes in After Effects and use it for compositing. 

Step 1. Create a new project in Adobe After Effects as shown in Figure 2.13. 
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Fig. 2.13 Create a Project in Adobe After Effects software Courtesy-Author 

Step 2. Import the shape in and insert it in timeline as shown in Figure 2.14. Don’t 

forget to import original video layer whence the object is extracted. 

 

Fig. 2.14 Import the shapes Courtesy-Author 

Step 3. You need to import another object for background. Import a video or Image and 

insert it in timeline as shown in Figure 2.15. So far you have not seen any change in 

composition. 

 

Fig. 2.15 Background layer place in bottom Courtesy-Author 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

225 

 

Fig. 2.16 Composition after inserting the background layer Courtesy-Author 

Step 4. Now open the track matte option on original video footage as shown in Figure 

2.17. 

 

Fig. 2.17 Track matte Option Courtesy-Author 

Steps 5. Observe the Figure 2.18, there are four options – Alpha Matte, Alpha Inverted 

Matte, Luma Matte and Luma Inverted Matte. You need to select Alpha Matte. 

 

Fig. 2.18 Select Alpha matte in track matte option Courtesy-Author 

Step 6. Now you can see that boat is extracted from the video and inserted over the 

background layer as shown in Figure 2.19. 

 

Fig. 2.19 Composite frame Courtesy-Author 

Step 7. You need to compose both objects in such manner so that it will look natural. 

Here is the final frame shown in Figure 2.20. 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

226 

 

Fig. 2.20 Final composition Courtesy-Author 

2.3 Export/Import shapes from SilhouetteFX© 

Silhouette can export and import shapes for different softwares like After Effects, Elastic 

Reality, Fusion, gMask (Combustion, Flint,  Flame, Inferno), Nuke and Shake 4.x SSF. 

As we are using two software which is Adobe After Effects© and SilhouetteFX©. 

Therefore we will export and import shapes between these software. If compositor wants 

shape for different software which is mentioned earlier then you can also export shapes 

for those software. 

Here are the steps which we will follow. 

• Export the shapes from SilhouetteFX© software. 

1. Import the shapes in after effects© software. 

2. Export shapes from after effects©. 

3. Import it in SilhouetteFX©. 

2.3.1 Export the shapes from Silhouette software to after effects. 

Step 1. Open the existing project in SilhouetteFX©v7.5 as shown in Figure 2.21. 

 

Fig. 2.21 Silhouette project Courtesy-Author 

Step 2. Select the shapes from object list to export as shown in Figure 2.22. 
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Fig. 2.22 Selection of shapes in Object List Courtesy-Author 

Step 3. Choose File > Export and select the shape format to export as shown in 

Figure 2.23. 

To export to After Effects masks, use the Silhouette Shapes option. The Silhouette Shape 

Import/Export Plug-in is then required to import Silhouette Shapes into After Effects. 

 

Fig. 2.23 Different Export Options Courtesy-Author 

Step 4. When the file browser opens, type a name and click OK to save the file as 

shown in Figure 2.24. 

 

Fig. 2.24 File Browser Courtesy-Author 

Step 5. File saves in .fxs format as shown in Figure 2.25. 

 

Fig. 2.25 File Format 

2.3.2 Import the shapes in After Effects 

The SilhouetteFX© Shape Import/Export Plug-in for Adobe After Effects© is required to 

Import Silhouette Shapes and convert them to Adobe After Effects© masks. 
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When importing Silhouette Shapes, the shape parameters transfer into After Effects© 

such as, opacity, blur, shape color, shape name, invert and locked states, transfer mode 

and per-shape motion blur state. 

Practical Activity 2.3 – Import the Silhouette’s exported shapes in Adobe After 

Effects© 

Step 1. Start Adobe After Effects©. Open a project and select a layer in the Timeline as 

shown in Figure 2.26. 

 

Fig. 2.26 Select a layer in Adobe After Effects© Timeline Courtesy-Author 

Step 2. From the After Effects File menu, select Import > Silhouette Shapes. A file 

browser opens as shown in Figure 2.27. Select the shape file to import and click OK. 

 

Fig. 2.27 Select the Shape file from File browser Courtesy-Author 

Step 3. Shapes are imported in a form of mask. You can see them in composition 

panel and timeline. 
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Fig. 2.28 Composition Panel and Timeline Courtesy-Author 

Step 4. Now you can modify individual mask of object. 

More to Know 

When importing and exporting Silhouette© Shapes in After Effects©, the general rule 

is that the After Effects composition size must match the Silhouette session size for 

shapes to import and export properly. However, as long as the ratio of the sizes 

between the After Effects composition and the Silhouette session match, you can 

successfully import and export shapes between them. For instance, you could import 

or export shapes from a 2000 × 1000 Silhouette session to a 1000 × 500. After Effects 

composition with no problems, as long as the pixel aspects were the same. 

2.3.3 Export shapes from After Effects© 

When exporting After Effects masks, the following shape parameters transfer into 

Silhouette: opacity, blur, shape color, shape name, invert and locked states, transfer 

mode and per-shape motion blur state. 

Practical Activity 2.4 – Export Adobe after Effects© shapes 

Step 1. Start Adobe After Effects©, open a project and select a layer in the Timeline 

that contains After Effects masks as shown in Figure 2.29. 

 

Fig. 2.29 Selected layer in the timeline which has different masks Courtesy-

Author 

Step 2. From the After Effects File menu, choose Export > Silhouette 5+ Shapes. A 

file browser opens. Type a name and press OK to save the file as shown in Figure 2.30. 
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Fig. 2.30 Exporting masks in silhouette shapes 

Step 3. All After Effects masks from the selected layer are exported and a file is saved 

with an .fxs file extension. 

2.3.4 Import After Effects© shapes in Silhouette 

Silhouette, After Effects, Commotion, Elastic Reality and Shake 4.x SSF 

Shapes can be imported into SilhouetteFX©. 

Step 1. Select roto node in the Session as shown in Figure 2.31. 

 

Fig. 2.31 Roto Node Courtesy-Author 

Step 2. Choose File > Import and select the shape format that you would like to import 

as shown in Figure 2.32. 

 

Fig. 2.32 Select the shape format for import Courtesy-Author 

Step 3. A file browser opens. To import, select the shape file and click on Open button 

as shown in Figure 2.33. 

 

Fig. 2.33 Select the shape file Courtesy-Author 

Step 4. The shapes are added to the current session as shown in Figure 2.34. 
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Fig. 2.34 Shape are added in object list Courtesy-Author 

More to Know – When you import after effects masks in silhouette© shapes then you 

cannot import its feather. So whenever you export shapes for silhouette©, edge 

feather need to be added in silhouette software later. 

2.4 Rendering shapes to channels 

Shapes can be assigned to different channels when rendering. Let us demonstreate to 

export the shapes in different channels in the following activity. 

Step 1. Create four shapes as shown in Figure 2.35. See these shapes in red, green, 

yellow and white outline. 

 

Fig. 2.35 Four Shapes Courtesy-Author 

Step 2. Select a shape and in the Object window, set the Channel parameter to Red. 

 
Fig.2.36 (a) Select shape-1 

 
Fig.2.36 (b) Set channel parameter 

to red Courtesy-Author 

Step 3. Assign the other three shapes as Green, Blue and Alpha. 
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Fig. 2.37 (a) Set channel parameter to Green 

 

Fig.2.37 (b) Set channel parameter to Blue 

 

Fig. 2.37 (c) Set channel parameter to Alpha 

Step 4. After assigning the shapes to different channels, you can visualize the results 

prior to rendering using View > Channels in conjunction with the Alt-R, G, B and A 

shortcut keys. Choose View > Channels, as shown in Figure 2.38. 

 

Fig. 2.38 Shapes are assigned to different channels Courtesy-Author 

Step 5. Use the Alt-R, G, B and A shortcut keys to see which shapes are assigned to 

the various channels as shown in Figure 2.39. 

 
Fig. 2.39 (a) Red 

Channel 

 
Fig. 2.39 (b) Green 

Channel 
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Fig. 2.39 (c) Green 

Channel 

 
Fig. 2.39 (d) Alpha 

Channel 

Step 6. When ready, render shapes into the assigned channels by connecting the Roto 

node’s Channels output to an Output node as shown in Figure 2.40. 

 

Fig.2.40 Connects Roto Channel output to output node Courtesy-Author 

Step 7. In the Output node, choose a file format that supports RGBA and make sure 

that RGB and Alpha are enabled in the Channels field. 

 

Fig. 2.41 Output Settings Courtesy-Author 

2.5 Rendering Shape Outlines or Color Filled Shapes 

Shapes can be outlined or filled with a color and rendered in the RGB output. 

Step 1. Create some shapes as shown in Figure 2.42. 
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Fig. 2.42 Shapes are created Courtesy-Author 

Step 2. In the Node parameters enable the color by selecting the option Color > Enable 

as shown in Figure 2.43. 

 

Fig. 2.43 Enable Colour in Node Parameter Courtesy-Author 

Step 3. Turn up the Outline Size parameter. The shape outlines will now render in the 

RGB output. To change the shape’s outline color, use the Shape > Color parameter. 

 
Fig.2.44 (a) Set Outline 

Size Courtesy-Author 

 
Fig.2.44 (b) Changes in Outline Size 

Step 4. Set the Outline Size parameter to 0 and turn up the Fill Opacity as shown in 

Figure 2.45 (a). The shapes are now filled with a color in the RGB output as shown in 

Figure 2.45 (b). 

 
Fig.2.45 (a) Set the Fill 

Opacity 

 
Fig.2.45 (b) Results of Fill Opacity 

on Viewer Courtesy-Author 
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Step 5. Select an individual shape and change the color in the Object window. Each 

shape can have its own color. 

 
Fig.2.46 (a) Select the Individual shape 

Courtesy-Author 

 
Fig. 2.46 (b) Change the 

Colour 

Step 6. It is possible to globally change the opacity using the Color > Fill Opacity node 

parameter. You can also change the opacity of each shape separately using the Shape > 

Opacity control in the Object window. 

Summary 

3D rendering is the process of a computer converting raw data from a 3D scene 

(polygons, materials, and lighting) into a final product. Typically, the output is a single 

image or a collection of photos that are rendered and combined. 

Choose the appropriate channels to render the shapes such as RGB, Alpha and Depth. 

In stereo project, choose the views (left, right, both) which you want to render. 

Use track matte option on roto footage, to composite various videos. 

Various shapes can be imported/ exported from Silhouette software to other software 

like After Effects, Elastic Reality, Fusion, gMask, Nuke and Shake. 

Silhouette shapes is exported in .fxs format. 

When importing Silhouette Shapes, the shape parameters transfer into After Effects© 

such as opacity, blur, shape color, shape name, invert and locked states, transfer mode 

and per-shape motion blur state. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Rendering is not used in (a) Architectural design (b) Video games (c) Animated 

movie (d) Video shooting 

2. Which of the following is selected in output node to export Alpha Matte (a) RGB 

(b) Alpha (c) RGB and Alpha (d) CMYK 

3. During compositing in After Effects, place the alpha matte ____the original layer 

(a) Below (b) above (c) within (d) between 

4. To export to After Effects masks, use the (a) Elastic reality shapes (b) GMask 

shapes (c) Fusion Shapes (d) Silhouette Shapes 

5. Which of the following parameter is not transfers when importing Silhouette 

shapes in After Effects (a) Opacity (b) Blur (c) Shape colour (d) Feather 

6. Which of the following is not possible to import when importing After Effects 

masks in silhouette shapes (a) Shape name (b) Blur (c) Feather (d) Shape colour 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

236 

B. Fill in the blanks 

1. After completing the work in Silhouette, you need to_____ the final result.   

2. In silhouette, select the shapes from_______ which you want to export. 

3. When you export shapes from Silhouette to After Effects, it is exported in 

_____format. 

4. In After effects, Silhouette shapes are imported in form of____. 

5. Shapes can be assigned to different_____ when rendering. 

C. True or False 

1. Rendering helps increase efficiency and reduce cost in design. 

2. When Export the shapes from Silhouette software to after effects, the file saves 

in .dpx format. 

3. After Effects composition size must match the Silhouette session size for shapes 

to import and export properly. 

4. Use the Alt-R, G, B and A shortcut keys to see which colours are assigned to the 

various channels. 

5. To change the shape’s outline color, use the Shape > Color parameter. 

D. Short answer questions 

1. What is rendering? 

2. What are the steps to rendering the shapes? 

3. What is File Padding and Extension? 

4. What is utilisation of matte after rendering? 

5. Write the steps to export the shapes from Silhouette to After Effects? 

6. How can you export the shapes from after effects to silhouette software? 

7. How can you render shapes in different channels? 

8. How can you render colour filled shapes? 

 

Session 3. Rotoscopy Work Environment 

The world of animation is open after rotoscoping. It is required in all animations and 

VFX houses. Rotoscoping is a starting point for career. One can explore his or her 

capabilities and take career further in compositor, VFX supervisor and many more. 

(Figure 3.1) In this session you will understand all about animation and visual effects 

industry, which will prepare you for the future. 

 

Fig. 3.1 Rohan is searching about Animation and VFX Career options Courtesy-

Author 
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3.1 Difference between CGI, VFX, SFX and FX 

Some abbreviations are used in the post-production field. So it is essential to 

understand some of the important terms. 

3.1.1 CGI 

It stands for Computer-Generated Imagery. It is a 3D picture prepared by using 

computer hence the name computer-generated imagery. It can be a video game, 3D 

animation, may be just a model made in computer as shown in Figure 3.2. It does not 

include the live-action shot. 

 

Fig. 3.2 3D Model of spaceship 

3.1.2 VFX 

It uses different elements so it can be 3D or 2D. These elements are integrated in live-

action shot that was filmed on set as shown in Figure 3.3. This is the basic difference 

between visual effects and CGI. 

 

Fig. 3.3 Visual Effect shots from the Movie Aladdin Courtesy- ILM 

3.1.3 SFX 

It stands for special effects. It was there before the invention of computers and 3D. All 

of these explosions, mechanical or any live effects as shown in Figure 3.4 has to be 

created on set instead of CG in post-production. 
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Fig. 3.4 (a) Mechanical Character 

Courtesy- Columbia Pictures 

 
Fig. 3.4 (b) Fire Special Effects 

Courtesy- Martin Goeres 

3.1.4 FX 

It is a same kind of special effects which is created on set. But nowadays we can create 

all the simulations fires, explosions, rain and many more using the computer. It is called 

digital effects or FX. A typical digital effects is shown in Figure 3.5. 

 

Fig. 3.5 Digital effects 

3.2 Connection between all these departments 

Digital effects (FX) can be used in CGI like a 3D video game or in visual effects like an 

integrated explosion in the shot. But it is still under the CGI. CGI can stand alone like 

a 3D animation or as a part of visual effects for example creating a background to 

replace the green-screen. (Figure 3.6) 

Special effects made on set so it is not directly connected with post production. So, it is 

separate from the group. 

 

Fig. 3.6 Connection between different departments Courtesy- Author 

If you put them in a chronological order it would be visual effects first then CGI as a 

part of visual effects and then digital effects (FX) as a part of a CGI as shown in Figure 

3.7. 
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Visual effects artist can have CGI skills. But CGI artist does not have Digital effects 

skills. CGI artists only work with 3D world. Anyone who knows how to integrate an 

element into the footage can work as visual effects artist. 

 

Fig. 3.7 Skill Connections Courtesy- Author 

3.3 Different work area 

CGI artist is different from visual effects artists. Also, a question may arise where the 

Roto artist stands? There are various areas which are closely related to each other. First, 

we will discuss about compositing, since all the work are closely connected with this. 

3.3.1 Compositing 

Compositing is combining different elements that were filmed separately or created 

separately. A typical compositing scene is shown in Figure 3.8. Combining them into 

one scene and making it look as if it was filmed in one location at the same time. 

 

Fig. 3.7 Compositing scene of movie Avengers – Infinity War Courtesy- Marvel 

Studio 

Let us overview the process of how the compositor is connected to other departments 

for receiving the files (Figure 3.9). Now different projects have got different structure and 

they might work in a different way. So before receiving any files for compositing, it sends 

to different department. Where they are cleaned and prepared for compositing later. 

 

Fig. 3.9 Different department connected with Compositor Courtesy- Author 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

240 

3.3.2 Chroma Keying 

If there is a green screen as shown in Figure 3.10 that needs to be removed in the scene. 

The shot first is being sent to the Keying Department, who removes the green screen, 

prepares the image and send it to compositor. 

 

Fig. 3.10 Chroma key Courtesy- Marvel Studio 

3.3.3 Rotoscoping 

Sometimes there are scenes without the green screen and may be the object needs to 

be cut out from the background. A rotoscoping department works in this case. They 

extract the object frame by frame from the background and send it to compositor to 

integrate it later. 

3.3.4 Retouch 

If you want to remove any minor object such as hanging wires or microphone picturised 

during shooting and if that should not be shown to the audience, it needs to be removed 

from the shot is done by the retouching personnel in that department. (Figure 3.11) 

They just paint out the objects that should not be there and then they create the clean 

shot for you without these objects. 

 

Fig. 3.11 Remove the wire Courtesy- Marvel Studio 

All these three are called Prep/Paint that stands for preparation and painting as shown 

in Figure 3.12. 

 

Fig. 3.12 Prep/Paint Courtesy- Author 



 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

241 

Basically Prep/Paint means cleaning out the shots and preparing the footage for the 

compositor. Now different projects require different elements. It needs to be integrated 

into the scene. Different departments use different skills to achieve. When the green 

screen is removed we need to replace it with something. It can be just a photo shoot 

that is filmed separately and then placed it or may be any animation or live footage as 

shown in Figure 3.13. 

 

Fig. 3.13 Shot is prepared for Compositing Courtesy- Marvel Studio 

3.3.5 Matte Painting 

Sometimes the background cannot be filmed in the way it was imagined. In such cases 

matte painting is used to digitally paint the background to look more complex for image 

and projection map. Figure 3.14 (a) shows the background before matte painting and 

Figure 3.14 (b) shows the background after matter painting. A 3D model in software 

looks very different depending on the project and the requirements. The background 

created can be export and send it to compositor for integration. 

 
Fig.3.14 (a) Before matte painting 

 
Fig.3.14 (b) After matte painting 

3.3.6 CGI 

3D elements require syncing that is where the CGI department is come. It spreads out 

further and deeper into more departments like texturing, modeling, rigging, animation, 

rendering and so on. All of these departments prepare the 3D imagery for compositor 

and they send it out in different layers as shown in Figure 3.15. Compositor needs to 

integrate and mix all these layers. 
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Fig. 3.15 Different CGI Department Courtesy- Author 

3.3.7 Motion Tracking 

If there's a complex camera motion that involves CGI objects or character or the 

background then the process also includes the motion tracking. It is accomplished by 

different departments. 

In motion tracking, the motion in live-action shot is tracked and the identical virtual 

camera is created in 3D software as shown in Figure 3.16. It allows compositor to 

integrate other elements in synchronization with the motion of the camera. 

 

Fig. 3.16 CGI element is placed in live footage 

After the footage is tracked the data is sent to the CGI or matte painting department as 

shown in Figure 3.17. Concerning department use it to place their created elements in 

synchronization with the motion of the shot. For example, if an element is a 2D image. 

If you have to replace a computer screen then the tracking data might be sent directly 

to the compositor to synchronize it with the motion. 

 

Fig. 3.17 Motion tracking data sent to CGI/Matte painting dept. Courtesy- 

Author 

So, after all those elements are created and sent to the compositor he combines them 

there. That is the work of the compositor to make it look real as shown in Figure 3.18. 
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Fig. 3.18 Object is placed using motion tracking data 

It is a good idea to watch and study the reality how the light interacts, how camera 

shoots a scene. It is not just putting the images together. It is the way you combine 

them. The tricks and skills that you use and make it look real. 

3.4 Difference between Compositor and other VFX Artist 

When you start out, you are probably not going to work on the big-budget films. You 

probably will be involved with commercials and small budget films. 

Those guys are searching for a person who not only composites but has some additional 

skills. By saying that you want to become a compositor, you probably mean that you 

want to become a visual effects artist. 

What is the difference between those two? 

The compositor combines the images that are created already by the different 

departments. While the visual effects artist has a variety of skills mentioned in Figure 

3.19 including the compositing. Compositing can be under the visual effects artists 

skills or as a separate profession. 

 

Fig. 3.19 Different Visual Effects Skill Courtesy- Author 

3.5 Software for visual effects 

The visual effects and animation artist have different work environment. Software used 

for this work are very costly. So, it is better to choose the right software. 

3.5.1 Compositing 

For Compositing, the industry standard is considered the Nuke software. However, After 

Effects is very popular and used broadly as well. Nuke is superior over the After Effects 
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or the way around their major and minor differences they are the one of them. Table 3.1 

shows a comparison between Nuke and After Effects. 

Table 3.1 Comparison between Nuke© and After Effect© 

 Nuke After Effects 

Workflow Node base Layer base 

Learning level Hard to learn Easy to learn 

Environment 3D Environment is integrated 

in software 

Does not have 3D 

environment. Need to use 

external plugins. 

Price 5000- 8000$ 20$/month (Standalone unit) 

50$/month (All adobe product) 

Mostly used by Cinema project, movies Broadcast, motion graphic 

work 

There is another software called Fusion by black magic. It is free and also has node-

based workflow like Nuke, that is another software used for the compositing. Knowledge 

and working skills of some more software are required move further visual effects artist. 

So, let us take an overview of each and see decide the software required for your work. 

3.5.2 Keying, Rotoscoping and Retouch 

The compositing software is used for green-screen removal (keying) as well as for 

rotoscoping as shown in Figure 3.20. However, if it gets more complicated there is a 

software called Mocha Pro. You can buy it as a plugin for software or as a standalone 

unit as well. 

The compositing software is required for retouching. Further a Photoshop software is 

required to retouch and repaint the environments. Mocha pro is also very helpful for the 

complex situations of the retouch. Very similar for the matte painting you can do simple 

fixes in the compositing software and you will need Photoshop as well to paint the 

background itself.   

 

Fig.3.20 Software used in Keying, Rotoscoping and Retouching Courtesy- Author 

3.5.3 Matte Painting 

Once the shapes are getting more complex you will definitely need a 3D software to make 

the model. Maya is industry standard software for films, visual effects, video games and 

3D animation as shown in Figure 3.21. 
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3Ds max© is more used for engineering type of modeling, architecture maybe a product 

or interior design. There is also easy software called cinema 4D©, which is more user 

friendly than Maya. it is much easier to learn. Blender is a free and open source software 

used to achieve good results. You can use any one from this for matte painting. 

 

Fig. 3.21 Software used in Matte Painting Courtesy- Author 

Table 3.2 Comparison between Maya and 3ds max 

 Maya© 3Ds max© 

Basics 3D animation, modeling, 

simulation and rendering 

program. 

3D modeling software 

3D 

modeling 

 

Offers the possibility to work on 

really complex 3D projects. 

Perfect for the creation of interior 

design, and for architectural 

visualizations. 

Animation 

 

Powerful for animation, already 

used by a lots of professionals. 

Comparably Weaker 

Rigging 

 

Recommend using Maya, which 

is better to create complex rigs. 

If you are not really experienced, you 

can use 3ds Max 

Rendering Creates same Result Creates same Result 

Mostly used 

by 

cinema or animation projects, 

character creation, virtual reality 

and animations 

video game developers, movie pre-

visualization, virtual reality 

experiences, and design visualization 

3.5.4 CGI 

Mostly 3D software are used for CGI. The examples of most commonly used software 

for CGI includes, MAYA, 3D Max, Cinema 4D, Blender as shown in Figure 3.22. 

 

Fig.3.22 Software used in CGI  Courtesy- Author 
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Table 3.3 Comparison between Maya and Cinema 4D 

 Maya© Cinema 4D© 

basics Maya is 3D simulation, modeling, 

animation and rendering software. 

Cinema 4D is a 3D modeling, 

animation, and rendering software. 

Developed by Autodesk Maxon 

Interface and 

features 

Maya’s interface is hard to master Cinema 4D relies on a hand-on 

interface 

Animation & 

Visual Effects 

Maya is excellent with tasks that 

involve character rigging and 

animation superimposing. 

Easy to learn in motion graphic 

and faster than 3DS Max. 

Mostly used in Film and Video game industry TV commercial and advertising 

creation 

3.5.5 Digital effects 

Fire explosions, fluid simulations, destruction and much more can be achieved with 3d 

software's that we have mentioned before, which allow achieving good results. You can 

also use an external plugins for the compositing or 3d software as shown in Figure 3.23. 

There is popular software that specializes in digital effects known as Houdini. 

 

Fig.3.23 Software used in FX Courtesy- Author 

3.5.6 Tracking 

The compositing software does contain tracking, which might be enough for you. But if 

the scene becomes more complex you might need external software. (Figure 3.24.) There 

is one of them is Boujou the most expensive one it's around 4,800$ but it's a good 

software then there is Syntheyes which has got a very good manual tracking, but it's 

not really user friendly. PF track is around 1700$ dollars and it is an old base which is 

close to the way nuke works. Then this mocha Pro which I mentioned before instead of 

2D or 3D tracking mocha Pro uses planar tracker which is very helpful in extra complex 

situations. 

 

Fig. 3.24 Software used in Motion Tracking Courtesy- Author 
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Choose the one you like play with that. See for yourself which one do you like more. 

Assignment 1. Identify the software from its logo given below. 

Software 

Logo 

      
Software 

Name 

      

3.6 The career growth in VFX 

As mentioned in introduction, you can start your career as a roto-artist in VFX field. 

Then after gaining experience you can choose the department you wish to go like Matte 

Painting, CGI, Compositing and many more. After year of experience you can become 

VFX supervisor. 

Summary 

• CGI means any three dimensional object that you see on screen. It is computer 

generated graphics. 

• SFX is created on sets while FX is a digital effect. 

• A Compositor is connected with Keying, Rotoscoping, Retouching, matte painting, 

motion tracking and CGI department. 

• Matte painter digitally paints the background. 

• CGI department have various sub-department such as Modeling, Texturing, 

Lighting/Shading, Rigging, 3D animation and Rendering. 

• Motion Tracking enables you to put 3D object into the live action shots. 

• Nuke, After Effects and Mocha Pro software is used for compositing, Keying, 

Retouch and Rotoscoping. 

• MAYA, 3D Max, Cinema 4D and Blender are used to create CGI and FX. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. CGI stands for (a) Common Graphics Imagery (b) Computer Generated Imagery 

(c) Computer Graphics Imagery (d) Compound Graphic Imagery 

2. CGI includes anything that is in (a) 2D (b) 3D (c) 2.5D (d) Motion graphics 

3. VFX means (a) Video Effect (b) Video Effects (c) Visual Effect (d) Visual Effects 

4. Any Explosions and live effect created on set is known as (a) DX (b) FX (c) SFX (d) 

VFX 

5. Special effect which is made on set, is directly connected with (a) CGI (b) VFX (c) 

DX (d) SFX 

6. Which element is not included in compositing (a) Live Characters (b) Motion 

Graphics (c) 3D Character (d) Transition 

7. Prep/Paint department does not include (a) Keying (b) Rotoscoping (c) Retouch 

(d) Modeling 
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8. CGI department spreads out in ___ departments (a) Four (b) Five (c) Six (d) Seven 

9. Nuke is not used in (a) Compositing (b) Rotoscoping  (c) Retouching (d) Editing 

10. 3Ds max is (a) 3D Modeling software (b) Motion graphics software (c) Compositing 

Software (d) Editing software 

B. Fill in the blanks 

1. CGI does not include __________ shot. 

2. Digital effects (FX) can be used in_____ like a 3D video game. 

3. If a person knows how to integrate an element into the footage, he can be 

________ artist. 

4. Prep/Paint means cleaning out the shots and preparing the footage for the 

______. 

5. Motion tracking allows compositor to integrate other elements in 

synchronization with the motion of the ______. 

6. After Effects is a________ base software. 

7. Cinema 4D is a 3D modeling, animation, and_______ software. 

C. True or False 

1. Fire and Explosion, which is created by computer is called as Digital effects. 

2. Digital effect can be used in visual effects in form of 3D character. 

3. Visual effects artist should have CGI skills. But CGI artist does not need         

Digital effects skills. 

4. If there's a green screen that needs to be removed, then the shot first is being 

sent to the Rotoscoping Department. 

5. Modeling, rigging and rendering comes under CGI department. 

6. Nuke is mostly used in motion graphics work. 

7. 3Ds max is more used for engineering type of modeling, architecture or         

interior design. 

8. The Compositing software does not contain tracking. 

D. Short answer questions 

1. What is difference between CGI and VFX? 

2. What is difference between SFX and FX? 

3. What is connection between FX and CGI? 

4. Write the skill connection between VFX, CGI and FX. 

5. What is Prep/Paint? 

6. What is matte painting? 

7. Write the name of different department included in CGI. 

8. Write the difference between compositor and other VFX department. 

9. Compare Maya and 3Ds max. 

10. What is the career growth in VFX field? 
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Further References for Practical’s/reading 

Text Books: 

Benjamin Bratt. (2011). Rotoscoping Techniques and Tools for the Aspiring Artist. 

Elsevier Inc. 

Steve Wright.(2011).Compositing Visual Effects: Essentials for the Aspiring Artist. 

Elsevier Inc. 

Jeffrey A.Okun, Susan Zwerman (Eds.).(2020).The VES Handbook of Visual Effects. 

Routledge 

Digital Resources: 

Text Materials 

Intro to rotoscoping 

https://kristen-gillette-crnt.squarespace.com/animation-rotoscope 

Animate reality with rotoscoping. 

https://www.adobe.com/in/creativecloud/video/discover/rotoscoping-animation.html 

The Art of Roto 

https://www.fxguide.com/fxfeatured/the-art-of-roto-2011/ 

Silhouette-v7.5-UserGuide 

https://cdn.borisfx.com/borisfx/store/silhouette-7-5/Silhouette-v7.5-UserGuide.pdf 

 

Online Videos 

SilhouetteFX video tutorial 

https://borisfx.com/videos/?tags=product:Silhouette&search= 

https://www.youtube.com/channel/UC7MqpMLZgeZxrlricwcFTUQ 

How to do Hair Roto - Silhouette FX Rotoscopy Tutorial 

https://youtu.be/qptclxM12nY 

Motion blur and vfx roto In Silhouette 

https://youtu.be/zYR-rFD94KY 

 

 

 

 

 

 

 

https://kristen-gillette-crnt.squarespace.com/animation-rotoscope
https://www.adobe.com/in/creativecloud/video/discover/rotoscoping-animation.html
https://www.fxguide.com/fxfeatured/the-art-of-roto-2011/
https://cdn.borisfx.com/borisfx/store/silhouette-7-5/Silhouette-v7.5-UserGuide.pdf
https://borisfx.com/videos/?tags=product:Silhouette&search
https://www.youtube.com/channel/UC7MqpMLZgeZxrlricwcFTUQ
https://youtu.be/qptclxM12nY
https://youtu.be/zYR-rFD94KY


 

Roto Artist, Grade XII 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

250 

Glossary 

Alpha Matte – It creates the matte using alpha channel. 

Bit Depth – It refers to the color information stored in an image. The higher the bit 

depth of an image, the more colors it can store. For example, a 1 bit image can only 

show two colors, black and white Because the 1 bit can only store one of two values, 0 

(white) and 1 (black). An 8 bit image can store 256 possible colors. 

Chroma Key – It is a compositing technique to use a specific colour like blue, green to 

remove background. 

Compositing – Combining different layers and object in to a single video or film frame. 

Depth Map – A depth map is just a representation of the distance from a reference point 

to your image. In terms of perspective, it provides in-depth detail of how near and far a 

part of the image is. These maps can be converted into a gray scale image where brighter 

pixels correspond to regions that are closer while darker pixels are further away from 

the reference point. 

Depth of Field blur – It describes the amount of sharpness a video frame has, when it 

focuses on certain point inside the frame. It is affected by the focal length of the lens, 

aperture and object distance. 

Edge Feather – Act of creating soft edge of the shape so that it can gradually mixed 

with background. 

Focus object – The object, that is going to separate from the video footage. 

Frame rate - Number of video frames camera captures in one second. It is denoted by 

FPS, some examples are- 24 FPS, 25FPS, 60 FPS, 12 FPS. 

Fringing – To form a border around edge of something. 

Grain – Random physical texture made from small metallic silver particles found on 

processed photographic celluloid. Also known as granularity, this can vary in size, not 

just due to its random nature, but by the size of the image shrinking or increasing 

“grains.” 

Image Sequence – Series of sequential still images that represent frames of an 

animation or video. 

Inorganic Shape – Shape created by the straight or perfectly curving lines, like those 

found in geometry. 

Key Frame – Beginning and end poses for a particular animation sequence are called 

key frames. 

Luma Matte – The matte based on luminance of the layer. It is created from grey-scale 

images or animations, here white is fully transparent, black is opaque and everything 

in between is a varying degree of transparency. 

Motion blur – It is the blur seen in moving objects in a photograph or a single frame of 

film or video. It happens because objects cover longer distance over a short numbers of 

frames. 

Multi frame – It allows transform and reshape tool to make adjustment on all previously 

set of key frames or selection of key frames. 

Node - In node base software, It can perform simple image processing operations by 

connecting together. 
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Noise – It is the random variation of brightness or color information in images, and is 

usually an aspect of electronic noise. This can be produced by the image sensor and 

circuitry of a scanner or digital camera. 

Opacity - Transparency of a shape/object determined by 0 to 100. Here Zero means 

completely transparent and 100 means fully opaque. 

Organic Shape – These shapes are often curved in appearance; these are similar to 

those found in nature, such as plants, animals, and rocks. 

Pivot Point – The spot from which a rotation takes place. 

Pixel – It is the smallest unit of digital image that is responsible for showing or 

displaying on digital display device. 

Pixel Aspect Ratio- Proportion of individual pixels that creates digital image. Mostly 

pixels are square that results pixel aspect ratio1:1 

Proxy Image – Provides lower quality source image for roto in SilhouetteFX software. 

Raster Graphics – Types of images that are produced when scanning or photographing 

an object. Raster images are compiled using pixels, or tiny dots, containing unique color 

and tonal information that come together to create the image. 

Rendering – Conversion of 3D models into two-dimensional images with 3D effects is 

called rendering. 

Resolution – It refers to number of pixels are displayed per inches of an image. It is 

denoted by PPI. Higher resolution means more pixels per inches. 

Spline – In computer graphic, a spline is a curve that connects two or more specific 

points, or that is defined by two or more points. 

Stabilization – Algorithms used to improve video quality by removing unwanted camera 

shakes and jitters due to hand jiggling and unintentional camera panning. 

Standout Hair – Strands of hair that is not included in basic shapes. 

Stereo 3D – It uses the disparity of two camera images viewing the same scene to 

calculate depth information, just like the human eye. 

Stereo Roto – In stereo conversion, roto is being used to separate elements from a two 

dimensional shot sequence to create a depth map that will allow a second 'virtual' 

camera to be produced with the correct offset for stereo parallax. 

Tangent – Controlling handles in spline tools. 

Track matte — It is a still image, video clip, graphic, piece of text or shape used to 

create variable transparency in another layer. With a track matte, you create a top layer 

that provides alpha, or luminance and a bottom layers that contains imaginary. 

Viewer – In Silhouette software, length of frames is viewed, playback and shapes are 

manipulated in this panel. 

Video Format – Type of file format used to storing digital video data on computer 

system. 

Warp Stabilizer – Digital Video Effect used to stabilize the shaky video footage. 

Zoom in/out – To make the image of something or someone appear much larger and 

nearer, or much smaller and further away by using camera or computer graphics 

software. 
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Answer 
 

Module 1. Drawing and Animating Roto shapes 

Session 1. Rotoscoping Pre-Requisite 

A. Multiple Choice Questions 

1. (d) 2.(c) 3.(c) 4.(d) 5.(a) 6.(d) 7.(c) 8.(c) 9.(c) 10.(c) 

B. Fill in the Blanks 

(1) Time and patience (2) Visible, Invisible (3) Warp Stabilizer (4) Final use of the matte 
(5) Form and Motion (6) Perfection (7) Single shape (8) Multiple shapes (9) Shape (10) 
Starting, End 

C. State True or False 

1.(T) 2. (T) 3. (T) 4. (F) 5. (T) 

 

Session 2. Working with Silhouette 

A. Multiple Choice Questions 

1. (c) 2.(c) 3.(d) 4.(a) 5.(d) 6.(c) 7.(b) 8.(b) 9.(a) 10.(d) 

B. Fill in the Blanks 

(1) Toolbars, Pop-up menus (2) Image sequence (3) Session (4) Silhouette (5) Mask (6) 
Node parameter (7) Combine, Delete (8) Enter (9) Crops (10) Playback 

C. True or False 

1.(F) 2.(T) 3.(F) 4.(T) 5.(T) 6.(T) 7.(F) 8.(T) 9.(F) 10.(T) 

 

Session 3. Drawing Shapes 

A. Multiple Choice Question 

1. (b) 2.(c) 3.(b) 4.(c) 5.(c) 6.(b) 7.(d) 8.(a) 9.(c) 10.(c) 

B. Fill in the Blanks 

(1) Curve (2) Smooth points (3) Curve (4) Reshape (5) Move more (6) Feather handle (7) 
Outward (8) X (10) Multiple (11) AA 

C. True or False 

1.(F) 2.(T) 3.(T) 4.(F) 5.(T) 6.(F) 7.(T) 8.(F) 9.(F) 10.(T) 

 

Session 4. Animating Shapes 

A. Multiple Choice Question 

1.(b) 2.(d) 3.(a) 4.(b) 5.(a) 6.(d) 7.(d) 8.(c) 9.(b) 

B. Fill in the Blanks 

(1) Move individual point (2) TT (3) Small portion of the shape (4) Reshape tool (5) Size 
of the shape (6) Ctrl key (7) Scales (8) E (9) Set interval (10) Incremental key frame 

C. True or False 

1.(F) 2.(F) 3.(T) 4.(T) 5.(T) 6.(T) 

 

Module 2. Roto Techniques in SilhouetteFX 

Session 1. Blur and Motion Blur 

A. Multiple Choice Questions 
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1.(a) 2.(b) 3.(b) 4.(a) 5.(b) 6.(b) 

B. Fill in the Blanks 

(1) Same (2) Higher (3) Motion or camera (4) Blur (5) Inner side (6) 50% (7) AA (8) Colour 
comp 

C. True or False 

1. (T) 2.(F) 3.(T) 4.(F) 5.(T) 

 

Session 2. Motion Tracking 

A. Multiple Choice Questions 

1.(c) 2.(a) 3.(b) 4.(d) 5.(c) 6.(d) 7.(a) 8.(c) 9.(d) 

B. Fill in the Blanks 

(1) Tracking (2) Stabilize (3) 2D (4) Foreground (5) Search region (6) Details (7) 
Perspective (8) Object list 

C. State True or False 

1. (F) 2.(T) 3.(F) 4.(T) 5.(T) 

 

Session 3. Human Figure based Rotoscoping 

A. Multiple Choice Questions 

1. (d) 2.(a) 3.(b) 4.(b) 5.(c) 6.(d) 7.(c) 8.(b) 9.(a) 

B. Fill in the Blanks 

(1) Movement (2) Middle (3) Joint (4) Shoulder (5) Control Point (6) Object list (7) Pivot 
Point (8) Recalculate 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (F) 5. (T) 6(T) 

 

Session 4. Rotoscopy of Hair 

A. Multiple Choice Questions 

1.(c) 2.(b) 3.(c) 4.(d) 5.(a) 6.(c) 7.(c) 8.(c) 9.(d) 10.(c) 

B. Fill in the Blanks 

(1) Basic Shape (2) Compositor (3) Object window (4) Majority of time (6) Thickness of 
the stroke (7) Single hair (8) Root 

C. True or False 

1.(F) 2.(F) 3.(F) 4.(F) 5.(T) 

 

Module 3. Advanced Roto Techniques and Applications 

Session 1. Useful Nodes of Silhouette  

A. Multiple Choice Questions 

1. (a) 2.(c) 3.(d) 4.(a) 5.(c) 6.(d) 7.(d) 8.(b) 

B. Fill in the Blanks 

(1) Open (2) Black (3) Estimation (4) Foreground and Background (5) Object (6) 
Foreground 

C. True or False 

1. (F) 2. (T) 3. (F) 4. (T) 5. (T) 

 

Session 2. Scene Salvage 
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A. Multiple Choice Questions 

1.(d) 2.(a) 3.(a) 4.(d) 5.(b) 6.(a) 7.(b) 8.(c) 9.(c) 10.(d) 

B. Fill in the Blanks 

(1) Wire (2) Clone tool (3) Moving, Steady (4) Facial blemishes (5) Square (6) Profile Tab 
(7) Clone Tool (8) Frame number (9) Target (10) Colour correction control 

C. True or False 

1.(F) 2.(T) 3.(T) 4.(F) 5.(T) 

 

Session 3. Stereo Roto 

A. Multiple Choice Questions 

1. (c) 2.(d) 3.(c) 4.(c) 5.(b) 6.(a) 7.(b) 8.(b) 

B. Fill in the Blanks 

(1) Digitized (2) High Quality, Economical (3) Human Visual System (4) Slightly Different 
(5) Depth (6) Watching 3D Movie 

C. True or False 

1.(T) 2.(F) 3.(T) 4.(F) 5.(F) 

 

Module 4. Finalizing Matte 

Session 1. Finishing the Rotoscoping 

A. Multiple Choice Questions 

1. (c) 2.(a) 3.(b) 4.(c) 5.(b) 6.(c) 7.(d) 

B. Fill in the Blanks 

(1) Playback (2) Key frame (3) All previously set key frame (4) Multiple (5)Zero 

C. True or False 

1. (F) 2.(T) 3.(T) 

 

Session 2. Rendering and Exporting Shapes 

A. Multiple Choice Questions 

1. (d) 2.(c) 3.(b) 4.(d) 5.(d) 6.(c) 

B. Fill in the Blanks 

(1) Render (2) Object List (3) .fxs (4) Mask (5) Channels 

C. True or False 

1. (T) 2. (F) 3. (T) 4.(F) 5.(T) 

 

Session 3. Rotoscoping Work Environment 

A. Multiple Choice Questions 

1. (b) 2.(b) 3.(d) 4.(c) 5.(a) 6.(d) 7.(d) 8.(b) 9.(d) 10.(a) 

B. Fill in the Blanks 

(1) Live action shot (2) CGI (3) Visual Effects Artist (4) Compositor (5) Camera (6) Layer 
(7) Rendering 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (F) 5. (T) 6. (F) 7. (T) 8. (F) 
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